Matrox Limited Warranty

Limited Warranty Statement

1 Matrox* ("Matrox") having its head office at 1055 St-Regis Blvd., Dorval, Quebec Canada tel: (514) 822-6000 warrants that the Matrox hardware products (the "Matrox Product") will be free from defects in materials and workmanship under normal use for a period of one (1) year from the date of purchase by the original customer ("Customer" or "You") who provides adequate proof of purchase and payment (for example, a copy of your sales receipt or purchase invoice). The warranties provided by Matrox in this Matrox limited warranty statement apply only to Matrox Products that the Customer purchases for use, and not for resale. This warranty applies only to the original Customer and is non-transferable. MATROX DOES NOT WARRANT THAT THE OPERATION OF THE MATROX PRODUCT WILL BE UNINTERRUPTED OR ERROR-FREE, THAT DEFECTS IN THE MATROX PRODUCT WILL BE CORRECTED, OR THAT THE MATROX PRODUCT WILL MEET THE CUSTOMER'S REQUIREMENTS OR PERFORM WITH ANY HARDWARE OR SOFTWARE PROVIDED BY THIRD PARTIES. Conditions and limitations of Matrox's warranty are stated below.

2 Matrox’s limited warranty applies only to the Matrox Product entirely manufactured by or for Matrox. The limited warranty does not apply to any non-Matrox hardware products or any software, even if packaged or sold with the Matrox Product. Manufacturers, suppliers or publishers other than Matrox may provide their own warranties to the Customer, but Matrox, insofar as permitted by law, provides their products "as is." Software provided by Matrox is not covered under this limited warranty (please refer to the licensing agreement accompanying the software for details of the terms applicable to such).

3 Matrox’s limited warranty covers only those defects which arise as a result of normal use of the Matrox Product and does not apply to any damage which arises from:

a) improper or inadequate maintenance;

b) incompatibilities due to the Customer's hardware or software applications, including non-Matrox products, with or in which the Matrox Product interfaces;

c) Matrox Product of a special or custom-made nature;

d) unauthorized modification or misuse, including physical damage to the Matrox Product caused by the Customer or due to transportation of the product;

e) improper installation, abuse, misapplication or negligence;

f) failure to follow instructions relating to Matrox Product's use;

g) operation outside the Matrox Product's environmental specifications;

h) improper site preparation or maintenance;

i) software;

j) service performed by anyone who is not a representative of Matrox;

k) other causes that do not relate to a Matrox Product defect;

l) defects or damage suffered as a result of force majeure (including theft);

m) defects or damage suffered as a result of normal wear and tear or otherwise due to the normal aging of the Matrox Product, and/or

n) stolen goods.

The warranty is voided by removal or alteration of identification labels on the Matrox Product or its parts.

4 In the event of a defect in a Matrox Product during the applicable warranty period, Matrox shall at its sole option, either i) repair the defect using new or refurbished parts and return the repaired Matrox Product within a reasonable delay; or ii) replace the Matrox Product with a Matrox Product that is new or which has been manufactured from new or serviceable used parts and is at least functionally equivalent to the original Matrox Product and send such replacement Matrox Product within a reasonable delay.

* Matrox is Matrox Electronic Systems Ltd, Matrox Graphics Inc. or Matrox Europe Limited. Head office at 1055 St-Regis Blvd. Dorval, Quebec, Canada H9P 2T4 Telephone (514) 822-6000.
5 A replacement Matrox Product or part assumes the remaining warranty of the original Matrox Product. When a Matrox Product or part is replaced, any replacement item becomes the Customer's property and the replaced item becomes Matrox's property.

6 This warranty is valid in any country where Matrox Products are distributed by Matrox and/or its authorized resellers, dealers or distributors.

7 This limited warranty gives the Customer specific legal rights. The Customer may also have other rights which vary from state to state in the United States, from province to province in Canada, and from country to country elsewhere in the world.

8 For Australian Consumers: The rights described in this warranty are in addition to the statutory rights to which You may be entitled under the Competition and Consumer Act 2010 and other applicable Australian consumer protection laws and regulations. Our Matrox Products come with guarantees that cannot be excluded under the Australian Consumer Law. You are entitled to a replacement or refund for a major failure and compensation for any other reasonably foreseeable loss or damage. You are entitled to have the goods repaired or replaced if the goods fail to be of acceptable quality and the failure does not amount to a major failure. Goods presented for repair may be replaced by refurbished goods of the same type rather than being repaired. Refurbished parts may be used to repair the goods.

Limitations of Warranty

1 TO THE EXTENT PERMITTED BY LAW, THIS WARRANTY AND THE REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES, REMEDIES AND CONDITIONS. NEITHER MATROX NOR ANY OF ITS THIRD PARTY SUPPLIERS MAKES ANY OTHER WARRANTY OF ANY KIND, WHETHER EXPRESSED OR IMPLIED, WITH RESPECT TO MATROX PRODUCTS. MATROX SPECIFICALLY DISCLAIMS (AND THE CUSTOMER, BY ACCEPTING THE MATROX PRODUCT, SPECIFICALLY ACCEPTS SUCH DISCLAIMER AND WAIVES) ALL OTHER WARRANTIES, EITHER EXPRESSED OR IMPLIED, ORAL OR WRITTEN, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR OR INTENDED PURPOSE OR USE AND THE WARRANTY AGAINST LATENT DEFECTS, WITH RESPECT TO THE HARDWARE AND/OR SOFTWARE. MATROX FURTHER DISCLAIMS ANY WARRANTY THAT MATROX PRODUCTS, IN WHOLE OR IN PART, WILL BE FREE FROM INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL PROPERTY, INCLUDING, WITHOUT LIMITATION, ANY PATENTS, OR PROPRIETARY RIGHTS.

2 To the extent that this limited warranty is inconsistent with the law of the locality where the Customer purchases the Matrox Product, this limited warranty shall be deemed modified to be consistent with such local law. Under such local law, certain limitations of this limited warranty may not apply to the consumer. If Matrox cannot lawfully disclaim statutory or implied warranties, then to the extent permitted by law, all such warranties shall be limited in duration to the duration of this express warranty and to repair or replacement service as determined by Matrox at its sole discretion.

3 Matrox disclaims any representation that it will be able to repair any Matrox Product under this warranty or make a Matrox Product exchange without risk to or loss of the programs or data.

4 To the extent allowed by local law, the remedies provided in this limited warranty are the Customer's sole and exclusive remedies.

Limitations of Liability

1 EXCEPT FOR THE OBLIGATIONS SPECIFICALLY SET FORTH IN THE LIMITED WARRANTY, IN NO EVENT SHALL MATROX BE LIABLE FOR:

a any direct, indirect, special, incidental, consequential, foreseeable or unforeseeable, or punitive damages, whether based on contract, tort, delict or any other legal theory and whether advised of the possibility of such damages; and/or
b damages arising from the loss of use, data, Matrox Production revenue, use of money, anticipated savings, procurement of substitute goods, business, opportunity, goodwill, reputation and/or profit in connection with the Matrox Product or any business interruption.

c Matrox disclaims and shall have no obligation to indemnify or defend You or any third party in respect of any actual or alleged infringement of any actual or pending patents, copyright or other intellectual property rights. Matrox shall have no liability arising out of any such actual or alleged intellectual property infringement.

2 Without prejudice to the foregoing, any liability of Matrox for any breach of warranty shall be limited to the actual amount paid by the Customer for the defective hardware in question.

3 To the extent allowed by local law, Matrox’s entire liability and the Customer’s exclusive remedy shall be the repair or replacement of any defective Matrox Product during the warranty period. Matrox does not offer any other warranty with respect to Matrox hardware or software or any other hardware or software.

4 Customer shall be responsible for all applicable taxes, duties and customs fees on any replacement unit, as well as all transport, insurance, storage and other charges incurred on all returned Matrox Products.

5 Matrox reserves the right to change its warranties at any time and without notice, at its sole discretion, with respect to future sales and deliveries.

6 UNAUTHORIZED USE. THE MATROX PRODUCT AND ANY DOCUMENTATION RELATED THERETO ARE NOT DESIGNED, INTENDED, AUTHORIZED OR WARRANTED TO BE SUITABLE FOR USE OR RESALE IN ANY TYPE OF SYSTEM OR OTHER APPLICATIONS RELATED TO, HAZARDOUS OR POTENTIALLY HAZARDOUS ENVIRONMENTS OR APPLICATIONS REQUIRING HIGH-AVAILABILITY OR FAIL-SAFE PERFORMANCE, WHERE PERSONAL INJURY OR DEATH MAY OCCUR, SUCH AS MEDICAL SYSTEMS, LIFE SUSTAINING, LIFE SAVING SYSTEMS, OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, PUBLIC WORKS, WEAPONS SYSTEMS, OR ANY OTHER APPLICATION IN WHICH THE FAILURE OF A MATROX PRODUCT COULD LEAD TO PROPERTY DAMAGE, ENVIRONMENTAL DAMAGE, OR PERSONAL INJURY. CUSTOMER WILL NOT USE, OR PERMIT TO BE USED, THE MATROX PRODUCTS FOR SUCH HIGH-AVAILABILITY, FAIL-SAFE OR CRITICAL APPLICATIONS AND FURTHER AGREES TO INDEMNIFY, DEFEND AND HOLD HARMLESS MATROX AND ITS MANAGERS, DIRECTORS, OFFICERS, EMPLOYEES, AGENTS, AFFILIATES, SUCCESSORS, AND ASSIGNS FROM AND AGAINST ANY ACTION, SUIT, PROCEEDING, COST, EXPENSE, DAMAGES, AND LIABILITY (INCLUDING, BUT NOT LIMITED TO, REASONABLE ATTORNEYS’ FEES) ARISING OUT OF, OR RELATED TO, THE BREACH OF CUSTOMER’S OBLIGATIONS RELATED HERETO, EVEN IF SUCH CLAIM ALLEGES THAT MATROX WAS NEGLIGENCE REGARDING THE DESIGN OR MANUFACTURE OF THE MATROX PRODUCT.

Obtaining Service (whether in or out of warranty)

1 Verify that your Matrox Product was installed and configured according to the information in its accompanying documentation or at the web site referenced therein.

2 Read the “Troubleshooting” information included with the Matrox Product or at the web site referenced therein, to verify if the problem can be easily solved.

3 If You are still experiencing difficulties, please contact your dealer or distributor where You purchased your Matrox Product. Please go to http://www.matrox.com/hr/en/company/legal/en/warranty, to find the list of Matrox authorized dealers and/or distributors in your area.

4 Alternatively, if this first option is unavailable to You and you are still experiencing problems or if you believe that your product is defective, please contact the Matrox Support team. We will help you troubleshoot your issue and process a replacement if it is found to be defective. Matrox support team can be reached at http://www.matrox.com/hr/en/company/legal/en/warranty.

5 Before returning the Matrox Product, please back up any and all information or data thereon, including, without limitation, confidential, proprietary, personal or other information. All data and information on the Matrox Product will be lost given that the persistent storage device(s) will be reformatted to factory default during testing;
and Matrox cannot, and does not, accept any responsibility for any information that may be lost, corrupted, damaged or otherwise rendered inaccessible.

6 When returning a Matrox Product, leave the configuration as it was when You were using it, and leave all identification stickers on the Matrox Product. Pack the Matrox Product in its original box and return it to your Matrox dealer or distributor where the Matrox Product was purchased, together with your proof of purchase. Your Matrox dealer or distributor will return the Matrox Product for You. Alternatively, You may proceed by returning your Matrox Product by following the guidelines referred to at the following address http://www.matrox.com/hr/en/company/legal/en/warranty, and follow the link to Customer Support, where a Return Merchandise Authorization (RMA) number will be issued, upon receipt of adequate proof of purchase, and shipping instructions will be given to you. Customer will be responsible in paying the freight to send the Matrox Product for service. Please ensure that the product is in Electrostatic discharge (ESD) packaging before shipping it back to Matrox or else the warranty shall be void.

DO NOT RETURN THE MATROX PRODUCT TO MATROX WITHOUT MATROX’S RMA NUMBER AND EXPRESS AUTHORIZATION.

Once an RMA number is issued, the Matrox Product must be returned to Matrox within thirty (30) days. NON-WARRANTY product will be shipped back to You collect or on your courier account number, if one is provided.

General

1 This limited warranty shall be governed by the laws of the Province of Quebec, Canada and the federal laws of Canada applicable therein and the courts of the Province of Quebec shall have exclusive jurisdiction to hear and decide any dispute instituted by the Customer in connection with this limited warranty; the Customer waives, by accepting the Matrox Product, its rights to institute proceedings in connection with this warranty against Matrox in any jurisdiction other than Quebec. Customer hereby agrees to all terms of this warranty in the English language. The United Nations Convention on Contracts for the International Sale of Goods does not apply to this warranty and is strictly excluded.

2 Except as may be expressly agreed to the contrary in a signed written agreement between Customer and Matrox, i) any written or oral information or advice given by Matrox’s distributors, agents or employees will in no way increase the scope of the limited warranty contained in this limited warranty; and ii) this limited warranty states the only warranty made to You by Matrox with respect to the units of Matrox Product that You have purchased, and the terms of this limited warranty shall override the terms of any purchase orders and any other terms and understandings You may seek to apply in respect thereof.

3 This limited warranty is personal to You and cannot be assigned or transferred without Matrox's prior written agreement.

4 The failure by Matrox to enforce any of the provisions of this limited warranty shall not constitute a waiver of Matrox's rights to enforce such provision or any other provision of this limited warranty in the future.

5 If any clause in this limited warranty is held by a court of law to be illegal or unenforceable the remaining provisions of this limited warranty shall not be affected thereby.
Matrox Software License Agreement

This is a legal agreement between the Licensee and Matrox Electronic Systems Ltd. ("Matrox") concerning the usage of the Matrox Software. By downloading, installing, copying, accessing, clicking on an "accept" button, or otherwise using the Software, the Licensee agrees to the terms of this agreement. If you are accepting these terms on behalf of your company, organization, educational institution, or agency, instrumentality, or department of the federal government as its authorized legal representative, you represent and warrant that you have full authority to bind licensee to these terms. If you do not agree to the terms of this agreement, please return your Matrox product. If the Software was downloaded, destroy all copies of the Software.

In this agreement "Software" refers to: any firmware, software, associated software components, media, printed materials, and "online" or electronic documentation related to Matrox products.

The Software is not sold, and instead is only licensed for use, strictly in accordance with this document. This license does not cover the sale of hardware, since it may not necessarily be sold as a package with the Software. This license sets forth the terms and conditions of the Software license only.

Any Software provided to Licensee is the copyrighted work of Matrox and/or its suppliers. The present License does not give Licensee any intellectual property rights to the Software or its derivatives. The downloading and/or the use of any Software are subject to the following restrictions and limitations:

LICENSES:
If you are an end user, the "End User License" shall apply to you.
If you are an original equipment manufacturer (OEM), the "OEM License" shall apply to you.

END USER LICENSE

1. Licensee may install the Software on an unlimited number of computers owned or leased by Licensee in any location. However, Licensee must use the Software on a single computer owned or leased by Licensee at a time, in conjunction with and for the purpose of, operating the Matrox hardware. Licensee shall also have the right to make one copy of the Software in any computer-readable or printed form for back-up or archival purposes;
2. No right to recopy, sell, distribute, license, sub-license, alter, modify, disassemble, de-compile or reverse engineer any Software in any manner whatsoever is hereby given, except as provided in this Agreement. Violation may result in severe civil and/or criminal penalties, as violators will be prosecuted to the maximum extent possible;
3. Licensee agrees to treat the Software as confidential information, and shall protect said information by using the same degree of care Licensee uses to protect Licensee's own confidential information, but no less than a reasonable degree of care, to prevent the unauthorized use, dissemination, disclosure or publication of such;
4. Licensee may only provide and disclose parts of the Software to third parties who have a need-to-know for the purpose of installation, service integration and/or support of said Software within Licensee's product. In such event, Licensee may only disclose the relevant and necessary parts of the Software to permit the third party to accomplish his work provided that all such disclosures shall be subject to the terms and conditions of this Agreement;
5. Licensee may not grant any sublicense, lease or other right in the Software to others;
6. Notwithstanding any other provision in this License, if Licensee provides any ideas, suggestions or recommendations to Matrox regarding the Licensed Software and/or Licensee's product ("Feedback"), Matrox is free to use and incorporate such Feedback in Matrox's products, without payment of royalties or other consideration to Licensee.
OEM LICENSE
Licensee may reproduce and distribute the Software only as an integral part of or incorporated in Licensee's product or as a standalone Software maintenance update for existing end users of Licensee's products, excluding any other standalone products, subject to these conditions:

1. This Software is licensed for use only in conjunction with Matrox products. Use of the Software in conjunction with non-Matrox products is not licensed hereunder;

2. No right to recopy, sell, distribute, license, sub-license, alter, modify, disassemble, de-compile or reverse engineer any Software in any manner whatsoever is hereby given, except as provided in this Agreement. Violation may result in severe civil and/or criminal penalties, as violators will be prosecuted to the maximum extent possible;

3. Licensee agrees to treat the Software as confidential information, and shall protect said information by using the same degree of care Licensee uses to protect Licensee's own confidential information, but no less than a reasonable degree of care, to prevent the unauthorized use, dissemination, disclosure or publication of such;

4. You may only distribute the Software to your customers pursuant to a written license agreement. At a minimum such license shall safeguard Matrox's ownership rights to the Software;

5. Licensee may only provide and disclose parts of the Software to third parties who have a need-to-know for the purpose of installation, service integration and/or support of said Software within Licensee's product. In such event, Licensee may only disclose the relevant and necessary parts of the Software to permit the third party to accomplish his work provided that all such disclosures shall be subject to the terms and conditions of this Agreement;

6. Notwithstanding any other provision in this License, if Licensee provides any ideas, suggestions or recommendations to Matrox regarding the Licensed Software and/or Licensee's product ("Feedback"), Matrox is free to use and incorporate such Feedback in Matrox's products, without payment of royalties or other consideration to Licensee.

GENERAL LICENSE TERMS: (APPLICABLE TO BOTH END-USERS & OEM'S)
There are inherent dangers in the use of any software available for downloading on the Internet and Matrox cautions Licensee to ensure that Licensee completely understands the potential risks before downloading any of the Software. Licensee is solely responsible for adequate protection and backup of the data and equipment used in connection with any of the Software, and Matrox will not be liable for any damages that may be suffered in connection with use of the Software.

Licensee hereby acknowledges and agrees that this License, and all its terms and conditions, automatically applies, without other notice, to future updates of the Software, firmware, BIOS, drivers and associated utilities.

COPYRIGHT
All title, including but not limited to copyrights, in and to the Software and any copies thereof are owned by Matrox or its suppliers. All title and intellectual property rights in and to the content which may be accessed through use of the Software is the property of the respective content owner and may be protected by applicable copyright or other intellectual property laws and treaties. This Software License Agreement grants you no rights to use such content. All rights not expressly granted are reserved by Matrox.

DISCLAIMER OF WARRANTIES
Licensee expressly acknowledges and agrees that use of the Software is at Licensee's sole risk. The Software and Documentation is provided "AS IS" AND WITHOUT WARRANTY OF ANY KIND AND MATROX EXPRESSLY DISCLAIMS ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT. MATROX DOES NOT WARRANT THAT THE CONTENTS OF THE SOFTWARE OR DOCUMENTATION WILL MEET LICENSEE'S REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE OR DOCUMENTATION WILL BE UNINTERRUPTED OR ERROR-FREE. THE ENTIRE RISK ASSOCIATED WITH THE USE OF THE SOFTWARE AND
DOCUMENTATION IS ASSUMED BY LICENSEE. FURTHERMORE, MATROX DOES NOT WARRANT OR
MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF THE
SOFTWARE OR DOCUMENTATION IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY,
CURRENTNESS, OR OTHERWISE. SHOULD THE CONTENTS OF THE SOFTWARE OR DOCUMENTATION
PROVE DEFECTIVE, LICENSEE ASSUMES THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR
OR CORRECTION. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED
WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO LICENSEE.
LICENSEE ACKNOWLEDGES AND AGREES THAT LICENSEE IS SOLELY RESPONSIBLE FOR
DETERMINING WHETHER ANY THIRD PARTY PATENT OR COPYRIGHT LICENSES, INCLUDING BUT
NOT LIMITED TO VARIOUS AUDIO AND VISUAL STANDARDS, ARE NECESSARY TO USE, IMPLEMENT
OR DISTRIBUTE THIS PRODUCT, WHICH INCLUDES ANY OR ALL SOFTWARE OR HARDWARE.
LICENSEE IS RESPONSIBLE TO ADVISE LICENSEE'S CUSTOMERS OF THE LIMITATIONS PROVIDED
HEREIN.

LIMITATION OF LIABILITY
UNDER NO CIRCUMSTANCES SHALL MATROX, ITS SISTER COMPANIES AND ITS SUBSIDIARIES BE
LIABLE FOR ANY DIRECT, INDIRECT, PUNITIVE, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL
DAMAGES THAT RESULT FROM THE USE OF, OR INABILITY TO USE, THE SOFTWARE. THIS
LIMITATION APPLIES WHETHER THE ALLEGED LIABILITY IS BASED ON CONTRACT, TORT,
NEGLIGENCE, STRICT LIABILITY, OR ANY OTHER BASIS, EVEN IF MATROX HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE. BECAUSE SOME JURISDICTIONS DO NOT ALLOW THE
EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, MATROX'S LIABILITY
IN SUCH JURISDICTIONS SHALL BE LIMITED TO THE MINIMUM REQUIRED BY LAW.

UNAUTHORIZED USE.  THIS SOFTWARE AND ANY DOCUMENTATION RELATED THERETO ARE NOT
DESIGNED, INTENDED, AUTHORIZED OR WARRANTED TO BE SUITABLE FOR USE OR RESALE IN ANY
TYPE OF SYSTEM OR OTHER APPLICATIONS RELATED TO, HAZARDOUS OR POTENTIALLY
HAZARDOUS ENVIRONMENTS OR APPLICATIONS REQUIRING HIGH-AVAILABILITY OR FAIL-SAFE
PERFORMANCE, WHERE PERSONAL INJURY OR DEATH MAY OCCUR, SUCH AS MEDICAL SYSTEMS,
LIFE SUSTAINING, LIFE SAVING SYSTEMS, OPERATION OF NUCLEAR FACILITIES, AIRCRAFT
NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, PUBLIC WORKS, WEAPONS
SYSTEMS, OR ANY OTHER APPLICATION IN WHICH THE FAILURE OF A PRODUCT COULD LEAD TO
PROPERTY DAMAGE, ENVIRONMENTAL DAMAGE, OR PERSONAL INJURY. LICENSEE WILL NOT USE,
OR PERMIT TO BE USED, THE PRODUCTS FOR SUCH HIGH-AVAILABILITY, FAIL-SAFE OR CRITICAL
APPLICATIONS AND FURTHER, LICENSEE AGREES TO INDEMNIFY, DEFEND AND HOLD HARMLESS
MATROX AND ITS MANAGERS, DIRECTORS, OFFICERS, EMPLOYEES, AGENTS, AFFILIATES,
SUCCESSORS, AND ASSIGNS FROM AND AGAINST ANY ACTION, SUIT, PROCEEDING, COST,
EXPENSE, DAMAGES, AND LIABILITY (INCLUDING, BUT NOT LIMITED TO, REASONABLE
ATTORNEYS' FEES) ARISING OUT OF, OR RELATED TO, THE BREACH OF LICENSEE'S OBLIGATIONS
RELATED HERETO, EVEN IF SUCH CLAIM ALLEGES THAT MATROX WAS NEGLIGENCE REGARDING
THE DESIGN OR MANUFACTURE OF THE SOFTWARE.

TERMINATION
This License will automatically terminate if Licensee fails to comply with any of the terms and conditions hereof. In
such event, Licensee must destroy all copies of the Software and all of its component parts. Matrox reserves the right
to terminate this License without prejudice to any additional recourses Matrox may have against Licensee if Licensee
violates any of this Licenses' terms and conditions.
Matrox will not, by reason of the termination of this Agreement, be liable for compensation, reimbursement or
damages on account of the loss of prospective profits on anticipated sales, or on account of expenditures, investments,
leases, or commitments in connection with the Licensee's business or goodwill or otherwise.

Matrox Software License Agreement
If Licensee commences or participates in any legal proceeding against Matrox then Matrox may, in its sole discretion, suspend or terminate all license grants and any other rights provided under this License during the pendency of such legal proceedings.

**MISCELLANEOUS**

If any provision of this License is inconsistent with, or cannot be fully enforced under, the law, such provision will be construed as limited to the extent necessary to be consistent with and fully enforceable under the law. This License is the final, complete and exclusive agreement between the parties relating to the subject matter hereof, and supersedes all prior or contemporaneous understandings and agreements relating to such subject matter, whether oral or written. This License may only be modified in writing signed by an authorized officer of Matrox. Licensee agrees that it will not ship, transfer or export the Software into any country, or use the Software in any manner, prohibited by the United States Bureau of Industry and Security or any export laws, restrictions or regulations.

Controlling Law. The validity, performance and construction hereof shall be governed by and interpreted in accordance with the laws of the Province of Quebec. Both parties hereby irrevocably submit to the exclusive jurisdiction of the Courts of the district of Montreal, Province of Quebec, Canada with regard to any dispute arising out of or in connection with this Agreement.

Additional information may be available on the Matrox website. If used, this site may contain other proprietary notices and copyright information, the terms of which must also be observed and followed.

The failure of Matrox to enforce at any time any of the provisions of this Agreement, or the failure to require at any time performance by the Licensee of any of the provisions of this Agreement, shall in no way be construed to be a present or future waiver of such provisions, nor in any way affect the right of Matrox to enforce each and every such provision thereafter.

All rights reserved by Matrox.

Matrox reserves the right to change Software specification without notice. All intellectual property, including without limitation, trademarks and copyrights are the property of their respective owners and any unauthorized use thereof is strictly prohibited.

COPYRIGHT © 2012 Matrox is a trademark of Matrox Electronic Systems Ltd.
MXO2 LE RS-422 serial connection ................................................... 37
Typical Matrox MXO2 LE connections ................................................ 38
  Analog component video connections ............................................ 38
  Digital video connections ............................................................. 39

Chapter 6
Connecting External Devices to Matrox MXO2 Mini
Available MXO2 Mini connections ................................................ 42
  MXO2 video and audio connections ............................................... 42
Powering MXO2 Mini ..................................................................... 42
  MXO2 Mini power supply and adapter plugs .................................. 42
Connecting MXO2 Mini to your computer ....................................... 44
  Ensuring proper PCIe cable connection ......................................... 44
  Using Matrox MXO2 Dock ............................................................. 45
  Using the Matrox MXO2 Thunderbolt adapter ............................... 45
  Using the Matrox PCIe host adapters .......................................... 46
Connecting S-Video devices to MXO2 Mini ..................................... 47
Typical Matrox MXO2 Mini connections ........................................ 48
  Analog component video connections ........................................ 48
  HDMI video connections ............................................................ 49

Chapter 7
Configuring Your MXO2 System
Introduction .................................................................................. 52
Custom presets ............................................................................. 52
  Saving custom presets ................................................................. 52
  Loading custom presets ............................................................. 52
Specifying your general settings .................................................... 53
Specifying your genlock settings ..................................................... 54
Specifying your A/V input settings .................................................. 55
Specifying your video output settings ............................................. 58
Specifying your audio output settings ............................................. 62
Closed captioning and AFD ......................................................... 64
  Adobe closed caption playback ................................................... 64
  Matrox 4VANC capture and playback ........................................... 66
Specifying your Matrox WYSIWYG settings .................................. 70
Contents

Outputs
MXO2 outputs ................................................................. 163
MXO2 Rack outputs .......................................................... 164
MXO2 LE outputs ............................................................. 165
MXO2 Mini outputs ............................................................ 166
Output connector descriptions .......................................... 167
Output connector descriptions (MXO2 Mini) ....................... 169

Appendix C
Matrox MXO2 Supported Input and Capture Formats
  Supported input formats .................................................... 172
  Supported capture formats ................................................ 174

Appendix D
Matrox MXO2 Supported Output Formats
  Supported main and SD video output formats ...................... 178
    Avid Media Composer/Symphony ......................................... 181
  Video formats supported on MXO2 outputs ......................... 182

Chapter E
Connecting and Using Matrox MXO2 Dock
  Powering Matrox MXO2 Dock ............................................. 184
    MXO2 Dock power supply and adapter plugs ..................... 184
  Connecting MXO2 Dock to your MXO2 system ....................... 186
    Connecting to Matrox MXO2 ............................................. 186
  Connecting to Matrox MXO2 Rack ....................................... 187
  Connecting to Matrox MXO2 LE .......................................... 188
  Connecting to Matrox MXO2 Mini ....................................... 189
  Available MXO2 Dock connections .................................... 190
    HDMI ............................................................................. 190
    Gigabit Ethernet ......................................................... 191
    USB ............................................................................. 191
  Understanding the MXO2 Dock status LED ......................... 191
Appendix F

Matrox MXO2 Specifications

Matrox MXO2 specifications .............................................................194
  General .................................................................................................194
  Connections ............................................................................................194
  Environmental specifications ..............................................................198

Matrox MXO2 Rack specifications ....................................................198
  General .................................................................................................198
  Connections ............................................................................................199
  Environmental specifications ..............................................................202

Matrox MXO2 LE specifications ....................................................... 203
  General .................................................................................................203
  Connections ............................................................................................203
  Environmental specifications ..............................................................207

Matrox MXO2 Mini specifications ..................................................... 207
  General .................................................................................................207
  Connections ............................................................................................207
  Environmental specifications ..............................................................210

Matrox MXO2 Thunderbolt adapter specifications ............................ 211

Matrox MXO2 Dock specifications .................................................... 211
  Connections ............................................................................................211
  Environmental specifications ..............................................................212

Matrox PCIe host adapter specifications ..........................................212
  Matrox PCIe host ExpressCard/34 adapter (for laptops) .................. 212
  Matrox PCIe host adapter (for desktops) .............................................. 212

Appendix G

Matrox Customer Support

How to get Matrox customer support ..............................................214
  Registration ..............................................................................................214
  Keep up to date with our website ..........................................................214
  Contacting us ..........................................................................................214

Index ........................................................................................................215
Introducing Matrox MXO2

This chapter lists the MXO2 system requirements, details the battery requirements and guidelines, and describes the MXO2 documentation.
Chapter 1, Introducing Matrox MXO2

Welcome to Matrox MXO2

Matrox MXO2 connects to your Mac system to provide broadcast-quality input/output, monitoring, and up/down/cross conversion to streamline your workflow with supported video editing applications. MXO2 provides built-in surround sound monitoring, as well as the flexibility to map any audio track from a video editing application to any audio output. MXO2 also features the Matrox HDMI Calibration Utility, which is a unique tool designed to calibrate your RGB HDMI monitor or television so that it performs like a traditional broadcast video monitor. For Matrox MXO2 products with Matrox MAX technology, the dedicated hardware processor accelerates the creation of H.264 .mov files for Blu-ray Disc, the web, and mobile devices.

Matrox MXO2 system requirements

Matrox MXO2 requires a Mac system with the following configuration:

\[\text{Note}\] For the most up-to-date system requirements, including the supported versions of the operating system and programs, see the Matrox MXO2 Support section of our website at www.matrox.com/video/support.

- Mac OS X Mountain Lion and Lion. For the supported OS versions for this release, see the “Supported OS and Applications” document provided in the “Downloads” section of the Matrox MXO2 Support website.

\[\text{Note}\] MXO2 Dock is supported with Mac OS X Mountain Lion only.

- One free PCIe slot to install the Matrox PCIe host adapter (for desktops), or one free ExpressCard/34 slot to install the Matrox PCIe host ExpressCard/34 adapter (for laptops), or one free Thunderbolt port to connect the Matrox MXO2 Thunderbolt adapter or MXO2 Dock.

\[\text{Note}\] A third-party Thunderbolt cable is required to connect the Matrox MXO2 Thunderbolt adapter or Matrox MXO2 Dock to your computer.

- We recommend an HDMI monitor that supports the following:
  - An HDMI input resolution of 1920×1080 for previewing all HD formats.
  - 1:1 pixel mapping for displaying your MXO2 output at its exact resolution, and for use with the Matrox HDMI Calibration Utility.

Supported programs

For a complete list of the third-party applications supported with this release, see the “Supported OS and Applications” document provided in the “Downloads” section of the Matrox MXO2 Support website.
Check our website for equipment information
For up-to-date information about recommended computer systems, batteries, and other MXO2-compatible devices, check the Matrox MXO2 Support section of our website at www.matrox.com/video/support.

Battery requirements and guidelines for MXO2

**Note** This section does not apply to Matrox MXO2 Rack and Matrox MXO2 Mini as they cannot be powered by a battery.

As an alternative to using an AC outlet, you can use a battery to power Matrox MXO2 or MXO2 LE. To avoid damage to your MXO2 system and peripheral devices when using a battery, please observe the following requirements and guidelines. For instructions on how to connect a battery, see “Powering MXO2” on page 12 or “Powering MXO2 LE” on page 32.

- Use a standard self-protected (fused) battery with a nominal voltage of 12V, 13.2V, or 14.4V. A higher-voltage battery will damage your MXO2 system.
- Disconnect MXO2 from the battery when not in use. Do not leave MXO2 connected to the battery when not in use as this may damage your MXO2 system and/or battery.
- Do not power your MXO2 using your vehicle’s battery via the power socket.

**Caution** To avoid damage to your MXO2 system and peripheral devices, use a Matrox-recommended battery. For a list of batteries recommended for use with your MXO2, visit the Matrox MXO2 Support section of our website at www.matrox.com/video/support.

About this manual
This manual provides you with information about installing and using your Matrox MXO2 hardware and software, including how to configure your Matrox MXO2 for use with supported programs.

Style conventions
The following style conventions are used in this manual:

- The names of files, folders, and manuals appear in *italics*. For example:
  - The data is stored in the *Sample Movie* file.
  - The file is located in the *Clips* folder.
  - Please refer to your *Matrox MXO2 Installation and User Guide*.
- Menus and commands that you need to choose are displayed in the form **Menu > Command**. For example, **File > Save** means click **File** in the menu bar, and then click **Save** in the menu that appears.

Battery requirements and guidelines for MXO2
**How video formats are expressed**

With the exception of NTSC and PAL, all SD and HD video formats are expressed in the Matrox MXO2 documentation as follows:

VRp or i or PsF at n fps

Where:

- **VR** is the vertical resolution. For 1440×1080 video, however, both the horizontal and vertical resolutions are specified.
- **p** or **i** or **PsF** represents either progressive, interlaced, or progressive segmented frame video.
- **n fps** is the frame rate in frames per second.

Here are some examples:

- **486p at 23.98 fps**  Represents 720×486 progressive video at 23.98 frames per second.
- **720p at 59.94 fps**  Represents 1280×720 progressive video at 59.94 frames per second.
- **1440x1080i at 29.97 fps**  Represents 1440×1080 interlaced video at 29.97 frames per second. This format is used for HDV 1080i material.
- **1080i at 29.97 fps**  Represents full-size 1920×1080 interlaced video at 29.97 frames per second.

**Last-minute information**

Any important information that wasn’t available for inclusion in this manual by publication time is provided to you in the *Matrox MXO2 Release Notes*. 
Installing Your Matrox MXO2 Hardware and Software

This chapter describes how to install Matrox MXO2 hardware (PCIe adapters only) and software.
Important installation information

This chapter explains how to install Matrox software and hardware on your Mac system. However, hardware installation is required only if you’ll be using MXO2 with the Matrox MXO2 PCIe host adapter or Matrox MXO2 PCIe ExpressCard/34 adapter. If you want to use MXO2 with the Matrox MXO2 Thunderbolt adapter or MXO2 Dock, hardware installation is not required.

Before installing your Matrox hardware

Read the following information carefully before attempting to install the Matrox MXO2 PCIe host adapter on your Mac system.

Start with a functioning system

Before attempting any Matrox MXO2 installation, you should have a Mac computer system with Mac OS X fully installed and functioning smoothly. This will avoid potential problems later on.

Avoid costly damage

Static electricity from your body can damage your Matrox PCIe host adapter or your computer. Although you may not notice it, static electricity is generated every time you move. It’s often too small to cause a spark, but it can still cause damage to sensitive electronic components or at least reduce their lifespan.

To avoid damage, please observe the following precautions:

• Do not remove your Matrox PCIe host adapter from its antistatic bag until you’re ready to install it. Before removing the card, place the package within easy reach of the area where you intend to perform the installation.

• You should avoid touching the chips and other components on the circuit board. Try to handle the card by its edges.

• Try to work in an area where the relative humidity is at least 50%.

• Do not wear wool or synthetic clothing. These fabrics tend to generate more static electricity than cotton, which is best for this kind of work.

• Turn off the power switches on your computer and its connected components.

Once you’ve opened your computer, drain static electricity from your body by touching a bare metal surface on your computer chassis before you install or remove any parts of your system. If you have a grounding wrist strap, use it while handling and installing any components in your computer.

Installing your Matrox PCIe adapter

This section details how to install the Matrox MXO2 host adapter and Matrox MXO2 host ExpressCard/34 adapter on your Mac computer.
Note  If you want to use MXO2 with the Matrox MXO2 Thunderbolt adapter or MXO2 Dock, hardware installation is not required.

Installing your PCIe host adapter (for desktops)
The Matrox PCIe host adapter is a standard low-profile PCIe x1 card designed to operate in an Intel-based Mac system. For detailed instructions on how to perform the following steps, refer to your Mac desktop computer’s documentation.

1. Shut down the computer, unplug the power cord and all the cables from the unit, and open the computer’s chassis.
2. Insert the Matrox PCIe host adapter in an available PCIe slot in the computer, and secure the adapter into place.
3. Close the computer chassis, and reconnect the power cord and all the cables to the unit.

Installing your PCIe host ExpressCard/34 adapter (for laptops)
The Matrox PCIe host ExpressCard/34 adapter is designed to operate in your Mac laptop’s ExpressCard/34 slot. You can install the Matrox PCIe host ExpressCard/34 adapter when your laptop is on or off. Connect the Matrox PCIe cable to the host ExpressCard/34 adapter, and then insert the host adapter in your laptop’s ExpressCard/34 slot until the adapter clicks into place. For details on how to safely remove your Matrox PCIe host ExpressCard/34 adapter from your laptop, see “Removing your PCIe host ExpressCard/34 adapter” on page 8.

Caution  To ensure functionality and avoid damaging the PCIe cable or host connector, the side labeled “B” on the PCIe cable connector must face the top of the Matrox PCIe ExpressCard/34 adapter.
Removing your PCIe host ExpressCard/34 adapter
You can remove the Matrox PCIe host ExpressCard/34 adapter when the laptop is either on or off. However, you must power off the card before removing it.

**Important** Do not disconnect the PCIe cable from the Matrox PCIe host ExpressCard/34 adapter when your laptop is running. Instead, remove the adapter from your laptop with the Matrox PCIe cable attached.

1. Close all video/audio applications that are running on your system.
2. From the menu bar, click the ExpressCard icon ( ).
3. Click **Power off Card**.
4. Remove the Matrox PCIe host ExpressCard/34 adapter from your laptop’s ExpressCard/34 slot.

Installing your Matrox MXO2 software
You can install the MXO2 software on a computer with or without the MXO2 hardware connected. To download and install the latest version of the MXO2 software, visit the MXO2 Support section of our website at [www.matrox.com/video/support](http://www.matrox.com/video/support). You can also contact your MXO2 dealer for the latest software.

**Important**
- If your MXO2 system also includes a Matrox CompressHD card, you **must** install the Matrox MAX Utilities software, even if your MXO2 hardware does not include Matrox MAX technology. Installing the Matrox MAX Utilities software installs the software for your CompressHD card as well. If the CompressHD software is already installed on your computer, you must uninstall it before installing the Matrox MAX Utilities software.
- If you plan on working with a supported video editing application, such as Adobe Premiere Pro, you **must** install that application before installing the MXO2 software.

Updating your MXO2 firmware
When you install the MXO2 software while your MXO2 hardware is powered and connected to your Mac system, the software installation automatically verifies the firmware on your MXO2 hardware and updates it if required. However, if you install the MXO2 software on your Mac system without a powered MXO2 connected, your MXO2 hardware may have a firmware version that is not supported by the installed MXO2 software. If your MXO2 hardware has an incompatible firmware version when you later connect the MXO2 hardware to your Mac system, the **Matrox Utilities** preferences window options will be unavailable and a message regarding the incompatibility between the
Removing your Matrox MXO2 software

Perform the following steps to remove the MXO2 software from your Mac system.

1. In the Finder menu, choose File > New Finder Window.
2. In the Applications folder, click the Matrox utilities folder, and then double-click the software uninstaller file.
3. In the uninstaller dialog box, select or clear the Delete the Matrox software user preferences option. When selected, all current user settings in the Matrox Utilities preferences window will be removed from your computer. Clear this option if you wish to keep your current MXO2 user settings for a future MXO2 software installation.
4. Click Continue.
5 Enter your administrator password, and click **OK** to remove the MXO2 software from your computer.
Connecting External Devices to Matrox MXO2

This chapter shows how to supply power and connect external devices to Matrox MXO2.
Note This chapter details how to connect external devices to Matrox MXO2 only. For another MXO2 product, see Chapter 4, “Connecting External Devices to Matrox MXO2 Rack”, Chapter 5, “Connecting External Devices to Matrox MXO2 LE”, or Chapter 6, “Connecting External Devices to Matrox MXO2 Mini.”

Available MXO2 connections
Matrox MXO2 features a full compliment of professional inputs and outputs, and allows you to connect multiple devices for up to five user-selectable simultaneous video outputs.

MXO2 video connections
- One HD HDMI input and one HD/SD HDMI output, both with up to eight channels of embedded audio support. The HDMI input/output supports YUV and RGB devices.
- One HD/SD SDI input and two HD/SDI outputs with up to 16 channels of embedded audio. Both SDI outputs simultaneously output the same video and embedded audio.
- One HD/SD analog component input/output, one S-Video input/output, and one composite input/output.
- Analog black burst reference input.

MXO2 audio connections
- Two balanced analog XLR inputs (stereo pair).
- Four balanced analog XLR outputs (two stereo pairs).
- One AES/EBU stereo input/output.
- Two unbalanced analog RCA inputs (stereo pair).
- Six unbalanced analog RCA outputs (for surround sound monitoring).

Powering MXO2
Supply power to MXO2 using an AC outlet via the Matrox external power supply and a power cord, or using a battery via the Matrox battery power cable. Matrox MXO2 connects to the battery via a 4-pin XLR connector. For information on how to connect your battery to portable video equipment, such as Matrox MXO2, contact the battery manufacturer. Before connecting MXO2 to a battery, please read the “Battery requirements and guidelines for MXO2” on page 3.

MXO2 power functionality
MXO2 features a power button that you can use to manually turn the MXO2 on and off. However, when power is supplied to MXO2 and it is connected to your Mac system, the MXO2 will turn on or off automatically when you start up or...
shut down your Mac system. That is, when you shut down your Mac system, your MXO2 turns off. Starting up your Mac system turns your MXO2 on. To manually turn your MXO2 on, press the power button. To turn off your MXO2, press and hold the power button for at least two seconds.

**Important** When MXO2 is connected to a Mac system that is running, do not disconnect MXO2 from its power source, or power off MXO2. Shut down your Mac system before removing power from MXO2. If using a battery to power MXO2, ensure that the battery is sufficiently charged.

**Caution** When disconnecting the power supply from MXO2, make sure that you slide back the casing on the connector to release the locking mechanism.
Connecting MXO2 to your Mac system

Connect MXO2 to your Mac system using the Matrox PCIe cable and the appropriate Matrox host adapter or MXO2 Dock.

Ensuring proper PCIe cable connection

To ensure functionality and avoid damaging the PCIe cable or host connector when connecting MXO2 to your computer, the PCIe cable must be connected to your MXO2 and host connector as shown below:

To Matrox MXO2
“B” side of PCIe cable must face the side labeled “HOST” on MXO2.

To Matrox PCIe ExpressCard/34 adapter
“B” side of PCIe cable must face the top of the Matrox PCIe ExpressCard/34 adapter.

To Matrox MXO2 Thunderbolt adapter
“B” side of PCIe cable must face the side labeled “HOST” on the Matrox MXO2 Thunderbolt adapter.

To Matrox MXO2 Dock
“B” side of PCIe cable must face the top of MXO2 Dock.

To Matrox PCIe host adapter
“B” side of PCIe cable must face the side labeled “XI LINK” on the Matrox PCIe host adapter.
Using Matrox MXO2 Dock
For instructions on how to connect and use Matrox MXO2 Dock, see Appendix E, “Connecting and Using Matrox MXO2 Dock,” on page 183.

Using the Matrox MXO2 Thunderbolt adapter
Use the Matrox MXO2 Thunderbolt adapter to connect MXO2 to your computer’s Thunderbolt port. When doing this, it may take up to ten seconds for your MXO2 to be detected by your system and its applications.

Important Make sure that the Matrox PCIe cable is connected to the adapter and MXO2 before connecting the adapter to your computer via the Thunderbolt cable. If you want to disconnect or connect MXO2 when your system is running, you must do it by disconnecting/connecting the Thunderbolt cable. Do not disconnect the Matrox PCIe cable from the adapter, or MXO2, when your Mac system is running.

Caution To ensure functionality and avoid damaging the PCIe cable or host connector, you must connect the PCIe cable as shown in “Ensuring proper PCIe cable connection” on page 14.

Connecting MXO2 to your Mac system
Using the Matrox PCIe host adapters

For MXO2 to be detected on a Mac desktop system, power must be supplied to MXO2 (see “Powering MXO2” on page 12), and it must be connected to your computer before starting up your system.

**Important** Do not disconnect the Matrox PCIe cable from the adapter, or MXO2, when your Mac system is running. To safely remove the Matrox PCIe host Expresscard/34 adapter, see “Removing your PCIe host ExpressCard/34 adapter” on page 8.

**Caution** To ensure functionality and avoid damaging the PCIe cable or host connector, you must connect the PCIe cable as shown in “Ensuring proper PCIe cable connection” on page 14.

To your laptop’s ExpressCard/34 slot (see “Installing your PCIe host ExpressCard/34 adapter (for laptops)” on page 9).
MXO2 RS-422 serial connection

MXO2’s RS-422 serial connector allows a video editing application, such as Adobe Premiere Pro, to control a device that uses the RS-422 SMPTE time code protocol, such as a VTR or digital disk recorder, to ensure frame-accurate capture and export to tape.
Typical Matrox MXO2 connections

In the following typical connection examples, we’ve connected a monitor to view the signal that will be recorded, and separate source and record decks. You may, however, use the same deck as both your source and record device by making the input and output connections to a single deck. For details on the Matrox MXO2 connectors, see Appendix B, “Matrox MXO2 Connectors.”

Analog component video connections

In this illustration, we’re using analog component connectors for video, XLR connectors for audio, and an HDMI connector for video monitoring. The video is genlocked using MXO2’s internal genlock.
Digital video connections

In this illustration, we’re using SDI connectors for video and audio, an SDI connector for video monitoring, and we’re monitoring the audio on a surround sound speaker system through RCA connectors. The video is genlocked using a tri-level sync generator.
Your notes
Connecting External Devices to Matrox MXO2 Rack

This chapter shows how to rack mount, supply power, and connect external devices to Matrox MXO2 Rack.
Note  This chapter details how to connect external devices to Matrox MXO2 Rack only. For another MXO2 product, see Chapter 3, “Connecting External Devices to Matrox MXO2”, Chapter 5, “Connecting External Devices to Matrox MXO2 LE”, or Chapter 6, “Connecting External Devices to Matrox MXO2 Mini.”

Available MXO2 Rack connections
Matrox MXO2 Rack features a full compliment of professional inputs and outputs, and allows you to connect multiple devices for up to five user-selectable simultaneous video outputs.

MXO2 Rack video connections
• One HD HDMI input and one HD/SD HDMI output, both with up to eight channels of embedded audio support. The HDMI input/output supports YUV and RGB devices.
• One HD/SD SDI input and two HD/SDI outputs with up to 16 channels of embedded audio. Both SDI outputs simultaneously output the same video and embedded audio.
• One HD/SD analog component input/output, one S-Video input/output, and one composite input/output.
• One analog black burst reference input and loop-through output.

MXO2 Rack audio connections
• Four balanced analog XLR inputs (two stereo pairs).
• Eight balanced analog XLR outputs (four stereo pairs).
• Two AES/EBU stereo inputs/outputs.

Rack mounting your MXO2 Rack
Use the supplied rackmount brackets to mount your Matrox MXO2 Rack to a standard 19-inch rack. The rackmount brackets can be used to either front or rear mount your MXO2 Rack. You can also mount MXO2 Rack so that it’s recessed to allow more space for cables. MXO2 Rack takes up two vertical rack unit spaces.

1 Unpack the two rackmount brackets and their eight mounting screws.

Caution  Use only the screws supplied with your MXO2 Rack to attach the rackmount brackets to your MXO2 Rack. If you use screws that are larger or longer than the ones supplied, you can damage your equipment.

2 Depending if you want to front or rear mount your MXO2 Rack, position the rackmount brackets so that the bracket face is either towards the front (connector side) or the back of your MXO2 Rack.
MXO2 Rack can be recess mounted to allow extra space for connectors and cables. Depending on your mounting needs, align the screw holes on each rackmount bracket with the desired screw holes on either side of the MXO2 Rack.

Caution For stability and safety, whichever mounting method you choose, make sure to fasten each rackmount bracket to MXO2 Rack using all four supplied screws.

4 Using a hand screwdriver only (no power screwdrivers), carefully tighten each screw until snug. Do not overtighten!

5 Fasten your MXO2 Rack to the standard 19-inch rack as per your rack’s instructions.
Powering MXO2 Rack

You can power MXO2 Rack using an AC outlet and an IEC-C13 power cord.

**MXO2 power functionality**

When power is supplied to MXO2 Rack and it is connected to your Mac system, the MXO2 Rack will turn on or off automatically when you start up or shut down your Mac system. That is, when you shut down your Mac system, your MXO2 Rack turns off. Starting up your Mac system turns your MXO2 Rack on.

**Important** When MXO2 Rack is connected to a Mac system that is running, do not disconnect MXO2 Rack from its power source. Shut down your Mac system before removing power from MXO2 Rack.

![Diagram of MXO2 Rack with AC outlet and IEC-C13 power cord connections.]
Connecting MXO2 Rack to your Mac system

Connect MXO2 Rack to your Mac system using the Matrox PCIe cable and the appropriate Matrox host adapter or MXO2 Dock.

Ensuring proper PCIe cable connection

To ensure functionality and avoid damaging the PCIe cable or host connector when connecting MXO2 Rack to your computer, the PCIe cable must be connected to your MXO2 Rack and host connector as shown below:

To Matrox MXO2 Rack
“B” side of PCIe cable must face the side labeled “HOST” on MXO2 Rack.

To Matrox PCIe ExpressCard/34 adapter
“B” side of PCIe cable must face the top of the Matrox PCIe ExpressCard/34 adapter.

To Matrox MXO2 Thunderbolt adapter
“B” side of PCIe cable must face the side labeled “HOST” on the Matrox MXO2 Thunderbolt adapter.

To Matrox MXO2 Dock
“B” side of PCIe cable must face the top of MXO2 Dock.

To Matrox PCIe host adapter
“B” side of PCIe cable must face the side labeled “XI LINK” on the Matrox PCIe host adapter.

Connecting MXO2 Rack to your Mac system
**Using Matrox MXO2 Dock**

For instructions on how to connect and use Matrox MXO2 Dock, see Appendix E, “Connecting and Using Matrox MXO2 Dock,” on page 183.

**Using the Matrox MXO2 Thunderbolt adapter**

Use the Matrox MXO2 Thunderbolt adapter to connect MXO2 Rack to your computer’s Thunderbolt port. When doing this, it may take up to ten seconds for your MXO2 Rack to be detected by your system and its applications.

**Important** Make sure that the Matrox PCIe cable is connected to the adapter and MXO2 Rack before connecting the adapter to your computer via the Thunderbolt cable. If you want to disconnect or connect MXO2 Rack when your system is running, you must do it by disconnecting/connecting the Thunderbolt cable. Do not disconnect the Matrox PCIe cable from the adapter, or MXO2 Rack, when your Mac system is running.

**Caution** To ensure functionality and avoid damaging the PCIe cable or host connector, you must connect the PCIe cable as shown in “Ensuring proper PCIe cable connection” on page 25.
Using the Matrox PCIe host adapters
For MXO2 Rack to be detected on a Mac desktop system, power must be supplied to MXO2 Rack (see “Powering MXO2 Rack” on page 24), and it must be connected to your computer before starting up your system.

**Important** Do not disconnect the Matrox PCIe cable from the adapter, or MXO2 Rack, when your Mac system is running. To safely remove the Matrox PCIe host Expresscard/34 adapter, see “Removing your PCIe host ExpressCard/34 adapter” on page 8.

**Caution** To ensure functionality and avoid damaging the PCIe cable or host connector, you must connect the PCIe cable as shown in “Ensuring proper PCIe cable connection” on page 25.

To your laptop’s ExpressCard/34 slot (see “Installing your PCIe host ExpressCard/34 adapter (for laptops)” on page 9).

Connecting MXO2 Rack to your Mac system
MXO2 Rack RS-422 serial connection

The Matrox MXO2 Rack RS-422 serial connector allows a video editing application, such as Adobe Premiere Pro, to control a device that uses the RS-422 SMPTE time code protocol, such as a VTR or digital disk recorder, to ensure frame-accurate capture and export to tape.
Typical Matrox MXO2 Rack connections

In the following typical connection examples, we’ve connected a monitor to view the signal that will be recorded, and separate source and record decks. You may, however, use the same deck as both your source and record device by making the input and output connections to a single deck. For details on the Matrox MXO2 Rack connectors, see Appendix B, “Matrox MXO2 Connectors.”

Analog component video connections

In this illustration, we’re using analog component connectors for video, XLR connectors for audio, and an HDMI connector for video monitoring. The video is genlocked using MXO2’s internal genlock.
**Digital video connections**

In this illustration, we’re using SDI connectors for video and audio, an SDI connector for video monitoring, and we’re monitoring the audio on a surround sound speaker system through XLR connectors. The video is genlocked using a tri-level sync generator.

To another device’s reference input. If not used, terminate the signal with a BNC 75-ohm terminator.

---

Chapter 4, Connecting External Devices to Matrox MXO2 Rack
Connecting External Devices to Matrox MXO2 LE

This chapter shows how to supply power and connect external devices to Matrox MXO2 LE.
Note  This chapter details how to connect external devices to Matrox MXO2 LE only. For another MXO2 product, see Chapter 3, “Connecting External Devices to Matrox MXO2”, Chapter 4, “Connecting External Devices to Matrox MXO2 Rack”, or Chapter 6, “Connecting External Devices to Matrox MXO2 Mini.”

Available MXO2 LE connections
Matrox MXO2 LE features a full compliment of professional inputs and output, and allows you to connect multiple devices for up to five user-selectable simultaneous video outputs.

MXO2 LE video connections
- One HD HDMI input and one HD/SD HDMI output, both with up to eight channels of embedded audio support. The HDMI input/output supports YUV and RGB devices.
- One HD/SD SDI input and two HD/SDI outputs with up to 16 channels of embedded audio. Both SDI outputs simultaneously output the same video and embedded audio.
- One HD/SD analog component input/output, one S-Video input/output, and one composite input/output.
- Analog black burst reference input.

MXO2 LE audio connections
- Two balanced analog XLR inputs/outputs (stereo pair).
- Two unbalanced analog RCA inputs/outputs (stereo pair).

Powering MXO2 LE
Supply power to MXO2 LE using an AC outlet via the Matrox external power supply and a power cord, or using a battery. Matrox MXO2 LE connects to the battery via a 4-pin XLR connector. For information on how to connect your battery to portable video equipment, such as Matrox MXO2 LE, contact the battery manufacturer. Before connecting MXO2 LE to a battery, please read the “Battery requirements and guidelines for MXO2” on page 3.

MXO2 LE power functionality
MXO2 LE features a power button that you can use to manually turn the MXO2 LE on and off. However, when power is supplied to MXO2 LE and it is connected to your Mac system, the MXO2 LE will turn on or off automatically when you start up or shut down your Mac system. That is, when you shut down your Mac system, your MXO2 LE turns off. Starting up your Mac system turns your MXO2 LE on. To manually turn your MXO2 LE on, press the power button.
To turn off your MXO2 LE, press and hold the power button for at least two seconds.

**Important** When MXO2 LE is connected to a Mac system that is running, do not disconnect MXO2 LE from its power source, or power off MXO2 LE. Shut down your Mac system before removing power from MXO2 LE. If using a battery to power MXO2 LE, ensure that the battery is sufficiently charged.
Connecting MXO2 LE to your Mac system

Connect MXO2 LE to your Mac system using the Matrox PCIe cable and the appropriate Matrox host adapter or MXO2 Dock.

Ensuring proper PCIe cable connection

To ensure functionality and avoid damaging the PCIe cable or host connector when connecting MXO2 LE to your computer, the PCIe cable must be connected to your MXO2 LE and host connector as shown below:

To Matrox MXO2 LE
“B” side of PCIe cable must face the side labeled “HOST” on MXO2 LE.

To Matrox PCIe ExpressCard/34 adapter
“B” side of PCIe cable must face the top of the Matrox PCIe ExpressCard/34 adapter.

To Matrox MXO2 Thunderbolt adapter
“B” side of PCIe cable must face the side labeled “HOST” on the Matrox MXO2 Thunderbolt adapter.

To Matrox MXO2 Dock
“B” side of PCIe cable must face the top of MXO2 Dock.

To Matrox PCIe host adapter
“B” side of PCIe cable must face the side labeled “XI LINK” on the Matrox PCIe host adapter.
Using Matrox MXO2 Dock
For instructions on how to connect and use Matrox MXO2 Dock, see Appendix E, “Connecting and Using Matrox MXO2 Dock,” on page 183.

Using the Matrox MXO2 Thunderbolt adapter
Use the Matrox MXO2 Thunderbolt adapter to connect MXO2 LE to your computer’s Thunderbolt port. When doing this, it may take up to ten seconds for your MXO2 LE to be detected by your system and its applications.

Important Make sure that the Matrox PCIe cable is connected to the adapter and MXO2 LE before connecting the adapter to your computer via the Thunderbolt cable. If you want to disconnect or connect MXO2 LE when your system is running, you must do it by disconnecting/connecting the Thunderbolt cable. Do not disconnect the Matrox PCIe cable from the adapter, or MXO2 LE, when your Mac system is running.

Caution To ensure functionality and avoid damaging the PCIe cable or host connector, you must connect the PCIe cable as shown in “Ensuring proper PCIe cable connection” on page 34.

Connecting MXO2 LE to your Mac system
Using the Matrox PCIe host adapters

For MXO2 LE to be detected on a Mac desktop system, power must be supplied to MXO2 LE (see “Powering MXO2 LE” on page 32), and it must be connected to your computer before starting up your system.

**Important** Do not disconnect the Matrox PCIe cable from the adapter, or MXO2 LE, when your Mac system is running. To safely remove the Matrox PCIe host Expresscard/34 adapter, see “Removing your PCIe host ExpressCard/34 adapter” on page 8.

To your laptop’s ExpressCard/34 slot (see “Installing your PCIe host ExpressCard/34 adapter (for laptops)” on page 9).
MXO2 LE RS-422 serial connection
MXO2 LE’s RS-422 serial connector allows a video editing application, such as Adobe Premiere Pro, to control a device that uses the RS-422 SMPTE time code protocol, such as a VTR or digital disk recorder, to ensure frame-accurate capture and export to tape.
Typical Matrox MXO2 LE connections

In the following typical connection examples, we’ve connected a monitor to view the signal that will be recorded, and separate source and record decks. You may, however, use the same deck as both your source and record device by making the input and output connections to a single deck. For details on the Matrox MXO2 LE connectors, see Appendix B, “Matrox MXO2 Connectors.”

Analog component video connections

In this illustration, we’re using analog component connectors for video, XLR connectors for audio, and an HDMI connector for video monitoring. The video is genlocked using MXO2 LE’s internal genlock.
Digital video connections
In this illustration, we’re using SDI connectors for video and audio, an SDI connector for video monitoring, and we’re monitoring the audio on a surround sound speaker system through an HDMI connector. The video is genlocked using a tri-level sync generator.
40

Your notes
Connecting External Devices to Matrox MXO2 Mini

This chapter shows how to supply power and connect external devices to Matrox MXO2 Mini.
Available MXO2 Mini connections

Matrox MXO2 Mini provides inputs and outputs for connecting external devices, including HDMI, analog component, S-Video, and composite video devices.

**MXO2 video and audio connections**

- One HD HDMI input and one HD/SD HDMI output, both with up to eight channels of embedded audio support. The HDMI input/output supports YUV and RGB devices.
- One HD/SD analog component input/output, or one S-Video input/output and one composite input/output.

*Note* S-Video input/output is available by using the provided S-Video adapters (see “Connecting S-Video devices to MXO2 Mini” on page 47).

- Two unbalanced analog RCA audio inputs/outputs (stereo pair).

**Powering MXO2 Mini**

You can supply power to MXO2 Mini using an AC outlet via the Matrox external power supply cable. To turn MXO2 Mini off, unplug the Matrox external power supply cable from the AC outlet while your computer is shut down.

*Important* When MXO2 Mini is connected to a computer that is running, do not disconnect MXO2 Mini from its power source. Shut down your computer before removing power from MXO2 Mini.

**MXO2 Mini power supply and adapter plugs**

MXO2 Mini provides an external power supply cable with international adapter plugs for use in different regions:

- To remove an adapter plug from the power adapter, hold down the button labeled **PUSH** on the power adapter, and then slide the adapter plug up until it releases from the power adapter.
- To insert an adapter plug into the power adapter, ensure that the adapter plug is properly aligned with the corresponding slot on the power adapter, and then slide the adapter plug down into the power adapter until it locks into place.
Powering MXO2 Mini

Removing an adapter plug

Inserting an adapter plug

To AC outlet

Power supply cable

MXO2 Mini

Powering MXO2 Mini
Connecting MXO2 Mini to your computer

Connect MXO2 Mini to your Mac system using the Matrox PCIe cable and the appropriate Matrox host adapter or MXO2 Dock.

Ensuring proper PCIe cable connection

To ensure functionality and avoid damaging the PCIe cable or host connector when connecting MXO2 Mini to your computer, the PCIe cable must be connected to your MXO2 Mini and host connector as shown below:

- **To Matrox MXO2 Mini**
  - “B” side of PCIe cable must face the side labeled “HOST” on MXO2 Mini.

- **To Matrox PCIe ExpressCard/34 adapter**
  - “B” side of PCIe cable must face the top of the Matrox PCIe ExpressCard/34 adapter.

- **To Matrox MXO2 Thunderbolt adapter**
  - “B” side of PCIe cable must face the side labeled “HOST” on the Matrox MXO2 Thunderbolt adapter.

- **To Matrox MXO2 Dock**
  - “B” side of PCIe cable must face the top of MXO2 Dock.

- **To Matrox PCIe host adapter**
  - “B” side of PCIe cable must face the side labeled “XI LINK” on the Matrox PCIe host adapter.
Using Matrox MXO2 Dock
For instructions on how to connect and use Matrox MXO2 Dock, see Appendix E, “Connecting and Using Matrox MXO2 Dock,” on page 183.

Using the Matrox MXO2 Thunderbolt adapter
Use the Matrox MXO2 Thunderbolt adapter to connect MXO2 Mini to your computer's Thunderbolt port. When doing this, it may take up to ten seconds for your MXO2 Mini to be detected by your system and its applications.

**Important** Make sure that the Matrox PCIe cable is connected to the adapter and MXO2 Mini before connecting the adapter to your computer via the Thunderbolt cable. If you want to disconnect or connect MXO2 Mini when your system is running, you must do it by disconnecting/connecting the Thunderbolt cable. Do not disconnect the Matrox PCIe cable from the adapter, or MXO2 Mini, when your Mac system is running.

**Caution** To ensure functionality and avoid damaging the PCIe cable or host connector, you must connect the PCIe cable as shown in “Ensuring proper PCIe cable connection” on page 44.
Using the Matrox PCIe host adapters

For MXO2 Mini to be detected on a Mac desktop system, power must be supplied to MXO2 Mini (see “Powering MXO2 Mini” on page 42), and it must be connected to your computer before starting up your system.

**Important** Do not disconnect the Matrox PCIe cable from the adapter, or MXO2 Mini, when your Mac system is running. To safely remove the Matrox PCIe host Expresscard/34 adapter, see “Removing your PCIe host ExpressCard/34 adapter” on page 8.

**Caution** To ensure functionality and avoid damaging the PCIe cable or host connector, you must connect the PCIe cable as shown in “Ensuring proper PCIe cable connection” on page 44.

To your laptop’s ExpressCard/34 slot (see “Installing your PCIe host ExpressCard/34 adapter (for laptops)” on page 9).
Connecting S-Video devices to MXO2 Mini

To support S-Video connections on MXO2 Mini, your MXO2 Mini kit includes two S-Video adapter cables (one for S-Video input and one for S-Video output).

Note When you connect an S-Video device to MXO2 Mini, you won’t be able to connect an analog component device at the same time.
Typical Matrox MXO2 Mini connections

In the following typical connection examples, we’ve connected a monitor to view the signal that will be recorded, and separate source and record decks. You may, however, use the same deck as both your source and record device by making the input and output connections to a single deck. For details on the Matrox MXO2 Mini connectors, see Appendix B, “Matrox MXO2 Connectors.”

Analog component video connections

In this illustration, we’re using component connectors for video, RCA connectors for audio, and an HDMI connector for video monitoring. The video is genlocked to the input source using MXO2 Mini’s built-in genlock.
**HDMI video connections**

In this illustration, we’re using HDMI for video, RCA connectors for audio, and S-Video for video monitoring. The video is genlocked to the input source using MXO2 Mini’s built-in genlock.

---

**Note**  When using HDMI connections, the embedded uncompressed HDMI audio is also available.
7

Configuring Your MXO2 System

This chapter explains how to configure your MXO2 settings.
Introduction

This chapter describes the settings in the Matrox Utilities preferences window for all MXO2 products. The Matrox Utilities preferences window allows you to specify various settings for working with MXO2. You can also save and load custom presets, and view information about your MXO2, such as the serial number and software version.

Depending on your MXO2 hardware, some of the options described in this chapter may not be available, and your Matrox Utilities preferences window may not appear exactly as shown.

Remarks

• Before defining your settings, make sure that you’ve installed your MXO2 hardware, powered your MXO2, and connected your MXO2 to your Mac system.

• If you have an MXO2 product with Matrox MAX technology, the MXO2 inputs and outputs will not be available when creating H.264 files using the Matrox MAX H.264 codec. This limitation, however, does not apply if your system includes a Matrox CompressHD card. In this case, the Matrox MAX H.264 codec on your CompressHD card will always be used for the encoding, and your Matrox inputs and outputs will be available when creating H.264 files. For details on using the Matrox MAX H.264 codec, see Chapter 10, “Using the Matrox MAX H.264 Codec.”

Custom presets

You can save and load custom presets of your Matrox MXO2 preference settings.

Saving custom presets

Saving a custom MXO2 preference settings preset creates a .plist file that you can load at any time. All settings, except the FCP X setting, are saved in your custom preset.

1. From the Apple menu, click System Preferences, and then click the Matrox Utilities icon.
2. Specify your MXO2 settings.
3. Click Save Preset, specify a filename and location, and then click Save.

Important Do not save your preset, or overwrite any Matrox files, in Users/~/Library/Preferences.

Loading custom presets

You can load a custom MXO2 preference settings preset at any time. Your MXO2 settings are automatically updated when you load a preset.
Specifying your general settings

You can specify general settings for working with Matrox MXO2. These settings are applied to the MXO2 video inputs and outputs.

1. From the Apple menu, click System Preferences, and then click the Matrox Utilities icon.
2. Click General.
3. Under Luminance Levels, select Allow super white to allow the highest luminance level of your video to exceed the standard maximum white level. Select Allow super black to allow the lowest luminance level of your video to fall below the standard black level.

Note Super white and super black should not be allowed when producing your final video production for broadcast.
4 Under **Setup Level**, select the pedestal setting that you want for your NTSC analog video from the **Analog NTSC pedestal** menu:
- **7.5 IRE** Applies the standard NTSC pedestal of 7.5 IRE.
- **0 IRE** Applies a pedestal of 0 IRE. You should select this option when working with a commercial DV device that uses the Japanese analog NTSC pedestal of 0 IRE. For example, if the video appears too bright when you play back DV clips on your NTSC monitor, you can change the pedestal to 0 IRE to output your DV clips at the correct brightness.

**Note** If your device has a different NTSC pedestal for input and output, you can switch the pedestal setting as needed before capturing or recording to tape.

### Specifying your genlock settings

**Note** This section does not apply to Matrox MXO2 Mini.

You can select the source to which you want to genlock all devices connected to your MXO2 system, as well as adjust the timing offset for all MXO2 video outputs.

1. From the **Apple** menu, click **System Preferences**, and then click the **Matrox Utilities** icon.
2. Click **Genlock**.
3 Select **Use external genlock source (REF)** if you connected an external analog genlock source to MXO2’s **REF/REF IN** connector, such as a bi-level analog black burst for SD or a tri-level sync for HD. If you don’t have an external genlock source connected to MXO2, clear this option to genlock to MXO2’s internal reference signal during playback, and genlock to your capture source during capture (see “Specifying your A/V input settings” on page 55).

**Remarks**
- When capturing RGB material from a DVI source using MXO2’s HDMI input, you must use an external genlock source.
- When capturing video with digital closed captioning (see “Matrox 4VANC capture and playback” on page 66), you must genlock to your capture source and not an external genlock source. Clear this option to genlock to your capture source.

To indicate whether or not MXO2 is presently locked to your external genlock source, the status will be displayed next to the **Genlock format** menu as **Locked** or **Not locked**.

4 From the **Genlock format** menu, select the video format of your external genlock source.

**Important** To ensure good output results, make sure that your genlock source’s video format is compatible with the MXO2 video output format.

5 Use the horizontal and vertical settings under **Video Output Timing Offset** to adjust the timing of the video output relative to your external genlock source. This lets you compensate for cable delays within your system.

**Specifying your A/V input settings**

You can select the MXO2 video and audio inputs to be used as your capture source. Only one video and audio input source can be used at a time. You can also capture your video to a different format than your source video by enabling scaling on the input.

**Note** When capturing, MXO2 outputs your source video at the capture format. The Matrox video output settings are ignored during capture.

For descriptions of the MXO2 inputs, see “Inputs” on page 156. For a list of the input and capture formats that are supported on MXO2, and to view the MXO2 input scaling options, see Appendix C, “Matrox MXO2 Supported Input and Capture Formats.”

**Note** The HDMI video input does not support SD video for capture. When capturing RGB material from a DVI source using MXO2’s HDMI input, you must use an external genlock source (see “Specifying your genlock settings” on page 54).
1 From the **Apple** menu, click **System Preferences**, and then click the **Matrox Utilities** icon.

2 Click **A/V Input**.

3 Under **Input Source**, select the **Video** and **Audio** inputs that you want to capture.

   **Remarks**
   - The **SDI embedded audio** option can be used with the **SDI** video input option only.
   - When capturing from an **HDMI** source, only uncompressed embedded audio is supported.

4 To capture an unstable or low-quality video signal, such as from a low-quality composite or S-Video VCR, select **Capture unstable video signals** to ensure that the capture application does not stop the capture due to a poor video signal/signal loss. The captured video, however, may include dropped or black frames. If this option is disabled, a low-quality video signal or signal loss may cause the capture application to stop the capture.

5 If the format to which you want to capture does not match the format of your source video, select **Scale input for capture**. **MXO2** will either upscale, downscale, or cross-convert to the desired capture format. For example, select **Scale input for capture** if your source video is 720p at 59.94 fps and...
you want to capture to 1080i at 29.97 fps. For a list of the input and capture formats that are supported on MXO2, and to view the MXO2 input scaling options, see Appendix C, “Matrox MXO2 Supported Input and Capture Formats.”

**Note** If scale input for capture is not selected, your capture format must match your source video’s format.

6 If you selected scale input for capture in step 5, select the format of your source video (MXO2 input) from the **Source format** list:

**Note** Depending on the input type selected in step 3, some options may not be available.

- **SD 4:3** Select this option for standard 4:3 NTSC or PAL video. When upscaling to HD, the video is captured in pillarbox format.
- **SD 16:9** Select this option for widescreen 16:9 NTSC or PAL video. When upscaling to HD, the video is captured in anamorphic format.
- **720p** Select this option for 720p video.
- **1080i** Select this option for 1080i video.
- **1080PsF** Select this option for 1080PsF video.
- **1080p** Select this option for 1080p video.

7 If you selected scale input for capture in step 5, select the **Aspect ratio formatting** option to be used when your source video’s aspect ratio does not match the capture aspect ratio:

- **Letterbox/Pillarbox** When capturing 16:9 video from a 4:3 source, your video is captured in pillarbox mode (black bars to the left and right of the picture). When capturing 4:3 video from a 16:9 source, your video is captured in letterbox mode (black bars at the top and bottom of the picture). When capturing SD 16:9 from an SD 4:3 source, this option is not supported and will result in anamorphic video.
- **Center cut/Center zoom** When capturing 16:9 video from a 4:3 source, your video is captured in center zoom mode (picture is zoomed with even cropping of the top and bottom edges of the picture). When capturing 4:3 video from a 16:9 source, your video is captured in center cut mode (even cropping of the left and right edges of the picture).
- **Anamorphic** Captures the source video so that the entire picture fills the capture aspect ratio, without cropping. The source video’s aspect ratio is not maintained.

**Specifying your A/V input settings**
Specifying your video output settings

MXO2 features simultaneous video outputs that allow you to send your video to a variety of devices at the same time. MXO2 provides two separate video output channels to choose from: main channel and SD channel. The video output settings allow you to set the main channel’s video format, assign a video channel to an MXO2 output, and define the channel’s behavior. You can also select other settings such as the scrub and pause method, and calibrate your HDMI monitor for video.

Note When capturing, MXO2 outputs your source video at the capture format. The Matrox video output settings are ignored during capture.

For a list of the supported video output formats for the MXO2 main and SD channels, and the supported video formats for the MXO2 outputs, see Appendix D, “Matrox MXO2 Supported Output Formats.”

Note When working with Apple Final Cut Pro X, changes made to certain video output settings won’t take effect until you play back the clip in Final Cut Pro X.

1. From the Apple menu, click System Preferences, and then click the Matrox Utilities icon.
2. Click Video Output.
3 For MXO2 Mini only, from the Active analog output menu, select the type of connection that you want to use for MXO2 Mini’s Y, Pb, and Pr output connectors (see “Outputs” on page 163).

Note When you connect an analog component device to MXO2 Mini, you won’t be able to connect an S-Video or composite device at the same time. If you’re outputting HD analog component video, the composite and S-Video outputs will be invalid.

4 From the Set main channel format to menu, you can select the video output format that you want for the MXO2 main channel. For a list of the supported video output formats for the MXO2 main and SD channels, see “Supported main and SD video output formats” on page 178.

- **Follow application** Sets the main channel’s video output to match your project’s video format, or to a compatible format for your project. For example, if your project’s video format is NTSC, the MXO2 main channel will be set to NTSC as well. If your project’s video format is 720p at 23.98 fps, the MXO2 main channel will be set to the compatible 720p at 59.94 fps output format.

- **486p/576p** Sets the main channel’s video output to either 486p or 576p, depending on your project’s video frame rate. For example, a 720p

Specifying your video output settings
at 23.98 fps project will be output as 486p, and a 720p at 25 fps project will be output as 576p.

- **720p** Sets the main channel’s video output to 720p at a frame rate compatible with your project’s video frame rate.

- **1080i/PsF** Sets the main channel’s video output to a 1080i or 1080PsF format, depending on your project’s video format. For 23.98 fps video, selecting this option outputs 1080PsF at 23.98 fps video by default. However, you can use the Pulldown feature (see step 5) to convert 1080PsF at 23.98 fps video to 1080i at 29.97 fps video at the output.

- **1080p** Sets the main channel’s video output to 1080p at a frame rate compatible with your project’s video frame rate.

5 If **1080i/PsF** was selected in step 4, select Pulldown to output 23.98 fps video as 1080i at 29.97 fps video instead of 1080PsF at 23.98 fps. Matrox uses standard pulldown to convert 1080PsF at 23.98 fps video to 1080i at 29.97 fps video. For a description of standard pulldown, see Appendix A, “Understanding Pulldown.”

6 Under Channel Selection, select the video channel (main or SD) that you want for your MXO2 analog (composite, S-Video, and component), SDI (not available on MXO2 Mini), and HDMI outputs:

- **Main channel** Outputs your project’s video as defined for the main channel (see step 4).

- **SD channel** Outputs your project’s video as NTSC or PAL, depending on your project’s video output frame rate.

7 Under Channel Behavior, select the Aspect ratio formatting option to be used for your video output when the source video’s aspect ratio does not match the main channel/SD channel output’s aspect ratio:

- **Letterbox/Pillarbox** When outputting 16:9 video from a 4:3 source, the video is output in pillarbox mode (black bars to the left and right of the picture). When outputting 4:3 video from a 16:9 source, the video is output in letterbox mode (black bars at the top and bottom of the picture). When outputting SD 16:9 from an SD 4:3 source, this option is not supported and will result in anamorphic video.

- **Center cut/Center zoom** When outputting 16:9 video from a 4:3 source, the video is output in center zoom mode (picture is zoomed with even cropping of the top and bottom edges of the picture). When outputting 4:3 video from a 16:9 source, the video is output in center cut mode (even cropping of the left and right edges of the picture).

- **Anamorphic** Outputs the source video so that the entire picture fills the capture aspect ratio, without cropping. The source video’s aspect ratio is not maintained. When outputting 4:3 video from a 16:9 source, select the
16:9 display setting on your NTSC/PAL monitor to display the video with the correct proportions.

8 Under **HDMI 3D Viewing Mode**, select the **3D Signal type** that will be sent to your 3D monitor via MXO2’s HDMI output. This option signals your 3D monitor to automatically switch to the selected 3D viewing mode. You must select the signal type that matches the 3D video that you want to output, or disable this option (this feature may not be supported on some 3D monitors).

- **Disabled** Select this if you’re not outputting 3D video, or to disable this option. You can still monitor 3D video, but you must select the correct viewing mode on your 3D monitor manually.

- **Side by Side** Select this for horizontally-compressed side-by-side 3D video (also referred to as side-by-side horizontal).

- **Over/Under** Select this for over/under 3D video (also referred to as top bottom).

**Note** If your Avid Media Composer or Avid Symphony project’s **Stereoscopic** setting is anything other than **Side by side, Over/Under, or Full**, make sure that you set the **HDMI 3D Viewing Mode** to **Disabled**. For example, if your project’s **Stereoscopic** setting is **Off** or **Leading Eye**, you must disable the **HDMI 3D Viewing Mode** option in order to properly view the HDMI output.

9 Under **Miscellaneous**, select **First field, Second field, or Both fields** from the **Scrub and pause** menu to indicate whether you want to display both fields or only one field when pausing video playback or scrubbing the timeline in your project. For example, you may want to scrub the first or second field to eliminate the flickering that can be seen in your picture when you pause while scrubbing interlaced video.

10 From the **Set HDMI output to** menu, select the type of video signal that you want to be sent from the HDMI output:

- **YUV** Outputs YUV HDMI video. Select this only if you connected the HDMI output to a device that accepts a YUV signal.

- **RGB - calibrated** Outputs adjusted RGB HDMI video using the currently loaded Matrox HDMI calibration settings for your HDMI monitor or television. For details on calibrating your HDMI monitor and loading HDMI calibration settings using the Matrox HDMI Calibration Utility, see Chapter 8, “Calibrating Your HDMI Monitor for Video.”

- **RGB - native** Outputs native RGB HDMI video that does not apply any calibration compensation. This is useful when you want to output RGB HDMI video to a device other than an HDMI monitor or television, such as an HDMI recorder to perform an export to tape.

**Specifying your video output settings**
11 From the **Set component output to** menu, select **YUV** or **RGB** to set the type of video that is sent from MXO2’s component (Y, Pb, Pr) output. For example, select **RGB** if your MXO2’s component output is connected to a device that accepts an RGB signal.

**Note** Component outputs are not available on MXO2 Mini.

12 Click the **Calibrate** button to calibrate your HDMI monitor or load HDMI calibration settings using the Matrox HDMI Calibration Utility (see Chapter 8, “Calibrating Your HDMI Monitor for Video”).

**Note** In order to run the Matrox HDMI Calibration Utility, the HDMI output type must be set to **RGB - calibrated** (see step 10).

### Specifying your audio output settings

MXO2’s simultaneous audio outputs allow you to send your audio to a variety of devices at the same time. You can also map any audio track in your video application to any MXO2 audio output. For descriptions of the MXO2 outputs, see “Outputs” on page 163.

**Important** Audio mapping must be disabled for surround sound HDMI audio output.

1 From the **Apple** menu, click **System Preferences**, and then click the **Matrox Utilities** icon.
2 Click **Audio Output**.

![Audio Output Settings](image)

**Note** The available MXO2 audio outputs depend on your MXO2 hardware.

3 Under **Audio Mapping**, select or clear the **Enable audio mapping** option. If this option is cleared, your application’s audio track outputs will be routed to the corresponding MXO2 audio outputs by default. For example, when you output audio tracks as Pair 1/2 from your application, the audio will be routed to the corresponding 1/2 MXO2 audio outputs.

4 If you selected the **Enable audio mapping** option, for each of the MXO2 outputs, select the desired audio pair from your application.

**Note** If you enable playback of Matrox 4VANC AFD or Matrox 4VANC closed captioning, audio track 15 or 16 will be muted and won’t be available for audio playback (see “Matrox 4VANC capture and playback” on page 66).

5 Under **Miscellaneous**, select the **Number of HDMI channels** that you want to output from MXO2’s HDMI output. This option is especially useful for HDMI monitors that don’t accept more than two audio channels. If you choose to output two audio channels, MXO2 will output the audio pair mapped to **HDMI 1/2**.

6 Select **Attenuate analog audio by 4dB** to decrease the level of the audio that is output from the MXO2 analog outputs by 4dB.

---

**Specifying your audio output settings**
Chapter 7, Configuring Your MXO2 System

Note  The **Attenuate analog audio by 4dB** option is not available on MXO2 Mini.

### Closed captioning and AFD

**Note**  Closed captioning and AFD are supported on Matrox MXO2, MXO2 Rack, and MXO2 LE only.

The Matrox 4VANC tool lets you capture and play back digital closed caption and AFD (active format description) data along with your video using a supported video application.

Matrox MXO2 also supports Adobe Premiere Pro’s closed captioning feature for playback and export to tape. If you’re working with Adobe Premiere Pro, you can choose to use Premiere Pro’s closed captioning feature instead of the Matrox 4VANC tool to play back closed captioning using MXO2.

This section details how to specify the settings in MXO2 when using the Matrox 4VANC tool or Premiere Pro’s closed captioning feature.

### Adobe closed caption playback

Matrox MXO2 supports Premiere Pro’s closed captioning feature for playback and export to tape. When using Premiere Pro, you can choose to use the closed captioning feature in Premiere Pro instead of the Matrox 4VANC tool to play back closed captioning using MXO2.

The closed captions on your sequence can be embedded in your video’s VANC on output for display on an SDI or analog video monitor that supports closed captioning, or you can choose to overlay the closed captions on all the MXO2 video outputs for display on video monitors that do not support closed captioning.

For detailed instructions on how to use Adobe Premiere Pro’s closed captioning feature with MXO2, see “Closed captioning and AFD” on page 91.

1. From the **Apple** menu, click **System Preferences**, and then click the **Matrox Utilities** icon.
2 Click **CC/AFD**.

3 Select **Use Adobe CC Playback**.

4 Specify where you want the closed caption data to be embedded in the video signal during playback. Since MXO2 features simultaneous outputs, you can select more than one of the following options.

- **Embed in SDI VANC (HD/SD)** Use this option if you want to play back HD or SD video from MXO2’s SDI output, and embed the closed captioning data in your video’s VANC.

- **Embed in SDI Line 21 (SD)** Use this option if you want to play back SD video from MXO2’s SDI output, and embed the closed captioning data on Line 21 of the VBI (vertical blanking interval) portion of your video signal.

- **Embed in analog Line 21 (SD)** Use this option if you want to play back SD video from any of MXO2’s analog outputs (component, S-Video, and composite), and embed the closed captioning data on Line 21 of the VBI (vertical blanking interval) portion of your video signal.

**Note** To preview HD video with closed captioning on an SD monitor, you must set the output that is connected to your monitor to SD (see “Specifying your video output settings” on page 58), and select either **Embed in SDI Line 21 (SD)** or **Embed in analog Line 21 (SD)**.
Specify the appropriate settings in your video application.

**Matrox 4VANC capture and playback**

The Matrox 4VANC tool lets you capture and play back AFD (active format description) and digital closed caption data, along with your video, using audio tracks 15 and 16, respectively. This section describes Matrox 4VANC, as it applies to AFD and closed captioning, and details how to enable these features on MXO2.

**AFD capture and playback**

If you have an SDI video source that contains AFD (active format description) data in the VANC (vertical ancillary data space), Matrox 4VANC lets you preserve the data during capture, maintain the data during playback and export to disk, and restore the data during output. When using a supported video application, Matrox 4VANC captures the AFD data as an audio track using MXO2’s SDI input, along with the video. The Matrox 4VANC audio track that contains the AFD data can then be used in a supported video application to play back the AFD data through MXO2’s SDI output.

Matrox 4VANC preserves the SDI VANC AFD data during capture by encoding the data into the audio stream using audio track 15. The resulting file is an uncompressed 24-bit 48 kHz audio file that contains the AFD data. When using MXO2’s SDI input for capture, you can choose to use audio track 15 to preserve the AFD data that is in your source video’s VANC. Because audio track 15 is used for capturing AFD data, that channel will not be available for capturing audio.

When using MXO2’s SDI output for playback, you can choose to retrieve and output the Matrox 4VANC AFD data from your video application. The AFD data is retrieved from audio track 15 and output using MXO2’s SDI output. The AFD data is restored to your HD/SD video’s VANC on output. When Matrox 4VANC is being used, track 15 is muted during playback, therefore it will not be available for playing back audio.

The following steps describe how to enable Matrox 4VANC AFD for capture and playback on MXO2:
1 From the Apple menu, click System Preferences, and then click the Matrox Utilities icon.

2 Click CC/AFD.

3 Select Use Matrox 4VANC CC/AFD.

4 Under Capture, select Preserve SDI VANC AFD using audio track 15 to capture the AFD data from your source video’s VANC using SDI audio track 15.

   Note To capture AFD data, you must select SDI as your video input source (see “Specifying your A/V input settings” on page 55). You must also genlock to your capture source and not an external genlock source (see “Specifying your genlock settings” on page 54).

5 Under Playback, select Retrieve AFD from audio track 15 to retrieve the Matrox 4VANC AFD data from audio track 15 in your video application, and play back the video with the AFD data restored to the VANC using MXO2’s SDI output.

6 Specify the appropriate settings in your video application. For information on how to set your video application settings to capture, play back, and export Matrox 4VANC AFD, see Chapter 9, “Using Matrox MXO2 with Supported Programs.”
Closed caption capture and playback
If you have an SDI video source that contains digital closed caption data in the VANC (vertical ancillary data space), Matrox 4VANC lets you capture the closed caption data as an audio track using MXO2’s SDI input, along with the video. The Matrox 4VANC audio track that contains the closed caption data can then be used in a supported video application to play back closed captioning through MXO2’s SDI or analog output.

Matrox 4VANC preserves the SDI VANC closed caption data during capture by encoding the data into the audio stream using audio track 16. The resulting file is an uncompressed 24-bit 48 kHz audio file that contains the closed caption data. You can also create a Matrox 4VANC closed caption audio file using supported captioning software, such as CPC MacCaption. You can add a Matrox 4VANC closed caption audio file to any project timeline in your video application, or transport and store the audio file on any video/audio device as an audio track.

When using MXO2’s SDI input for capture, you can choose to use audio track 16 to preserve the closed caption data that is in your source video’s VANC. Because audio track 16 is used for capturing closed captioning, that channel will not be available for capturing audio.

Note  Closed caption data that is present in line 21 of a video’s VBI (vertical blanking interval) is not transferred to an audio track because it is captured by MXO2 as part of the video signal.

When using MXO2’s SDI or analog output for playback, you can choose to retrieve and output the Matrox 4VANC closed caption data from your video application. The closed caption data is retrieved from audio track 16 and output using MXO2’s SDI or analog output. When Matrox 4VANC is being used, track 16 is muted during playback, therefore it will not be available for playing back audio. For playback, MXO2 lets you choose whether to embed the closed caption data in your HD/SD video’s VANC, or in Line 21 of the VBI portion of SD video.

The following steps describe how to enable Matrox 4VANC closed captioning for capture and playback on MXO2:
1 From the **Apple** menu, click **System Preferences**, and then click the **Matrox Utilities** icon.

2 Click **CC/AFD**.

3 Select **Use Matrox 4VANC CC/AFD**.

4 Under **Capture**, select **Preserve SDI VANC closed Captioning using audio track 16** to capture the digital closed caption data from your source video’s VANC using SDI audio track 16.

   **Note** To capture digital closed captioning, you must select **SDI** as your video input source (see “Specifying your A/V input settings” on page 55). You must also genlock to your capture source and not an external genlock source (see “Specifying your genlock settings” on page 54).

5 Under **Playback**, select **Retrieve closed captioning from audio track 16** to retrieve the Matrox 4VANC closed caption data from track 16 in your video application, and play back the video with closed captioning using MXO2’s SDI or analog output.

6 If you selected **Retrieve closed captioning from audio track 16** in step 5, specify where you want the closed captioning data to be embedded in the video signal during playback. Since MXO2 features simultaneous outputs, you can select more than one of the following options.
– **Embed in SDI VANC (HD/SD)**  Use this option if you want to play back HD or SD video from MXO2’s SDI output, and embed the closed captioning data in your video’s VANC.

– **Embed in SDI Line 21 (SD)**  Use this option if you want to play back SD video from MXO2’s SDI output, and embed the closed captioning data on Line 21 of the VBI (vertical blanking interval) portion of your video signal.

– **Embed in analog Line 21 (SD)**  Use this option if you want to play back SD video from any of MXO2’s analog outputs (component, S-Video, and composite), and embed the closed captioning data on Line 21 of the VBI (vertical blanking interval) portion of your video signal.

**Note**  To preview HD video with closed captioning on an SD monitor, you must set the output that is connected to your monitor to SD (see “Specifying your video output settings” on page 58), and select either **Embed in SDI Line 21 (SD)** or **Embed in analog Line 21 (SD)**.

7 Specify the appropriate settings in your video application. For information on how to set your video application settings to capture, play back, and export Matrox 4VANC closed captioning, see Chapter 9, “Using Matrox MXO2 with Supported Programs.”

**Specifying your Matrox WYSIWYG settings**

The Matrox WYSIWYG settings configure the MXO2 video output when working with Adobe After Effects and Photoshop only (see Chapter 9, “Using Matrox MXO2 with Supported Programs”).

1 From the Apple menu, click System Preferences, and then click the Matrox Utilities icon.
2 Click WYSIWYG.

3 From the Video format menu, select the format that matches your composition/image, or the format that is closest in resolution and aspect ratio. The video format at which your composition/image is output from MXO2 is set in the Video Output pane (see step 6).

**Note** To view a 1:1 representation of your composition/image on an HDMI monitor that does not support 1:1 pixel mapping, select your monitor’s native resolution as the video format, and disable Scale to fit.

4 If the selected video format does not match your composition/image, select Scale to fit to upscale/downscale your project to fit the selected video format. Clear this option to display your composition/image at its exact resolution (1:1) within the selected video format.

5 Select Alpha channel only to output only the alpha channel from your composition/image.

6 Specify the Video Output settings in the Matrox preferences window as described in “Specifying your video output settings” on page 58.

**Note** To output your composition/image at the video format selected in step 3, select Follow Application from the Set main channel format to list, and make sure that the MXO2 output that you will use for monitoring is set to output the Main channel under Channel Selection.

Specifying your Matrox WYSIWYG settings
Chapter 7, Configuring Your MXO2 System

7 To output your project using MXO2, specify the settings in Adobe After Effects/Photoshop as explained in Chapter 9, “Using Matrox MXO2 with Supported Programs.”

Specifying the Apple Final Cut Pro X setting

The FCP X pane in the Matrox Utilities preferences window is used when working with Apple Final Cut Pro X only. For details on setting the FCP X setting when using Matrox MXO2 with Final Cut Pro X, see “Working with Apple Final Cut Pro X” on page 120.

Note The FCP X setting in the Matrox Utilities preferences window is not saved when saving a custom preset (see “Saving custom presets” on page 52).

Viewing MXO2 information

To view your MXO2’s serial number, firmware version, and software version:

1 From the Apple menu, click System Preferences, and then click the Matrox Utilities icon.
2 Click Info.

Note If a message appears indicating an unsupported firmware version on your MXO2 hardware, you must update the MXO2 firmware as explained in “Updating your MXO2 firmware” on page 8.
MXO2 core audio support

You can use MXO2 as the input and output audio device for your Mac OS, and any audio application on your system. The Matrox MXO2 input and output audio device options allow you to set MXO2 as the input and output audio device in your Mac OS Sound settings for your entire system, for use with such applications as Apple iTunes. You can also set MXO2 as the input and output audio device within specific audio applications on your system.

Capture
If you want to perform a capture in an application that has MXO2 as the audio device, you must close any other application that has MXO2 selected as the audio device before capturing.

Playback
When playing back in an application that uses MXO2 as the output audio device, you must close any other application that uses MXO2 as the output audio device.
Calibrating Your HDMI Monitor for Video

This chapter explains how to use the Matrox HDMI Calibration Utility to calibrate your RGB HDMI monitor for video.
Overview

The Matrox HDMI Calibration Utility is a unique tool designed to calibrate your RGB HDMI monitor or television so that it performs like a traditional broadcast video monitor. This utility provides a wizard that walks you through the calibration process using specially designed patterns to effectively identify and compensate for the processing errors that may be present in your HDMI monitor. The Matrox HDMI Calibration Utility calibrates your monitor’s black and white levels, white point, gamma response, and hue and chroma.

This utility is optimized for calibrating HDMI LCD/LED monitors or televisions that support 1:1 pixel mapping, which allows you to view the output on your HDMI monitor at its exact resolution without any scaling. Although instructions are provided for calibrating plasma HDMI monitors, and HDMI monitors that scale the output, a blue-only filter will be required for the color calibration (hue and chroma). Some HDMI monitors feature a built-in blue-only mode that you can use for color calibration. If your HDMI monitor does not have a built-in blue-only mode, you can use a proper third-party blue-only filter (for example, a blue gel filter, or blue-only calibration glasses) that completely blocks out all colors except for blue. Because some blue-only filters do not block out colors effectively, the Matrox HDMI Calibration Utility includes a blue-only filter test that you can use to determine if your blue-only filter is adequate for color calibration.

Note This utility is best viewed at a display resolution of 1280×800 or higher.

Calibrating your HDMI monitor

The Matrox HDMI Calibration Utility provides on-screen instructions to calibrate your HDMI monitor. At the end of the calibration process, you must save your calibration settings to a file. Once saved, the calibration settings are automatically loaded as your system’s current calibration settings. If you’re calibrating more than one HDMI monitor, you can calibrate and save settings for each monitor and load the corresponding settings at any time (see “Loading Matrox HDMI calibration settings” on page 77). You can later choose to enable or disable the loaded calibration settings (see “Enabling and disabling the Matrox HDMI calibration settings” on page 78).

Note An administrator username and password is required to calibrate your HDMI monitor.

1 Ensure that your HDMI monitor is connected to MXO2’s HDMI output, turn the HDMI monitor on, and allow it to warm up for about 20 or 30 minutes.

2 From the Apple menu, click System Preferences, and then click the Matrox Utilities icon.

3 Click Video Output.

Chapter 8, Calibrating Your HDMI Monitor for Video
4 Under **Miscellaneous**, from the **Set HDMI output to** list, select **RGB - calibrated**.

5 Click **Calibrate**, and follow the on-screen instructions to calibrate your HDMI monitor.

**Note** When the Matrox HDMI Calibration Utility is running, you will not have access to the MXO2 options in the Matrox preferences window, and the MXO2 inputs and outputs will not be available to any other application.

6 At the end of the calibration process, save your calibration settings to a file anywhere on your system. You'll be required to enter an administrator username and password to save the settings. Once saved, your settings are automatically loaded as your system’s current calibration settings. You can later choose to enable or disable the loaded calibration settings (see “Enabling and disabling the Matrox HDMI calibration settings” on page 78).

**Note** The calibration settings file is saved as a .plist file. If you cancel the HDMI calibration, or close the utility at any time before saving the calibration settings, the current calibration settings will be lost.

---

### Loading Matrox HDMI calibration settings

After calibrating your HDMI monitor and saving your calibration settings to a file (see “Calibrating your HDMI monitor” on page 76), the calibration settings are automatically loaded as the current HDMI calibration settings for your system. You can, however, load another HDMI calibration settings file at any time, but only one calibration settings file can be loaded for your system at any given time. Once loaded, you can enable or disable the calibration settings (see “Enabling and disabling the Matrox HDMI calibration settings” on page 78). If your system has multiple users, the loaded calibration settings apply to all users.

**Note** An administrator username and password is required to load HDMI calibration settings.

1 From the **Apple** menu, click **System Preferences**, and then click the **Matrox Utilities** icon.

2 Click **Video Output**.

3 Under **Miscellaneous**, from the **Set HDMI output to** list, select **RGB - calibrated**.

4 Click **Calibrate**, enter an administrator username and password, and then click **Load Settings** from the **Welcome** page.

5 Select the desired .plist calibration file, and then click **Open**.
Enabling and disabling the Matrox HDMI calibration settings

The HDMI calibration settings that are loaded for your system (see “Loading Matrox HDMI calibration settings” on page 77) can be enabled or disabled. When enabled, the video that is output from the MXO2 HDMI output will have the color settings that are saved in the currently loaded calibration file. This is used when you want to monitor video on your RGB HDMI monitor. Disable the calibration settings if you want the HDMI video to be output from MXO2 with its native color settings, such as when performing an edit-to-tape.

1. From the Apple menu, click System Preferences, and then click the Matrox Utilities icon.
2. Click Video Output.
3. Under Miscellaneous, from the Set HDMI output to list, select RGB - calibrated to enable the loaded HDMI calibration settings. Depending on your HDMI output device, select RGB - native or YUV to disable the loaded calibration settings. For more information on setting the MXO2 HDMI output type, see “Specifying your video output settings” on page 58.
Using Matrox MXO2 with Supported Programs

This chapter explains how to define various settings for using MXO2 with supported programs.
Introduction
This chapter provides information on how to configure the following applications for use with MXO2:

- Adobe Premiere Pro (page 80)
- Adobe Encore (page 105)
- Adobe Prelude (page 106)
- Adobe After Effects (page 107)
- Adobe Photoshop (page 108)
- Adobe SpeedGrade (page 109)
- Avid Media Composer and Symphony (page 111)
- Apple Final Cut Pro X (page 120)

Important  Matrox MXO2 features scaling options that you can use to scale your video for capture and output. To ensure desired results, always scale your video using the MXO2 scaling options (see Chapter 7, “Configuring Your MXO2 System”) instead of the scaling options found in your video editing application.

Working with Adobe Premiere Pro
You can use Adobe Premiere Pro to play back, capture, export, and output video and audio using Matrox MXO2. For a list of the supported video output formats for the MXO2 main and SD channels, and the supported video formats for the MXO2 outputs, see Appendix D, “Matrox MXO2 Supported Output Formats.” For a list of the input and capture formats that are supported on MXO2, and to view the MXO2 input scaling options, see Appendix C, “Matrox MXO2 Supported Input and Capture Formats.”

Note  To ensure that changes made in the Matrox Utilities preferences window are applied to Premiere Pro when switching between Premiere Pro and the Matrox Utilities preferences window, select Disable video output when in the background in Premiere Pro’s Playback settings (Premiere Pro > Preferences > Playback).

This section provides information on how to:

- Create a new Matrox MXO2 project. (page 81)
- Define your playback settings. (page 82)
- Define your capture settings. (page 84)
- Add a voice-over to your sequence. (page 86)
- Work with closed captioning and AFD. (pages 91–94)
- Set up Matrox device control. (page 99)
- Export your sequence to tape. (page 101)
• Use the Matrox MPEG-2 I-frame codec. (page 102)

Creating a new Matrox MXO2 project

Creating a new Adobe Premiere Pro project involves specifying the location of your scratch disks and selecting a sequence preset.

1. Start Premiere Pro and click the **New Project** icon. The **New Project** dialog appears. You can leave all the settings on the **General** pane at the default settings. For details on changing these settings, see your Adobe Premiere Pro documentation.

2. On the **Scratch Disks** pane, use the **Browse** button to select an appropriate A/V drive for each scratch disk type. When specifying the location of your scratch disks, make sure you follow the recommendations in your Adobe Premiere Pro documentation. For example, store your video and audio files on a separate hard drive dedicated to your media assets.

   **Tip** Specifying the same scratch disk settings for all your projects will help shorten the amount of time it takes to open new or existing projects.

3. From the **Location** list, select where you want to save your project.

4. Specify a **Name** for your project.

5. Click **OK** to save your settings.

6. In Premiere Pro, choose **File > New > Sequence**. The **New Sequence** dialog opens on the **Sequence Presets** pane.

7. Under **Available Presets**, select the preset that matches the type of sequence that you want to create. Matrox MXO2 supports all the available presets, including custom presets that you create.

   **Note** When you select any of the MPEG-2 I-frame presets, the Matrox MPEG-2 I-frame codec will be set for rendering your video previews.

8. Specify a **Sequence Name**.

9. If you plan on playing back or exporting Matrox 4VANC AFD or Matrox 4VANC closed caption data:
   
   a. In the **Tracks** pane, select **Multichannel** from the **Master** list.
   
   b. From the **Number of channels** list, select **16**, and then set the **Track Type** for each track in your sequence to **Mono**.
   
   c. In the **Settings** pane, under **Audio**, select **48000 Hz** from the **Sample Rate** list.

10. Click **OK** to apply the settings.

   **Note** To avoid playback issues when using **Matrox Player** as the playback device, make sure that a Matrox audio option is not selected in the **Audio Hardware** preferences (**Premiere Pro > Preferences > Audio Hardware**).
Defining your playback settings
This section details how to define your settings in order to use your Matrox MXO2 hardware to output video and audio that is played back in Adobe Premiere Pro. For a list of the supported video output formats for the MXO2 main and SD channels, and the supported video formats for the MXO2 outputs, see Appendix D, “Matrox MXO2 Supported Output Formats.”

1 In Premiere Pro, choose Premiere Pro > Preferences > Audio Hardware, and make sure that a Matrox audio setting is not selected as the Adobe Desktop Audio device. This includes a Matrox aggregate audio device that you created for your Mac OS X Mountain Lion system for the purposes of adding a voice-over (see “Adding a voice-over to your sequence” on page 86).

2 Choose Premiere Pro > Preferences > Playback.

3 In the Preferences dialog, select Matrox Player from the Audio Device list.
4 Under Video Device, select Matrox Player, and then click Setup beside Matrox Player.

5 In the Matrox Player Setup dialog, select the bit depth for your video output (8-bit or 10-bit).

6 If your sequence includes closed captioning that was not creating using the Matrox 4VANC tool, select Enable CC overlay on output to overlay the closed captions on all the MXO2 video outputs for display on video monitors that do not support closed captioning. For more information on working with closed captioning in Premiere Pro, see “Closed captioning and AFD” on page 91.

7 Click OK to close the Matrox Player Setup dialog.

8 Click OK to save your settings in the Preferences dialog.

9 If you selected an MPEG-2 I-frame sequence preset, or a custom sequence preset that uses the Matrox MPEG-2 I-frame codec to render your video preview, choose Sequence > Sequence Settings, and then in the Settings pane, click Configure beside Preview File Format to configure the codec. See “Using the Matrox MPEG-2 I-frame codec” on page 102 for information on specifying your Matrox MPEG-2 I-frame codec settings.

10 Set the appropriate video and audio output settings in the Matrox Utilities preferences window (see Chapter 7, “Configuring Your MXO2 System”).

Note To ensure that changes made in the Matrox Utilities preferences window are applied to Premiere Pro when switching between Premiere Pro and the Matrox Utilities preferences window, select Disable video output when in the background in Premiere Pro’s Playback settings (Premiere Pro > Preferences > Playback).

11 In Premiere Pro, play back your sequence.
Defining your capture settings

To capture video and audio in Premiere Pro using your Matrox MXO2 hardware, you must define your capture settings as detailed in this section. For a list of the input and capture formats that are supported on MXO2, and to view the MXO2 input scaling options, see Appendix C, “Matrox MXO2 Supported Input and Capture Formats.”

1 In Premiere Pro, choose File > Capture.
2 In the Capture panel, in the Settings pane, under Capture Settings, click Edit.

3 In the Capture Settings pane, select Matrox Recorder from the Capture Format list, and then click Configure.

4 In the Matrox Recorder Configuration dialog, select the Video format to which you want to capture your source video.

5 Click Configure Codec to select and configure the capture codec. If you want to use the Matrox MPEG-2 I-frame codec, see “Using the Matrox MPEG-2 I-frame codec” on page 102 for details on configuring the codec.

6 Select the number of Audio channels to capture. If capturing Matrox 4VANC AFD or closed caption data (see “Closed captioning and AFD” on page 91), you must capture 16 audio channels.
7 Click A/V Input Preferences to set the appropriate video and audio input settings in the Matrox Utilities preferences window (see “Specifying your A/V input settings” on page 55).

**Note** To ensure that changes made in the Matrox Utilities preferences window are applied to Premiere Pro when switching between Premiere Pro and the Matrox Utilities preferences window, select **Disable video output when in the background** in Premiere Pro’s Playback settings (Premiere Pro > Preferences > Playback).

8 Click OK to save your settings in the Matrox Recorder Configuration dialog.

9 If you want to use Matrox device control for frame-accurate capture from a device, see “Setting up Matrox device control” on page 99.

**Note** When using Matrox device control, the capture does not stop at the end of the tape when using the **Tape** option in the **Capture** panel. To avoid capturing beyond the end of the tape, use the **In/Out** capture option instead and set an In and Out point for your capture.

10 Capture as you would normally.
Adding a voice-over to your sequence
Matrox MXO2 supports voice-over in Adobe Premiere Pro, which allows you to record audio tracks as .wav files to add commentary to video clips, such as newsreels and documentaries.

Note Matrox voice-over supports recording to standard, mono, and adaptive audio tracks only.

Connection and setup
1. Connect the microphone to the audio input on a source device, such as a preamplifier, and then connect the audio output from the source device to the corresponding audio input on your MXO2 hardware.

Note The Matrox hardware audio inputs are line level. Therefore, make sure your audio equipment output matches.

2. If you’re using a Mac OS X Lion system, proceed to step 3. For Mac OS X Mountain Lion users, a Matrox aggregate audio device is required for your system. If you previously created a Matrox aggregate audio device on your system for the purposes of voice-over, proceed to step 3. To create a Matrox aggregate audio device, perform the following steps:

d. In the Mac OS X Finder window, choose Applications > Utilities, and then double-click Audio MIDI Setup.

e. In the Audio Devices window, click + at the bottom left of the dialog, and then Create Aggregate Device.

f. Double-click the newly created aggregate device that appears in the left pane, and type a descriptive name for the device, such as Matrox Audio.
g Highlight the **Matrox Audio** aggregate device, and then select to use the Matrox audio input and output.

![](image)

**Matrox Audio**

- **Clock Source**: Matrox MXO2 A441851 A...
- **Sample Rate**: 48000.0 Hz
- **Line Audio Device**: MATROX MXO2 A441851 Audio Output
- **In**: 10
- **Out**: 10
- **Config Speaker**:... 

**Quit Audio MIDI Setup.**

3 From the **Apple** menu, click **System Preferences**, and then click the **Matrox Utilities** icon.

4 Click **A/V Input**.
5 Under **Input Source**, select the **Audio** input on your Matrox hardware to which your audio source device is connected, and then select **Component** from the **Video** list.

6 Close the **Matrox Utilities** preferences window.

7 In Premiere Pro, choose **Premiere Pro > Preferences > Playback**, and then select **Adobe Desktop Audio** as the **Audio Device**.

8 Click **OK** to apply the change.

9 Choose **Premiere Pro > Preferences > Audio Hardware**, and then select the option based on your operating system:

   - **Mac OS X Lion** Select the Matrox input/output option from the **Adobe Desktop Audio** list. For example, **Matrox MXO2 (serial number)**

Chapter 9, Using Matrox MXO2 with Supported Programs
Input/Matrox MXO2 (serial number) Output. Do not select the Matrox option for output only.

– Mac OS X Mountain Lion  Select the Matrox aggregate audio device created in step 2 from the Adobe Desktop Audio list.

10 Click OK to apply the change.
Recording your voice-over
You use Adobe Premiere Pro’s Audio Track Mixer to record your voice-over. For further information on using the Audio Track Mixer, see your Adobe Premiere Pro documentation.

1 In Premiere Pro, choose Window > Audio Track Mixer, and then select the sequence in which you want to record your voice-over (for example, Window > Audio Track Mixer > Sequence 01).

2 Position the current-time indicator in the Timeline panel where you want the voice-over to begin. You can also set In and Out points to specify the section of the timeline to which you want to add your voice-over.

3 In the Audio Track Mixer panel, click the Enable track for recording button ( ) for the tracks on which you want to record audio. You can record your voice-over on multiple tracks at the same time.

Note If a track that you’ll be recording your voice-over on already contains audio at the current-time indicator, the audio will be overwritten by your voice-over.
4 For each track selected in step 3, select the Matrox audio input channel that you want to record from the Track Input Channel list at the top of the panel.

5 Select **Meter Input(s) Only** in the **Audio Track Mixer** menu to display the MXO2 audio input levels in the meters.

- **Tip** You can click the **Solo Track** button ( ) for a track on which you’ll be recording audio to mute the audio playback of other audio tracks in your sequence.

6 Test the audio input levels by speaking into the microphone, and watch the levels in the meters. If needed, adjust the audio level on your source device so that the input levels are sufficiently high but not clipping.

7 Click the **Record** button ( ) to prepare the sequence for recording.

8 Click the **Play** button ( ), or the **Play In to Out** button ( ) if you set In and Out points, to start recording your voice-over.

- **Note** During recording, there’s a slight delay in the audio preview of your voice-over. To mute the preview, click the **Mute Track** button ( ) or you can choose to lower the track volume by dragging the **Volume** slider.

9 Click the **Stop** button ( ) to stop recording. Your voice-over will be added to the selected audio tracks as .wav files.

10 To ensure proper A/V synchronization during playback when not recording a voice-over, make sure that a Matrox audio option is not selected for the **Adobe Desktop Audio** option in the **Audio Hardware** preferences (**Premiere Pro > Preferences > Audio Hardware**), and then select **Matrox Player** as the **Audio Device** and **Video Device** in the **Playback** settings (**Premiere Pro > Preferences > Playback**).

### Closed captioning and AFD

Matrox MXO2 provides two ways of working with closed caption and AFD data in Adobe Premiere Pro:

- **Matrox 4VANC tool** (pages 92 and 94) The Matrox 4VANC tool lets you capture and play back digital closed caption and AFD (active format description) data along with your video. The Matrox 4VANC closed caption and AFD data can be embedded in your video’s VANC on output for display on an SDI or analog video monitor that supports closed captioning.

- **Premiere Pro’s closed captioning** (page 97) Matrox MXO2 supports Adobe Premiere Pro’s closed captioning feature for playback. The closed captions on your sequence can be embedded in your video’s VANC on output for display on an SDI or analog video monitor that supports closed captioning, or you can choose to overlay the closed captions on all the MXO2 video outputs for display on video monitors that do not support closed captioning.

---

**Working with Adobe Premiere Pro**
Working with Matrox 4VANC AFD
MXO2 lets you capture the AFD (active format description) data stored in your video’s VANC, along with your video, and restore the AFD data during playback, using the Matrox 4VANC tool. This section details how to capture and play back Matrox 4VANC AFD using Adobe Premiere Pro. You can also use Premiere Pro to export a sequence with Matrox 4VANC AFD to a file for playback using Premiere Pro. For more information about any of the features mentioned in this section, see your Premiere Pro documentation.

Note Matrox MXO2 Mini does not support AFD data.

Capturing Matrox 4VANC AFD
When using MXO2’s SDI input for capture, Matrox 4V ANC lets you preserve the AFD (active format description) data from your video’s VANC (vertical ancillary data space) by capturing the data as an audio track.

If Matrox 4VANC capture is enabled in the Matrox Utilities preferences window, Matrox MXO2 uses audio track 15 to preserve the AFD data during capture in Premiere Pro. The resulting file is an uncompressed 24-bit 48 kHz audio file that contains the AFD data. The Matrox 4VANC audio track that contains the AFD data can then be played back in Premiere Pro. During playback the AFD data is restored to your HD/SD video’s VANC through MXO2’s SDI or analog output (see “Playing back Matrox 4VANC AFD” on page 92). Because audio track 15 is used for capturing AFD data, that channel will not be available for capturing audio. To capture Matrox 4VANC AFD:

a Enable capture of Matrox 4VANC AFD in the Matrox Utilities preferences window (see “AFD capture and playback” on page 66).
b Specify your capture settings in Premiere Pro as detailed in “Defining your capture settings” on page 84.
c Capture as you would normally.

Playing back Matrox 4VANC AFD
During playback, MXO2 retrieves the AFD data from the Matrox 4VANC audio track that is assigned to audio output 15 in Premiere Pro, and restores the AFD data to your HD/SD video’s VANC through MXO2’s SDI or analog output. Set your playback settings as follows:

a In Premiere Pro, choose File > New > Sequence. In the New Sequence dialog:
  • In the Tracks pane, select Multichannel from the Master list.
  • From the Number of channels list, select 16, and then set the Track Type for each track in your sequence to Mono.
  • In the Settings pane, under Audio, select 48000 Hz from the Sample Rate list.

Chapter 9, Using Matrox MXO2 with Supported Programs
b Set the remaining settings in the **New Sequence** dialog, and then click **OK**.

c With your project files on the timeline, in the **Audio Track Mixer**, assign the audio track that contains the Matrox 4VANC closed caption data on your timeline to audio output **15 + 16**, and then use the **Pan/balance control** to set the balance completely to the left (channel 15). If there is another audio track assigned to **15 + 16**, you must set the balance for that audio track completely to the right (channel 16). Audio track 16 can be used for Matrox 4VANC closed caption data (see “**Working with Matrox 4VANC closed captioning**” on page 94).

Note To preserve the integrity of the AFD data for playback, do not manipulate the audio track that contains the AFD data in any way. For example, do not adjust the audio gain or add audio effects to the track.

d Specify your playback settings as detailed in “**Defining your playback settings**” on page 82.

e Enable playback of Matrox 4VANC AFD in the **Matrox Utilities** preferences window (see “**AFD capture and playback**” on page 66).

f Play back your sequence.

**Exporting Matrox 4VANC AFD to a file**

This section details how to maintain the Matrox 4VANC AFD data when exporting your sequence to a file. The exported file can then be used in Premiere Pro for playback (see “**Playing back Matrox 4VANC AFD**” on page 92).

1 a In Premiere Pro, choose **File > New > Sequence**. In the **New Sequence** dialog:
   - In the **Tracks** pane, select **Multichannel** from the **Master** list.
   - From the **Number of channels** list, select **16**, and then set the **Track Type** for each track in your sequence to **Mono**.
   - In the **Settings** pane, under **Audio**, select **48000 Hz** from the **Sample Rate** list.

b Set the remaining settings in the **New Sequence** dialog, and then click **OK**.

c With your project files on the timeline, in the **Audio Track Mixer**, assign the audio track that contains the Matrox 4VANC AFD data to an audio output pair (for example, **3 + 4**), and then use the **Pan/balance control** to set the balance of the Matrox 4VANC track completely to the left or right. If the selected audio output pair is assigned to another audio track, set the balance for the other audio track to the other side. For example, if the Matrox 4VANC AFD audio track balance is set to the left, set the
Chapter 9, Using Matrox MXO2 with Supported Programs

balance for the other audio track that is assigned to the same audio outputs to the right.

d Choose File > Export > Media.

e In the Audio pane, select a lossless or uncompressed Audio Codec. Compressed audio codecs are not supported for use with Matrox 4VANC.

f Under Basic Audio Settings, select 48000 Hz from the Sample Rate list.

g From the Channels list, select the number of audio channels to export. **Note** Mono, 5.1, and Stereo are not supported when exporting Matrox 4VANC AFD data.

h From the Sample Size list, select 24 bit.

i Export your sequence to file. If you have an MXO2 product with MAX technology, see Chapter 10, “Using the Matrox MAX H.264 Codec” for information on exporting your sequence using the Matrox MAX H.264 codec.

**Working with Matrox 4VANC closed captioning**

MXO2 lets you capture and play back video with digital closed captioning using the Matrox 4VANC tool. This section details how to capture and play back Matrox 4VANC closed captioning using Adobe Premiere Pro. You can also use Premiere Pro to export a sequence with Matrox 4VANC closed captioning to a file for playback using Premiere Pro. For more information about any of the features mentioned in this section, see your Premiere Pro documentation.

**Note** Matrox MXO2 Mini does not support closed captioning.

**Capturing Matrox 4VANC closed captioning**

When using MXO2’s SDI input for capture, Matrox 4VANC lets you preserve the closed caption data from your video’s VANC (vertical ancillary data space) by capturing the data as an audio track.

If Matrox 4VANC capture is enabled in the Matrox Utilities preferences window, Matrox MXO2 uses audio track 16 to preserve the closed caption data during capture in Premiere Pro. The resulting file is an uncompressed 24-bit 48 kHz audio file that contains the closed caption data. The Matrox 4VANC audio track that contains the closed caption data can then be used in Premiere Pro to play back closed captioning through MXO2’s SDI or analog output (see “Playing back Matrox 4VANC closed captioning” on page 95). Because audio track 16 is used for capturing closed captioning, that channel will not be available for capturing audio. To capture Matrox 4VANC closed captioning:

a Enable capture of Matrox 4VANC closed captioning in the Matrox Utilities preferences window (see “Closed caption capture and playback” on page 68).
b Specify your capture settings in Premiere Pro as detailed in “Defining your capture settings” on page 84.

c Capture as you would normally.

Playing back Matrox 4VANC closed captioning
During playback, MXO2 retrieves the closed caption data from the Matrox 4VANC audio track that is assigned to audio output 16, and outputs it using MXO2’s SDI or analog output. To play back Matrox 4VANC closed captioning:

a In Premiere Pro, choose File > New > Sequence. In the New Sequence dialog:
   • In the Tracks pane, select Multichannel from the Master list.
   • From the Number of channels list, select 16, and then set the Track Type for each track in your sequence to Mono.
   • In the Settings pane, under Audio, select 48000 Hz from the Sample Rate list.

b Set the remaining settings in the New Sequence dialog, and then click OK.

c With your project files on the timeline, in the Audio Track Mixer, assign the audio track that contains the Matrox 4VANC closed caption data on your timeline to audio output 15 + 16, and then use the Pan/balance control to set the balance completely to the right (channel 16). If there is another audio track assigned to 15 + 16, you must set the balance for that audio track completely to the left (channel 15). Audio track 15 can be used for Matrox 4VANC AFD data (see “Working with Matrox 4VANC AFD” on page 92).

Note To preserve the integrity of the closed caption data for playback, do not manipulate the audio track that contains the closed caption data in any way. For example, do not adjust the audio gain or add audio effects to the track.

d Specify your playback settings as detailed in “Defining your playback settings” on page 82.

e Enable playback of Matrox 4VANC closed captioning in the Matrox Utilities preferences window (see “Closed caption capture and playback” on page 68).

f Play back your sequence.

Exporting Matrox 4VANC closed captioning to a file
This section details how to maintain the Matrox 4VANC closed caption data when exporting your sequence to a file. The exported file can then be used in Premiere Pro for playback (see “Playing back Matrox 4VANC closed captioning” on page 95).
a In Premiere Pro, choose File > New > Sequence. In the New Sequence dialog:
   • In the Tracks pane, select Multichannel from the Master list.
   • From the Number of channels list, select 16, and then set the Track Type for each track in your sequence to Mono.
   • In the Settings pane, under Audio, select 48000 Hz from the Sample Rate list.

b Set the remaining settings in the New Sequence dialog, and then click OK.

c With your project files on the timeline, in the Audio Track Mixer, assign the audio track that contains the Matrox 4VANC closed caption data to an audio output pair (for example, 3 + 4), and then use the Pan/balance control to set the balance of the Matrox 4VANC track completely to the left or right. If the selected audio output pair is assigned to another audio track, set the balance for the other audio track to the other side. For example, if the Matrox 4VANC closed caption audio track balance is set to the left, set the balance for the other audio track that is assigned to the same audio outputs to the right.

d Choose File > Export > Media.

e In the Audio pane, select a lossless or uncompressed Audio Codec. Compressed audio codecs are not supported for use with Matrox 4VANC.

f Under Basic Audio Settings, select 48000 Hz from the Sample Rate list.

g From the Channels list, select the number of audio channels to export.

Note Mono, 5.1, and Stereo are not supported when exporting Matrox 4VANC closed caption data.

h From the Sample Size list, select 24 bit.

i Export your sequence to file. If you have an MXO2 product with MAX technology, see Chapter 10, “Using the Matrox MAX H.264 Codec” for information on exporting your sequence using the Matrox MAX H.264 codec.
**Working with Premiere Pro’s closed captioning**

Matrox MXO2 supports Premiere Pro’s closed captioning feature for playback and export to tape. The closed captions on your sequence can be embedded in your video’s VANC on output for display on an SDI or analog video monitor that supports closed captioning, or you can choose to overlay the closed captions on all the MXO2 video outputs for display on video monitors that do not support closed captioning.

For details on how to import a closed caption file to your sequence, see your Adobe Premiere Pro documentation. To determine your video monitor’s capabilities for displaying closed captioning, check your video monitor’s documentation.

**Embed closed captions in VANC**

This section details how to embed the closed captions that are on your sequence in your video’s VANC for play back and export to tape using MXO2.

1. From the **Apple** menu, click **System Preferences**, and then click the **Matrox Utilities** icon.
2. Click **CC/AFD**.
3. Select **Use Adobe CC Playback**.
d Specify where you want the closed caption data to be embedded in the video signal during playback. Since MXO2 features simultaneous outputs, you can select more than one of the following options.

- **Embed in SDI VANC (HD/SD)** Use this option if you want to play back HD or SD video from MXO2’s SDI output, and embed the closed captioning data in your video’s VANC.

- **Embed in SDI Line 21 (SD)** Use this option if you want to play back SD video from MXO2’s SDI output, and embed the closed captioning data on Line 21 of the VBI (vertical blanking interval) portion of your video signal.

- **Embed in analog Line 21 (SD)** Use this option if you want to play back SD video from any of MXO2’s analog outputs (component, S-Video, and composite), and embed the closed captioning data on Line 21 of the VBI (vertical blanking interval) portion of your video signal.

**Note** To preview HD video with closed captioning on an SD monitor, you must set the output that is connected to your monitor to SD (see “Specifying your video output settings” on page 58), and select either **Embed in SDI Line 21 (SD)** or **Embed in analog Line 21 (SD)**.

e In Premiere Pro, specify your playback settings as detailed in “Defining your playback settings” on page 82.

f Play back your sequence or export your sequence to tape.

**Overlay closed captions**

This section details how to overlay the closed captions that are on your sequence on all the MXO2 video outputs for playback.

**Note** The closed captioning overlay is supported for playback only. The overlay will not be exported to tape.

a In Premiere Pro, specify your playback settings as detailed in “Defining your playback settings” on page 82. When specifying your playback settings, make sure to select the **Enable CC overlay on output** option in the **Matrox Player Setup** dialog.

b Click the Program monitor flyout menu button ( ), and **Enable** the **Closed Captioning Display** option.
c Play back your sequence.

**Setting up Matrox device control**

Matrox device control lets you control any device that supports the RS-422 SMPTE time code protocol when capturing or exporting material to tape in Adobe Premiere Pro. To use device control, you must connect your source device or recorder as follows:

- **MXO2, MXO2 Rack, and MXO2 LE** Connect the RS-422 connector on your MXO2 hardware to the serial device control port on your source device or recorder using an RS-422 serial cable (see “MXO2 RS-422 serial connection” on page 17, “MXO2 Rack RS-422 serial connection” on page 28, or “MXO2 LE RS-422 serial connection” on page 37).

  **Note** When using an analog RS-422 device on MXO2, MXO2 Rack, or MXO2 LE, you must genlock to an external broadcast-quality analog sync source. If you’re using an SDI RS-422 device and you don’t have an external broadcast-quality analog sync source, you can genlock to your SDI video source for capture. For export to tape, you can set your genlock source to the MXO2 internal reference and configure the setting on your deck to genlock to the SDI video input. For details on how to set your genlock source, see “Specifying your genlock settings” on page 54.

- **MXO2 Mini** MXO2 Mini does not feature an RS-422 serial connector. You can, however, use a suitable serial adapter to connect the serial device port on your source device or recorder to your computer. For a list of supported device control adapters, see the Matrox MXO2 Support section of our website at www.matrox.com/video/support.

  **To configure your Matrox device control settings:**

  1. In Premiere Pro, choose Premiere Pro > Preferences > Device Control.

     **Note** When exporting to tape, Matrox uses a preroll of five seconds. This value is hardcoded and cannot be changed. The **Preroll** and **Timecode Offset** options available in Premiere Pro are ignored when using Matrox device control for export to tape (see “Exporting your sequence to tape” on page 101).

  2. From the **Devices** list, select **Matrox Device Control**.
3 Click **Options** to display the **Matrox Device Control Options** panel.

4 From the **Port** list, select **Matrox RS-422 Port**. If the list contains more than one **Matrox RS-422 Port** option, which occurs when your system has more than one serial device control connection, select the option corresponding to the desired connection.

**Note** For MXO2 Mini users, if you’re using a third-party serial adapter to connect the serial device port on your source device or recorder to your computer, the adapter must be connected to your computer before starting your system for it to appear in the **Port** list.

5 From the **Time Source** list, select the time source to be used for controlling your device:

- **LTC** Longitudinal Time Code recorded on a track adjacent to the video. This type of time code can be read at all tape speeds, except still.
- **VITC** Vertical Interval Time Code that is recorded onto the vertical blanking interval of the video. This type of time code can be read whenever an image is displayed, but not usually during high-speed operation.
- **LTC + VITC** Select this if you want your device to decide which type of time code to use in different operational modes (recommended only if you’re sure that the two types of time code match on your tape).
- **Control Track** Select this if you want to use only your tape’s control track as the time source. Because using the control track is not as reliable as LTC or VITC for device control, you should select this option only if you’re having problems using the time code on your tape.

6 From the **Time Base** list, select the time base that matches your tape, such as **30 fps Drop Frame** if you’re using NTSC video with drop frame time code, or **25 fps** if you’re using PAL video.
If required, in the **Playback Offset** box, specify the number of frames to offset the playback of your sequence for export to tape. For example, if playback starts too late and the first three frames are black on the tape, enter an offset of -3. Alternately, if playback starts too early and the first three frames of your sequence are missing, enter an offset of 3.

Click **OK** to save your Matrox device control settings.

Click **OK** to save your settings in the Preferences dialog.

For details on specifying your capture settings in Premiere Pro, see “Defining your capture settings” on page 84. For details on capturing with device control, see your Adobe Premiere Pro documentation. For information about exporting your sequence to tape, see “Exporting your sequence to tape” on page 101.

### Exporting your sequence to tape

To export your Adobe Premiere Pro sequence to tape without using device control, simply play back your sequence and record the output from any of the available outputs on your MXO2 system.

If your recorder supports RS-422 device control, you can export your sequence to tape using Matrox device control.

**To export your sequence to tape using Matrox device control:**

1. Open your project, and set your playback settings as described in “Defining your playback settings” on page 82.

2. Make sure that you’ve properly connected your RS-422 recorder and configured Matrox device control as explained in “Setting up Matrox device control” on page 99.

3. Activate the sequence that you want to export to tape, and position the work area bar over the section of the sequence that you want to export.

4. If you haven’t already done so, render all sections that are identified with a red or yellow render bar.

   **Note** Adobe Premiere Pro will automatically render sections that have a red render bar when you start an export to tape, but to avoid having dropped frames you must render both the red and yellow sections before performing an export to tape.

5. Make sure that the sequence is activated and that your recorder is connected to MXO2 and powered up, and then choose **File > Export > Tape (Serial Device)** to open the *Edit To Tape* panel.

   **Note** When exporting to tape, Matrox uses a preroll of five seconds. This value is hardcoded and cannot be changed.

6. To preview the export to tape in the Edit To Tape panel:
a Connect your recorder’s output to the input on MXO2, and set the MXO2 input settings as specified in “Specifying your A/V input settings” on page 55.

b In the Edit To Tape panel, click Recorder Settings, select Matrox Recorder from the Capture Format list, and then click OK to close the Capture Settings pane.

7 Use the settings and controls in Premiere Pro’s Edit To Tape panel to export your sequence to tape. For information on how to use the Edit To Tape panel, refer to your Adobe Premiere Pro documentation.

Note When exporting to tape, MXO2 supports the first four audio channels only.

Using the Matrox MPEG-2 I-frame codec
The Matrox MPEG-2 I-frame codec is a full-raster HD codec that gets installed automatically when you install your MXO2 software. It is included primarily for users who do not have a full-raster HD codec installed on their system.

To capture SD/HD video using the Matrox MPEG-2 I-frame codec, the MXO2 software must be installed on your system, and the MXO2 hardware must be connected.

If the captured video will be played back on another system, the Matrox MPEG-2 I-frame codec must be installed on that system as well. You can download the Matrox MPEG-2 I-frame codec for playback on other Mac systems from the Download section of our Support website at www.matrox.com/video/support.

To configure the Matrox MPEG-2 I-frame codec:

The default settings for the Matrox MPEG-2 I-frame codec provide good results for most applications. We recommend that you change these settings only when needed for special purposes.
Working with Adobe Premiere Pro

Note If your're using the Matrox MPEG-2 I-frame codec for playback, some of the options described in this section may not apply.

1 Under **Motion**, select the frame rate for your captured video in **Frames per second**, and enter a target data rate in the **Limit data rate to** box.

Note The data rate must be between 10 Mb/s (975 KB/s) and 300 Mb/s (36621 KB/s) for SD material, and 50 Mb/s (6100 KB/s) and 300 Mb/s for HD material.

2 To apply advanced compression settings, set the options under **Compressor**. The default settings for the advanced options provide good results for most applications. We recommend that you change these settings only when needed for special purposes.

- Select your desired **Scan pattern**:
  - Regular Sets the regular zig zag scanning pattern of the AC coefficient of the DCT block as defined in the ISO/IEC 13818-2 (figure 7-2) specification document.
  - Alternate Sets the alternate zig zag scanning pattern of the AC coefficient of the DCT block as defined in the ISO/IEC 13818-2 (figure 7-3) specification document. Use this setting when capturing video at a high data rate.

- Select your desired **Rounding type**:
  - MPEG-2 Rounds the AC coefficient up to the nearest whole number when calculating the quantization coefficient.
Chapter 9, Using Matrox MXO2 with Supported Programs

- **Matrox custom** Truncates the AC coefficients to the lowest whole number when calculating the quantization coefficient. In some cases, this setting may yield less artifacts in graphics.
  - From the **DC precision** list, select the bit-depth precision of the DC intra block. The higher the DC precision value that’s used to render your video, the more likely that the DC content will be increased at the expense of the AC content in the encoded stream. This may result in lowering the overall quality of the compressed stream at a specified data rate.
  - Select the **Force frame-based DCT** setting to render macroblocks as frames rather than as fields. In some cases, graphics will yield less artifacts if this option is selected.

3 Click **OK** to save your settings.
Working with Adobe Encore

The MXO2 playback device for Encore lets you monitor video and audio from your Encore project using the MXO2 outputs. For a list of the supported video output formats for the MXO2 main and SD channels, and the supported video formats for the MXO2 outputs, see Appendix D, “Matrox MXO2 Supported Output Formats.”

Perform the following steps to output video and audio from the MXO2 outputs during playback in Encore:

1. Start Adobe Encore and either open an existing project, or start a new composition. If necessary, import your clip.
2. Choose Encore > Preferences > Audio/Video Out.
3. In the Preferences dialog, select Matrox Player from the Audio Device list.
4. Under Video Device, select Matrox Player, and then click Setup beside Matrox Player.
5. In the Matrox Player Setup panel, set whether to output 8-bit or 10-bit video, and then click OK.

Note: The Enable CC overlay on output option in the Matrox Player Setup panel is not used.

6. Set the appropriate video and audio output settings in the Matrox Utilities preferences window (see Chapter 7, “Configuring Your MXO2 System”).

Important When using Matrox Player as the playback device in Encore, make sure that a Matrox audio option is not selected as the Audio Output Device from Encore > Preferences > Audio/Video Out.
Working with Adobe Prelude

The MXO2 playback device for Prelude lets you monitor video and audio from your Prelude project using the MXO2 outputs. For a list of the supported video output formats for the MXO2 main and SD channels, and the supported video formats for the MXO2 outputs, see Appendix D, “Matrox MXO2 Supported Output Formats.”

Perform the following steps to output video and audio from the MXO2 outputs during playback in Encore:

1. Start Adobe Prelude and either open an existing project, or start a new composition. If necessary, import your clip.
2. Choose Prelude > Preferences > Playback.
3. In the Preferences dialog, select Matrox Player from the Audio Device list.
4. Under Video Device, select Matrox Player, and then click Setup beside Matrox Player.
5. In the Matrox Player Setup panel, set whether to output 8-bit or 10-bit video, and then click OK.
   **Note** The Enable CC overlay on output option in the Matrox Player Setup panel is not used.
6. Set the appropriate video and audio output settings in the Matrox Utilities preferences window (see Chapter 7, “Configuring Your MXO2 System”).
Working with Adobe After Effects

The Matrox WYSIWYG plug-in for After Effects lets you monitor video and audio from your After Effects project using the MXO2 outputs. Matrox also provides WYSIWYG options that you can set to customize your output preview.

Perform the following steps to output video and audio from the MXO2 outputs during playback in After Effects:

1. Start Adobe After Effects and either open an existing project, or start a new composition. If necessary, import your clip.

2. Set the MXO2 WYSIWYG settings in the Matrox Utilities preferences window (see “Specifying your Matrox WYSIWYG settings” on page 70).

3. Play back your clip. When playing back your clip in After Effects, the video portion of your clip is sent to the MXO2 outputs automatically. However, if you want to monitor audio from the MXO2 outputs as well, you must select MXO2 as the audio hardware device and then play back your clip in RAM Preview mode. To do so, choose After Effects > Preferences > Audio Hardware, select Matrox MXO2 Audio Output from the Default Device list, and launch RAM Preview (Composition > Preview > RAM Preview).
Working with Adobe Photoshop

The Matrox WYSIWYG plug-in for Photoshop lets you export your Photoshop image to the MXO2 outputs for monitoring. Matrox also provides WYSIWYG options that you can set to customize your output preview.

Perform the following steps to export your Photoshop image to the MXO2 outputs:

1. Start Adobe Photoshop and either open an existing image file, or start a new project.
2. Set the MXO2 WYSIWYG settings in the Matrox Utilities preferences window (see “Specifying your Matrox WYSIWYG settings” on page 70).
3. Export your image to the MXO2 outputs by choosing File > Export > Matrox WYSIWYG Preview. If you make a change to your image, or to the Matrox WYSIWYG options, you must export the image again to refresh the output.

Tip You can create a Photoshop Action shortcut for File > Export > Matrox WYSIWYG Preview. For information on creating Actions, see your Adobe Photoshop documentation.
Working with Adobe SpeedGrade

You can output video played back in Adobe SpeedGrade on the Matrox MXO2 video outputs to preview your clips on your video monitor. You can also choose to output audio played back in Adobe SpeedGrade on your Matrox MXO2 hardware.

For detailed information about using Adobe SpeedGrade, see your Adobe SpeedGrade documentation.

To specify your playback settings for use with Matrox MXO2:

1. In Adobe SpeedGrade, click Preferences ( ) at the top left of the window.
2. In the Preferences dialog, click Playback and set the Base frame rate for the playback, such as 29.97.
3. Click Display and select Enable under Mercury Transmit.
4. From the Device list, select Matrox Player.
5. From the Resolution list, select the resolution for playback, such as 1080p (1920 x 1080).
6. Click Setup and select the bit depth for your video output (8-bit or 10-bit).
Chapter 9, Using Matrox MXO2 with Supported Programs

7 Click OK to return to the Preferences dialog.
8 If you also want to output audio from your Matrox MXO2 hardware, click Sound, select Core Audio from the Engine list, and then select the Matrox MXO2 audio output option from the Device list.

Important For your sound device setting to take effect, you must quit and restart Adobe SpeedGrade.
9 Set the appropriate video and audio output settings in the Matrox Utilities preferences window (see Chapter 7, “Configuring Your MXO2 System”).
10 Play back your sequence in Adobe SpeedGrade.
Working with Avid Media Composer and Symphony

You can use Avid Media Composer and Avid Symphony with MXO2 to capture and play back video and audio. For a list of the supported input and capture video formats, see Appendix C, “Matrox MXO2 Supported Input and Capture Formats.” For a list of the supported video output formats, see Appendix D, “Matrox MXO2 Supported Output Formats.”

This section includes information on how to:

• Create a new Matrox MXO2 project. (page 111)
• Define your playback settings. (page 111)
• Define your capture settings. (page 112)
• Add a voice-over to your sequence. (page 114)
• Specify settings for capturing, playing back, and exporting Matrox 4VANC AFD and closed caption data. (pages 112–117)
• Specify your audio output settings. (page 118)
• Define settings for exporting your sequence to tape. (page 119)

Creating a new Matrox MXO2 project

You can create a new Avid Media Composer/Symphony project for working with Matrox MXO2 as explained in your Avid documentation, with the following exceptions:

• Avid supports only standard raster dimensions for projects created on Matrox MXO2 hardware. This means that when you create an HD project for MXO2, the raster dimension will be set to 1280×720 for a 720p project, or 1920×1080 for a 1080i/p project. You can, however, still import, export, and play back thin raster material in your HD project.
• Matrox MXO2 supports YCbCr video only. If you set your project’s color space to RGB, Avid Media Composer/Symphony will convert your material to YCbCr for output on Matrox MXO2. To capture video using your Matrox MXO2 hardware, your project’s color space must be set to YCbCr.

Defining your playback settings

This section details how to specify various settings for playing back video and audio in Avid Media Composer and Symphony using the Matrox MXO2 outputs. For a list of the supported video output formats, see Appendix D, “Matrox MXO2 Supported Output Formats.”
1. Specify the MXO2 General settings, and if applicable to your Matrox hardware, specify the Genlock settings (see Chapter 7, “Configuring Your MXO2 System”).

2. In Avid Media Composer/Symphony, open the project that you want to playback.

3. When using an MXO2, MXO2 LE, or MXO2 Rack SDI output for playback, you can choose to playback Matrox 4VANC AFD (active format description) or closed caption data that is stored as an audio track, and restore the data to your video's VANC (vertical ancillary data space) on output. For more information on Matrox 4VANC, see “Matrox 4VANC capture and playback” on page 66.

   **Note**  
   Matrox 4VANC is not available on Matrox MXO2 Mini.  
   To play back the Matrox 4VANC AFD and/or closed caption data, in Avid Media Composer/Symphony, click Settings in the Project window, and then double-click Audio Project. In the Audio Project Settings dialog box, in the Output pane, click the Mix Mode Selection button to select Direct or Direct, surround tracks in SMPTE order, depending on your version of Avid Media Composer/Symphony. Then, assign the audio track that contains the Matrox 4VANC AFD data to output as audio channel 15, and/or assign the audio track that contains the Matrox 4VANC closed caption data to output as audio channel 16. For information on how to maintain Matrox 4VANC AFD and closed caption data when exporting your project to a file, see “Specifying settings for exporting Matrox 4VANC AFD and closed captioning to a file” on page 117.

   **Note**  
   To preserve the integrity of the AFD and closed caption data for playback, do not manipulate the audio tracks that contain the AFD and closed caption data in any way. For example, do not adjust the audio gain or balance, or add audio effects to the tracks.

4. In Avid Media Composer/Symphony, click Settings in the Project window, double-click Video Output to open the Matrox Utilities preferences window, and specify your Matrox video output settings as described in “Specifying your video output settings” on page 58. If you’re playing back Matrox 4VANC AFD and/or closed caption data, you must enable Matrox 4VANC playback in the Matrox Utilities preferences window as described in “Matrox 4VANC capture and playback” on page 66.

5. In Avid Media Composer/Symphony, play back your project.

**Defining your capture settings**

This section details how to specify various settings for capturing video and audio in Avid Media Composer/Symphony using the Matrox MXO2 inputs.
When using MXO2 with Avid Media Composer/Symphony, your source material is captured to your project’s video format. You can also preview the captured video using the Matrox MXO2 outputs. When previewing the captured video, the output video format will match your project’s video format. For a list of the supported input and capture video formats, see Appendix C, “Matrox MXO2 Supported Input and Capture Formats.”

**Note** The SD channel video output setting is not supported on MXO2 during capture. To preview the captured video, Main channel must be selected for the MXO2 outputs in the Video Output pane of the Matrox Utilities preferences window (see “Specifying your video output settings” on page 58).

If you want to capture material using RS-422 device control, you can connect the RS-422 connector on Matrox MXO2, MXO2 Rack, or MXO2 LE to the RS-422 serial device control port on your source device (see “MXO2 RS-422 serial connection” on page 17, “MXO2 Rack RS-422 serial connection” on page 28, or “MXO2 LE RS-422 serial connection” on page 37). On Matrox MXO2 Mini, you must use a suitable adapter to connect the serial device control port on your source device or recorder to your computer. For a list of supported device control adapters, see the Matrox MXO2 Support section of our website at www.matrox.com/video/support.

**Remarks**

- To capture video on Matrox MXO2, your project’s color space must be set to YCbCr.
- Matrox MXO2 supports the Audio tool so that you can monitor and adjust your audio input levels for capture.
- Capture on Matrox MXO2 is not supported for a 24p NTSC, 24pPAL, or 720p/29.97 project.

**To specify your capture settings**:

1. Specify the MXO2 General settings, and if applicable to your Matrox hardware, specify the Genlock settings (see Chapter 7, “Configuring Your MXO2 System”.
2. Open Avid Media Composer/Symphony and create a new project (see “Creating a new Matrox MXO2 project” on page 111). Your source material will be captured to your project’s video format.
3. In the Capture tool, make sure that Matrox is selected as the Video and Audio input sources.
4. When using an MXO2, MXO2 LE, or MXO2 Rack SDI input for capture, you can choose to capture the AFD (active format description) or closed caption data that is stored in your source video’s VANC (vertical ancillary data space) by using the Matrox 4VANC tool. For more information on Matrox 4VANC, see “Matrox 4VANC capture and playback” on page 66.
To capture AFD and/or closed caption data, in Avid's **Capture** tool, enable all 16 audio channels, set audio channels 15 and 16 to **Mono**, and select **1:1 MXF** from the **Res** list.

**Note** Matrox 4VANC is not available on Matrox MXO2 Mini.

5 Click the **Hardware Setup** ( ) button to open the **Matrox Utilities** preferences window, and specify your Matrox capture settings as described in “Specifying your A/V input settings” on page 55. If you’re capturing Matrox 4VANC AFD and/or closed caption data, you must enable Matrox 4VANC capture in the **Matrox Utilities** preferences window as described in “Matrox 4VANC capture and playback” on page 66.

6 Capture as you would normally.

### Adding a voice-over to your sequence
Matrox MXO2 supports the **Audio Punch-In** tool, which allows you to record audio directly into the **Timeline** to add voice-over narration, such as to add commentary to newsreels and documentaries.

**Note** The **Audio Punch-In** tool supports recording to mono tracks only.

### Connection and setup

1 Connect the input device (microphone) to the audio input on a source device, such as a preamplifier, and then connect the audio output from the source device to the corresponding audio input on your MXO2 hardware.

**Note** The Matrox hardware audio inputs are line level. Therefore, make sure your audio equipment output matches.

2 From the **Apple** menu, click **System Preferences**, and then click the **Matrox Utilities** icon.
3 Click A/V Input.

4 Under Input Source, select the Audio input on your Matrox hardware to which your audio source device is connected, and then select Component from the Video list.

5 Close the Matrox Utilities preferences window.

Recording your voice-over
You use the Audio Punch-In tool to record your voice-over. The following steps provide guidelines for recording a voice-over. For details on using the Audio Punch-In tool, see your Avid documentation.
1 With a sequence loaded in the Avid Media Composer/Symphony timeline, choose Tools > Audio Punch-In.

2 Select Matrox from the Input Source list.

Tip If Matrox MXO2 (serial number) Audio Input appears in the Input Source list instead of Matrox, the Matrox hardware is deactivated in Avid. Click the Toggle Hardware button in Avid to activate the Matrox hardware, and then select Matrox.

3 Select the Matrox audio input channels that you want to record, and then select the corresponding tracks on which you want to record. If you select an existing track, you can replace all or part of the audio on the track with your voice-over.

4 Click the Audio Tool button ( ), and use the controls and meters in the Audio tool to test the audio input levels while speaking into the microphone. If needed, adjust the audio level on your source device so that the input levels are sufficiently high but not clipping.

Note To see the meters in the Audio tool, make sure that the In/Out toggle buttons are set to I (for Input):

For details on using the Audio tool, see your Avid documentation.

Chapter 9, Using Matrox MXO2 with Supported Programs
5 Move the position indicator on the timeline to where you want the voice-over to begin. You can also set In and Out points to specify the section of the timeline to which you want to add your voice-over, and specify preroll and postroll values if desired.

6 When you’re ready to start the voice-over, click the Record button ( ).

7 Click the Stop button ( ) to stop the recording. Your voice-over will be added as an audio clip on the Timeline.

**Note** During recording, your voice-over will not be output to your Matrox MXO2 hardware, and audio punch-in monitoring is not supported.

### Specifying settings for exporting Matrox 4VANC AFD and closed captioning to a file

When working in an Avid Media Composer or Symphony project that has Matrox 4VANC AFD and/or closed caption data stored as an audio track, the following steps detail how to specify your settings in Avid Media Composer/Symphony to maintain the Matrox 4VANC AFD and closed caption data when exporting your project to a file. For information on how to capture and play back Matrox 4VANC data in Avid Media Composer/Symphony, see “Defining your capture settings” on page 112 and “Defining your playback settings” on page 111.

1 In Avid Media Composer/Symphony, make sure that the audio track that contains the Matrox 4VANC AFD data is set to output as audio channel 15, and/or the audio track that contains the Matrox 4VANC closed caption data is set to output as audio channel 16.

2 Choose File > Export.

3 In the Export As dialog, select Send to QT Movie from the Export setting list, and then click Options.

4 In the Export Settings dialog, select the Use Marks and Use Enabled Tracks options, select Video and Audio, and then select Direct Out in the Audio Format pane.

### Specifying settings for importing a Matrox 4VANC file

When working in Avid Media Composer or Symphony, you can import a video file that contains Matrox 4VANC AFD and/or closed caption data to your project. You can also import a Matrox 4VANC closed caption audio file that was created using a supported captioning software, such as CPC MacCaption. This section details how to import your Matrox 4VANC file in Avid Media Composer/Symphony.

**Working with Avid Media Composer and Symphony**
For information on how to capture and play back Matrox 4VANC data in Avid Media Composer/Symphony, see “Defining your capture settings” on page 112 and “Defining your playback settings” on page 111. For information on how to specify your settings in Avid Media Composer/Symphony to maintain the Matrox 4VANC AFD and closed caption data when exporting your project, see “Specifying settings for exporting Matrox 4VANC AFD and closed captioning to a file” on page 117.

1 In Avid Media Composer/Symphony, choose File > Import.
2 In the Select files to Import dialog, select 1:1 MXF from the Resolution list, except when importing a Matrox 4VANC closed caption audio file that was created using a supported captioning software, such as CPC MacCaption. In this case, select a DV MXF option from the list.
3 Click Options.
4 In the Audio pane, make sure that all options are cleared, and then click OK.
5 In the Select files to Import dialog, select the file to import and then click Open.

**Specifying your audio output settings**
The simultaneous audio outputs on your Matrox MXO2 hardware allow you to send your audio to a variety of devices at the same time. Avid Media Composer/Symphony and Matrox provide various settings to configure your audio output on MXO2.

1 In Avid Media Composer/Symphony, click Settings in the Project window, and then double-click Audio Project.
2 In the Audio Project Settings dialog, click the Output tab, and then specify your desired audio output settings as explained in your Avid documentation. If playing back a project with Matrox 4VANC AFD and/or closed caption data, see “Defining your playback settings” on page 111 for information on how to specify your audio settings in Avid for use with Matrox 4VANC. If exporting a project with Matrox 4VANC AFD or closed captioning to a file, see “Specifying settings for exporting Matrox 4VANC AFD and closed captioning to a file” on page 117.

**Remarks**
- For surround sound HDMI audio output, Matrox MXO2 supports the 5.1 and 7.1 SMPTE settings only (and the Direct SMPTE setting, if available).
- Matrox MXO2 supports the Audio tool so that you can monitor the global output level of your sequence. If needed, you can use the Output Gain (master attenuator) slider to adjust the overall output volume for all tracks.
To preserve the integrity of Matrox 4VANC AFD or closed caption data for playback (see “Defining your playback settings” on page 111), do not manipulate the audio tracks that contain the AFD and closed caption data in any way. For example, do not adjust the audio gain or balance, or add audio effects to the tracks.

MXO2 lets you map any audio track in Avid Media Composer/Symphony to any MXO2 audio output. For information on how to enable and configure audio mapping in MXO2, see “Specifying your audio output settings” on page 62.

**Note** For surround sound HDMI audio output, the **Enable audio mapping** option in the **Audio Output** pane of the **Matrox Utilities** preferences window must be disabled.

### Exporting your sequence to tape

You can record your sequence onto tape using device control or manually as explained in your Avid documentation. Before exporting to tape, set your desired playback settings as explained in “Defining your playback settings” on page 111. For a list of the supported video output formats, see Appendix D, “Matrox MXO2 Supported Output Formats.”

To export to tape without device control, simply play back your sequence and record the output from any of the available outputs on your MXO2 system.

If your recorder supports RS-422 device control, you can connect the RS-422 connector on Matrox MXO2, MXO2 Rack, or MXO2 LE to the RS-422 serial control port on your recorder (see “MXO2 RS-422 serial connection” on page 17, “MXO2 Rack RS-422 serial connection” on page 28, or “MXO2 LE RS-422 serial connection” on page 37). On Matrox MXO2 Mini, you must use a suitable adapter to connect the serial device control port on your source device or recorder to your computer. For a list of supported device control adapters, see the Matrox MXO2 Support section of our website at www.matrox.com/video/support.

**Note** When using an analog RS-422 device on MXO2, MXO2 Rack, or MXO2 LE, you must genlock to an external broadcast-quality analog sync source. If you’re using an SDI RS-422 device and you don’t have an external broadcast-quality analog sync source, you can set your genlock source to the MXO2 internal reference and configure the setting on your deck to genlock to the SDI video input. For details on how to set your genlock source, see “Specifying your genlock settings” on page 54.

To record the output from your MXO2 system using device control with the **Digital Cut** tool, make sure that the **Output Mode** is set to **Real-Time**. Also, when configuring your deck in the **Channel** window, make sure that **Direct** is selected from the **Channel Type** list, and **Matrox RS-422** is selected from the **Port** list.

**Working with Avid Media Composer and Symphony**
Important If you want to downconvert a 720p/23.976, 1080p/23.976, or 1080p24 sequence to SD to record a digital cut, you must change your project’s format (project type) to SD. For example, to downconvert a 720p/23.976 or 1080p/23.976 sequence to NTSC to record a digital cut, you must change the project type to 23.976p NTSC. You can then select the output format that you want in the Digital Cut tool.

Working with Apple Final Cut Pro X
You can use Apple Final Cut Pro X to play back and output video and audio using Matrox MXO2.

Playback using Matrox MXO2
This section details how to play back and output video and audio in Apple Final Cut Pro X using Matrox MXO2. For a list of the supported video output formats, see Appendix D, “Matrox MXO2 Supported Output Formats.”

1. Ensure that Apple Final Cut Pro X is not running.
2. From the Apple menu, click System Preferences, and then click the Matrox Utilities icon.

3. In the Matrox Utilities preferences window, in the FCP X pane, select the Output format that matches the format of the project or clip that you want to play back in Final Cut Pro X.
Note If the Output format list is unavailable and “(In use)” appears, the MXO2 hardware is currently being used by an application on your system. To change the output format, you must first disable A/V Output in Final Cut Pro X (Window > A/V Output), or close any application that is using Matrox MXO2.

4 In System Preferences > Sound, set Matrox MXO2 as the Output audio device for your Mac OS system. Close the Sound preferences window.
5 Open Final Cut Pro X, choose Final Cut Pro > Preferences, and ensure that the Matrox video format that you selected in step 3 appears as the A/V Output option in the Playback pane.

6 In the Playback pane, set Playback Quality to High Quality. However, if you experience dropped frames in your video output, select Better Performance.
7 From the **Window** menu, enable **A/V Output**.

8 Play back your video in Final Cut Pro X.
Using the Matrox MAX H.264 Codec

This chapter explains how to use the Matrox MAX H.264 codec that is available on Matrox MXO2 products with MAX technology for exporting material for Blu-ray Disc, the web and mobile devices.
Overview

If you have an MXO2 product with Matrox MAX technology, you can quickly and easily create H.264 files for Blu-ray Disc (Apple Compressor only), the web and mobile devices, such as Apple TV, iPod, and iPhone, using the Matrox MAX H.264 codec.

Remarks

- The MXO2 inputs and outputs will not be available when creating H.264 files using the Matrox MAX H.264 codec. This limitation, however, does not apply if your system includes a Matrox CompressHD card. In this case, the Matrox MAX H.264 codec on your Matrox CompressHD card will always be used, and your MXO2 inputs and outputs will be available when creating H.264 files.

- Non-Matrox compression options that are available in supported applications are not optimized for using MXO2 to accelerate H.264 encoding. As a result, the use of non-Matrox options in a supported application may result in increased encoding times.

This chapter provides information on how to encode using the Matrox MAX H.264 codec from the following applications:

- Apple Compressor (page 126)
- Apple Final Cut Pro X (page 135)
- Adobe Premiere Pro (page 136)
- Adobe Media Encoder (page 136)
- Telestream Episode (page 140)
- Avid Media Composer (page 143)
- Avid Symphony (page 143)
- Apple QuickTime Pro (page 147)

Using Apple Compressor

The Matrox MAX H.264 component for Apple Compressor includes predefined Matrox MAX H.264 settings that you can assign to immediately apply appropriate compression settings for delivering H.264 files for Blu-ray, the web, and mobile devices. For most deliverables, you can use one of the predefined Matrox MAX H.264 settings in Compressor (see “Assigning a Matrox MAX H.264 setting” on page 127). However, if you require a custom setting, see “Creating a custom Matrox MAX H.264 setting” on page 128. For detailed information on settings and other Compressor-related subjects, see your Apple Compressor documentation.
The Matrox MAX H.264 Blu-ray settings encode video only. Audio is not encoded by the Matrox MAX H.264 codec when creating H.264 elementary streams for Blu-ray. To include audio when exporting to Blu-ray format, you must assign a separate audio setting to your source media file. However, audio is encoded by the Matrox MAX H.264 codec when creating QuickTime files for the web and mobile devices. The Matrox MAX H.264 elementary stream files that you create for Blu-ray Disc using Compressor can be imported directly to Adobe Encore and Roxio Toast without having to transcode the files.

Matrox MAX technology also supports the closed caption data from SCC files for web deliverables (.mov) when encoding at 1:1, or when downscaling. When an SCC (CEA-608) closed caption file is associated with your source media file in Compressor, Matrox MAX technology embeds the closed caption data in the encoded video file (.mov).

**Assigning a Matrox MAX H.264 setting**

This section describes how to assign a Matrox MAX H.264 setting to your source file in Apple Compressor. The Matrox MAX H.264 settings include the predefined settings installed with your MXO2 software, and any custom settings that you create (see “Creating a custom Matrox MAX H.264 setting” on page 128).

**Note** When selecting a predefined Matrox MAX H.264 setting, any modifications made to your source video’s frame size in your application must be taken into consideration. For example, if your source video was cropped in your application, your source video’s frame size is the cropped frame size and not the original frame size.

The predefined Matrox MAX H.264 settings that are installed with your MXO2 software are located in Compressor’s Settings window, under Custom > Matrox MAX H.264 Settings. The predefined Matrox MAX H.264 settings are separated into three folders: Blu-ray, Fast Encode, and High-Quality:

- **Blu-ray** Use these settings for all Blu-ray deliverables. The encoded file’s extension will be .264.

  **Note** For compatibility with most Blu-ray players and Adobe Encore, the predefined Matrox MAX H.264 settings for Blu-ray use a simple GOP structure.

- **Fast Encode** Use these settings for fast encoding of QuickTime files. These settings leverage your system’s resources with the MXO2 hardware, resulting in even faster encoding times. The encoded file’s extension will be .mov.

  **Note** If your source video must be scaled for encoding and its aspect ratio does not match the compression aspect ratio, with Compressor v3.5 or later,
you can select **Preserve source aspect ratio** from the **Padding** list in Compressor’s Geometry pane to maintain your source video’s aspect ratio.

- **High-Quality**  Use these settings for high-quality encoding of QuickTime files. With these settings, the encoding is performed entirely by the MXO2 hardware, which frees your system’s resources for other tasks. The encoded file’s extension will be `.mov`.

**™**

To assign a Matrox MAX H.264 setting:

1. In Apple Compressor, add the source media file that you want to export as an H.264 file to the **Batch** window in Compressor.

2. Drag the desired **Matrox MAX H.264** setting from the **Settings** window to your source media file (job) in the **Batch** window.

**Note**  Matrox MAX technology supports closed caption data from SCC files for web deliverables `.mov` when encoding at 1:1, or when downscaling. When an SCC (CEA-608) closed caption file is associated with your source media file in Compressor, Matrox MAX technology embeds the closed caption data in the encoded video file `.mov`.

3. If you’re exporting to Blu-ray format and you want to export audio as well, you must add a separate audio setting to your **Batch** window. Matrox provides predefined audio settings for each of the Matrox settings, however, you can choose to use another audio setting.

4. Choose a destination for your job’s targets and submit your batch as you would normally.

### Creating a custom Matrox MAX H.264 setting

You can create a custom Matrox MAX H.264 setting in Apple Compressor for delivering H.264 files for either Blu-ray (.264) or QuickTime (.mov). Once you create a new Matrox MAX H.264 setting, you can assign it to your source file in Apple Compressor using the steps described in “Assigning a Matrox MAX H.264 setting” on page 127.

**™**

To avoid losing your custom Matrox MAX H.264 settings in Compressor when updating your MXO2 software, you must uninstall the MXO2 software that is installed on your system, restart your computer, and then install the new MXO2 software version before opening Compressor. If you open Compressor before installing the new MXO2 software, that is, with no MXO2 software installed on your computer, your custom Matrox MAX H.264 settings will be deleted by Compressor.
1. In Apple Compressor, click the **Create a new setting** button in the **Settings** window, and then click either **Matrox MAX H.264 (.264)** for Blu-ray or **Matrox MAX H.264 (.mov)** for QuickTime.

   **Note** You can also select and duplicate an existing Matrox MAX H.264 setting that you want to use as a starting point for creating the new setting.

2. In the **Inspector** window, type a **Name** and **Description**.

3. On the **Encoder** pane of the **Inspector** window, make sure that **File Format** is set to **Matrox MAX H.264 (.264)** for Blu-ray or **Matrox MAX H.264 (.mov)** for QuickTime, and **Extension** is set to **.264** for Blu-ray or **.mov** for QuickTime, and then click **Options**.

---

**(.264 options)**

**(.mov options)**

---

**Using Apple Compressor**
4 Under **Encoding Resolution**, select the resolution settings for your encoded video:

**Note** Matrox MAX technology supports closed caption data from SCC files for web deliverables (.mov) when encoding at 1:1, or when downscaling. When an SCC (CEA-608) closed caption file is associated with your source media file in Compressor, Matrox MAX technology embeds the closed caption data to the encoded video file (.mov).

- **H.264 Level** Select the H.264 level that you want for your encoded video.

<table>
<thead>
<tr>
<th>H.264 Level</th>
<th>Maximum Frame Size</th>
<th>Maximum Frame Rate (fps)</th>
<th>Maximum Data Rate (Mb/s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0</td>
<td>352×288</td>
<td>29.97</td>
<td>2</td>
</tr>
<tr>
<td>3.0</td>
<td>720×576</td>
<td>29.97</td>
<td>10</td>
</tr>
<tr>
<td>3.1</td>
<td>1280×720</td>
<td>29.97</td>
<td>14</td>
</tr>
<tr>
<td>4.0</td>
<td>1920×1080</td>
<td>29.97</td>
<td>20</td>
</tr>
<tr>
<td>4.1</td>
<td>1920×1080</td>
<td>29.97</td>
<td>50</td>
</tr>
<tr>
<td>4.2</td>
<td>1920×1080</td>
<td>59.94</td>
<td>50</td>
</tr>
</tbody>
</table>

**Remarks**

- Use H.264 level 4.0 if you want to create Matrox MAX H.264 files intended for mass replication of Blu-ray Discs. You can use either level 4.0 or 4.1 if you want to author and burn individual copies that are compatible with Blu-ray Disc players.
- Use H.264 level 3.1 to create HD video for use with Apple iPad.
- **Frame size** Specify the frame size that you want for your encoded video. You can select a frame size from the list, or select **Custom** and enter a frame size (horizontal×vertical). If entering a custom frame size, the minimum frame size is 64×64, and the maximum frame size depends on the selected H.264 level. The horizontal and vertical values must be even numbers.

**Note** The available frame sizes in the list depend on the selected H.264 level. If the compression frame size differs from your source video’s frame size, MXO2’s onboard scaler will either upscale or downscale your source video.

- **Pixel aspect ratio** If you entered a custom compression frame size, specify a pixel aspect ratio for your encoded video. You can select a pixel aspect ratio from the list, or enter a custom value:
  - **Custom** Enter a custom pixel aspect ratio using a decimal value.
Using Apple Compressor

- **Square**  Use this for video that will be displayed on a computer, or when exporting to 1280×720 or 1920×1080.
- **NTSC (4:3)**  Sets the pixel aspect ratio to 4:3 using 720×480 pixels.
- **NTSC (16:9)**  Sets the pixel aspect ratio to 16:9 using 720×480 pixels.
- **PAL (4:3)**  Sets the pixel aspect ratio to 4:3 using 720×576 pixels.
- **PAL (16:9)**  Sets the pixel aspect ratio to 16:9 using 720×576 pixels.
- **DVCPRO HD 720p**  Sets the pixel aspect ratio to 16:9 using 960×720 pixels.
- **DVCPRO HD 1080i 59.94**  Sets the pixel aspect ratio to 16:9 using 1280×1080 pixels.
- **DVCPRO HD 1080i 50 / HDV**  Sets the pixel aspect ratio to 16:9 using 1440×1080 pixels.

- **Color space**  If you entered a custom compression frame size, specify a color space for your encoded video.
- **Frame rate**  Select the frame rate that you want for your encoded video.
- **Web streaming (Fast Start)**  (.mov files only) Select this option if you want your encoded .mov QuickTime file to play as it is being downloaded from a standard web server. This option encodes your video as a QuickTime “Fast Start” file. When the file is being downloaded, it will begin to play back from a QuickTime application once enough data has been downloaded to the system for uninterrupted playback. This option ensures high-quality playback regardless of internet connection speed. However, viewers with slower connection speeds may wait longer before the file begins to play.

5 Under **GOP Structure**, specify the GOP structure settings that you want the Matrox MAX H.264 codec to use to encode your video:

- **GOP type**  (.264 files only) Select the type of GOP structure for your encoded video:
  - **Simple GOP**  Offers a fixed structure in how frames are referenced, and may be more easily decoded than advanced GOPs.
  - **Advanced GOP (short/long)**  An advanced GOP has more structural flexibility than a simple GOP, is capable of using more reference frames, and therefore may provide better overall compression. For a “short” advanced GOP, the distance between P frames is always 4, and for a “long” advanced GOP, the distance between P frames is always 8.

**Important**  An H.264 elementary stream file for Blu-ray that was created using an advanced GOP structure may not be compatible with some Blu-ray players, and may cause stability issues in Adobe Encore when burning a

Using Apple Compressor
Blu-ray Disc. For compatibility with most Blu-ray players and Adobe Encore, we recommend using a simple GOP structure when encoding to Blu-ray.

- **GOP size**  Select the GOP size in frames (must be a multiple of the distance between P frames). The GOP size can be either 2048, or an integer value between 3 and 254.

**Note**  When creating an H.264 elementary stream file for Blu-ray, the GOP size must be less than one second of video. For example, if the frame rate that you want for your encoded video is 29.97 fps, the GOP size must be 29 frames or less.

- **Distance between P frames**  Select the number of frames between P frames that you want for your GOP structure. This setting can be changed for a simple GOP structure only.

6  Under **Hardware Preprocessing**, specify the hardware-related processing settings for your encoded video:

- **Hardware scaling**  If your source video must be scaled for encoding, select this option if you want the scaling to be done by the MXO2 hardware. This produces the best-quality results and frees your system’s resources for other tasks. Clear this option to leverage your system’s resources with the MXO2 hardware for even faster encoding times. If enabled, specify the following scaling options:
  - **De-interlace video**  Select this option if your source video is interlaced and you want to de-interlace your video before encoding. This option can be used to display your encoded video on a monitor that displays lines progressively, such as an LCD or computer monitor. For all other instances, make sure this option is not selected.
  - **Retain aspect ratio when scaling**  If your source video must be scaled for encoding, and its aspect ratio does not match your selected compression aspect ratio, select this option to maintain your source video’s aspect ratio. If this option is selected, MXO2 will encode your source video as pillarbox video when encoding to a larger aspect ratio, or letterbox video when encoding to a smaller aspect ratio. If this option is not selected, MXO2 will encode your source video as anamorphic video.

**Important**  When your source video must be scaled for encoding and **Hardware scaling** is disabled, if you’re working with Compressor v3.5 or later you can select **Preserve source aspect ratio** from the Padding list in Compressor’s Geometry pane to maintain your source video’s aspect ratio.

- **Noise Filter**  Sets the level of noise filtering that you want to apply to your video before encoding. Increasing the noise filter level reduces the amount of high frequencies in your source video by softening the

Chapter 10, Using the Matrox MAX H.264 Codec
high-detail portions of your video. Since high frequencies require more
bits to encode, increasing the noise filter level leaves more bits available
for the encoding of other frames, which can improve the overall quality of
your encoded video. However, if you lose too much detail in your encoded
video you may need to decrease the noise filter level.

- **Scene detection** (.mov files only) Enabling this option allows the
Matrox MAX H.264 codec to detect scene changes while encoding, and
encode these transitions as I-frames. This results in multi-pass quality in a
single pass. This option can be useful for creating higher quality video at a
given data rate. It’s especially useful when encoding video with many
scene changes and targeting a low data rate.

7 Under **Video Compression**, specify the compression settings for your
encoded video:

- **Algorithm** Select the entropy coding method to be used during
compression:
  - **CABAC** Uses the CABAC coding method, and defines the video
    stream as H.264 Main profile.
  - **CAVLC** Uses the CAVLC coding method, and defines the video
    stream as H.264 Baseline profile when **Distance between P frames**
    is set to 1. Otherwise, the video stream is defined as H.264 Main
    profile. This method is not supported when encoding to a frame size
    that has a width greater than 720.

- **Compression type** Select from the following compression types:
  - **Variable data rate** Video is compressed at varying data rates based
    on the complexity of the video and your specified minimum and
    maximum data rates. The Matrox MAX H.264 codec analyzes and
    encodes each frame to deliver the highest possible quality at your target
    data rate.
  - **Constant data rate** Video is compressed at your specified target
    data rate, which is useful when you need to limit or predict the size of
    your video file. However, if your video is very complex (such as scenes
    with many colors, sharp edges, or transitions), you’ll need to specify a
    high target data rate to avoid having frames of blocky video in your file.
  - **Constant quality** Delivers your desired quality on each frame with
    no regard to data rate.

**Remarks**
- When using **Constant quality**, the entropy encoding algorithm must be
  set to CABAC.
- **Variable data rate** and **Constant quality** compression types are not
  recommended for delivering H.264 files for Blu-ray.

8 Specify the settings associated with your selected compression type:

**Using Apple Compressor**
– **Target data rate**  (Variable/Constant data rate only) Enter the target data rate, in \( \text{Mb/s} \) or \( \text{Kb/s} \), for your encoded video. The higher the target data rate you specify, the better the video quality will be.

– **Minimum/Maximum data rate**  (Variable data rate only) If locked to the **Target data rate**, the minimum and maximum data rates are set automatically and cannot be changed. Unlock the minimum and maximum data rates to set custom rates for your encoded video.

**Note**  If you’ll be using Adobe Encore or Apple Compressor 3.5 to burn the encoded H.264 file for Blu-ray, the maximum H.264 level and data rate accepted by these applications for Blu-ray authoring is H.264 level 4.1 at 35 Mb/s (Encore) and H.264 level 4.1 at 30 Mb/s (Compressor).

– **Source video complexity**  (Variable data rate only) Specifies the complexity level of your source video. A complex video can be defined as containing scenes with many colors, sharp edges, or transitions. The Matrox MAX H.264 codec uses this setting to determine how much compression is required in order to deliver high-quality video at your specified target data rate. The default setting (15) is suitable for most moderately complex videos. For simpler or more complex videos, you may need to adjust this setting to obtain the highest-quality encoding possible while respecting your target data rate. If the size of your encoded video is good but the quality can be improved, lower the complexity level setting. Your video will then be encoded with less compression. If the quality of your encoded video is good but the size is larger than expected, raise the complexity level setting. Your video will then be encoded with more compression. In any case, you may need to try different settings to get your desired results.

– **Sample rate**  (Variable/Constant data rate only) Determines how frequently the Matrox MAX H.264 codec verifies the current data rate while encoding and compares it to your specified target data rate. If a discrepancy exists between the current and target data rates, the current data rate is adjusted as specified by the **Data rate adjustment** option.

– **Data rate adjustment**  (Variable/Constant data rate only) When the current encoding data rate does not match your specified target data rate, this setting determines how quickly the current data rate is adjusted to reach the target data rate. A gradual adjustment produces smoother transitions than a quick adjustment.

– **Encoding quality**  (Constant quality only) Specifies the quality level for your encoded video. Every frame in your video will be encoded at the specified quality level with no regard to data rate.

9 For .mov files, select **Enable audio** under **Audio** to encode audio along with your video, and then click **Settings** to set your QuickTime movie audio settings.

---

**Chapter 10, Using the Matrox MAX H.264 Codec**
Using Apple Final Cut Pro X

When working in Final Cut Pro X, you can send your clip to Apple Compressor and then use the Matrox MAX H.264 Compressor settings to export H.264 files for Blu-ray, the web, and other mobile devices. For detailed information on Final Cut Pro X- or Compressor-related subjects, see your application’s documentation.

**Note** If your system includes a Matrox CompressHD card, you can also use the Share feature in Final Cut Pro X for encoding using the Matrox MAX H.264 codecs in Compressor. Final Cut Pro X’s Share feature is not supported if your system does not include a Matrox CompressHD card.

The Matrox MAX H.264 Blu-ray settings encode video only. Audio is not encoded by the Matrox MAX H.264 codec when creating H.264 elementary streams for Blu-ray. To include audio when exporting to Blu-ray format, you must assign a separate audio setting to your source media file. However, audio is encoded by the Matrox MAX H.264 codec when creating QuickTime files for the web and mobile devices.

**Note** When selecting a predefined Matrox MAX H.264 setting, any modifications made to your source video’s frame size in your application must be taken into consideration. For example, if your source video was cropped in your application, your source video’s frame size is the cropped frame size and not the original frame size.

The predefined Matrox MAX H.264 Compressor settings are separated into three folders: Blu-ray, Fast Encode, and High-Quality:

- **Blu-ray** Use these settings for all Blu-ray deliverables. The encoded file’s extension will be `.264`.

  **Note** For compatibility with most Blu-ray players and Adobe Encore, the predefined Matrox MAX H.264 settings for Blu-ray use a simple GOP structure.

- **Fast Encode** Use these settings for fast encoding of QuickTime files. These settings leverage your system’s resources with the MXO2 hardware, resulting in even faster encoding times. The encoded file’s extension will be `.mov`.
Note If your source video must be scaled for encoding and its aspect ratio does not match the compression aspect ratio, with Compressor v3.5 or later, you can select Preserve source aspect ratio from the Padding list in Compressor’s Geometry pane to maintain your source video’s aspect ratio.

- High-Quality Use these settings for high-quality encoding of QuickTime files. With these settings, the encoding is performed entirely by the MXO2 hardware, which frees your system’s resources for other tasks. The encoded file’s extension will be .mov.

To send a Final Cut Pro X clip to Apple Compressor for export using the Matrox MAX H.264 settings:

1. In Final Cut Pro X, select the clip or sequence that you want to export.
2. If your system does not include a Matrox CompressHD card, from the Window menu, disable A/V Output.
3. Choose File > Send to Compressor.
4. Drag the desired Matrox MAX H.264 setting from the Settings window to your source media file (job) in the Batch window.

Note Matrox MAX technology supports closed caption data from SCC files for web deliverables (.mov) when encoding at 1:1, or when downscaling. When an SCC (CEA-608) closed caption file is associated with your source media file in Compressor, Matrox MAX technology embeds the closed caption data in the encoded video file (.mov).

5. If you’re exporting to Blu-ray format and you want to export audio as well, you must add a separate audio setting to your Batch window. Matrox provides predefined audio settings for each of the Matrox settings, however, you can choose to use another audio setting.
6. Choose a destination for your job’s targets and submit your batch as you would normally.

Using Adobe Premiere Pro or Media Encoder

This section details how to specify the Matrox MAX H.264 compression settings in Adobe Premiere Pro and Media Encoder for delivering QuickTime files for the web, and for use with Apple TV, iPad, iPod, iPhone, and other QuickTime-based devices. The encoded file’s extension will be .mov.

The Matrox MAX H.264 component for Premiere Pro and Media Encoder includes predefined Matrox MAX H.264 presets that you can use to immediately apply appropriate compression settings for delivering H.264 files. For most deliverables, you can use one of the predefined Matrox MAX H.264 presets (see “Assigning a Matrox MAX H.264 preset” on page 137). However, if you require a custom setting, see “Creating a custom Matrox MAX H.264 preset” on page 137.

Chapter 10, Using the Matrox MAX H.264 Codec
Assigning a Matrox MAX H.264 preset

This section describes how to assign a Matrox MAX H.264 preset to your source file in Premiere Pro and Media Encoder for delivering QuickTime files for the web, and for use with Apple TV, iPad, iPod, iPhone, and other QuickTime-based devices. The Matrox MAX H.264 presets include the predefined presets installed with your MXO2 software, and any custom presets that you create (see “Creating a custom Matrox MAX H.264 preset” on page 137).

**Note**  When selecting a predefined Matrox MAX H.264 preset, any modifications made to your source video’s frame size in your application must be taken into consideration. For example, if your source video was cropped in your application, your source video’s frame size is the cropped frame size and not the original frame size.

1 Start Adobe Premiere Pro and open a project, or start Adobe Media Encoder and add the source clip or sequence to the queue.

**Note**  When encoding using the Matrox MAX H.264 codec in Adobe Media Encoder, the Matrox MAX H.264 codec does not support batch encoding the same item (job) in the queue to more than one Matrox MAX H.264 setting. To export your file/sequence to more than one Matrox MAX H.264 setting, you must add a separate item to the queue for each Matrox MAX H.264 setting.

2 If you’re working with Premiere Pro, choose File > Export > Media. If you’re working with Media Encoder, in the Queue panel, right-click the clip or sequence that you want to export, and then click Export Settings.

3 In the Export Settings dialog, under Export Settings, select QuickTime from the Format list, and then select the desired Matrox MAX preset from the Preset list.

4 Export the file as you would normally.

Creating a custom Matrox MAX H.264 preset

You can create a custom Matrox MAX H.264 preset in Adobe Premiere Pro and Media Encoder for delivering QuickTime files for the web, and for use with Apple TV, iPad, iPod, iPhone, and other QuickTime-based devices. Once you create a new Matrox MAX H.264 preset, you can assign it to your source file in Premiere Pro and Media Encoder using the steps described in “Assigning a Matrox MAX H.264 preset” on page 137.

1 Start Adobe Premiere Pro and open a project, or start Adobe Media Encoder and add the source clip or sequence to the queue.

**Note**  When encoding using the Matrox MAX H.264 codec in Adobe Media Encoder, the Matrox MAX H.264 codec does not support batch encoding the same item (job) in the queue to more than one Matrox MAX H.264 setting.
To export your file/sequence to more than one Matrox MAX H.264 setting, you must add a separate item to the queue for each Matrox MAX H.264 setting.

2 If you’re working with Premiere Pro, choose File > Export > Media. If you’re working with Media Encoder, in the Queue panel, right-click the clip or sequence that you want to export, and then click Export Settings.

3 In the Export Settings dialog, under Export Settings, select QuickTime from the Format list.

Tip You can use an existing Matrox MAX preset as a starting point for your new preset by selecting the desired preset from the Preset list before specifying your export settings.

4 In the Video pane, under Video Codec, select Matrox MAX H.264 from the Video Codec list, and then click Codec Settings.

5 In the Matrox MAX H.264 Codec Settings dialog, set the following options:

- Select the entropy coding Algorithm to be used during compression:
  - CABAC Uses the CABAC coding method, and defines the video stream as H.264 Main profile.
  - CAVLC Uses the CAVLC coding method, and defines the video stream as H.264 Main profile when Frame Reordering (under Advanced Settings) is selected. Otherwise, the video stream is defined as H.264 Baseline profile. This method is not supported when encoding to a frame size that has a width greater than 720. In this case, CABAC will always be used for encoding.

- De-interlace video Select this option if your source video is interlaced and you want to de-interlace your video before encoding. This option can be used to display your encoded video on a monitor that displays lines progressively, such as an LCD or computer monitor. For all other instances, make sure this option is not selected.
Using Adobe Premiere Pro or Media Encoder

Select the **H.264 level** that you want to be used to encode your video.

<table>
<thead>
<tr>
<th>H.264 level</th>
<th>Maximum Frame size</th>
<th>Maximum Frame rate (fps)</th>
<th>Maximum Data rate (Mb/s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0</td>
<td>352x288</td>
<td>29.97</td>
<td>2</td>
</tr>
<tr>
<td>3.0</td>
<td>720x576</td>
<td>29.97</td>
<td>10</td>
</tr>
<tr>
<td>3.1</td>
<td>1280x720</td>
<td>29.97</td>
<td>14</td>
</tr>
<tr>
<td>4.0</td>
<td>1920x1080</td>
<td>29.97</td>
<td>20</td>
</tr>
<tr>
<td>4.1</td>
<td>1920x1080</td>
<td>29.97</td>
<td>50</td>
</tr>
<tr>
<td>4.2</td>
<td>1920x1080</td>
<td>59.94</td>
<td>50</td>
</tr>
</tbody>
</table>

Select the **Noise filter level** that will be applied to your video before encoding. Increasing the noise filter level reduces the amount of high frequencies in your source video by softening the high-detail portions of your video. Since high frequencies require more bits to encode, increasing the noise filter level leaves more bits available for the encoding of other frames, which can improve the overall quality of your encoded video. However, if you lose too much detail in your encoded video you may need to decrease the noise filter level.

6 Click **OK** to save and close the **Matrox MAX H.264 Codec Settings** dialog.

7 In the **Export Settings** dialog, in the **Video** pane, under **Bitrate Settings**, enable the **Limit data rate to** option and enter a value if you’re using the CAVLC entropy coding algorithm (see step 5). If using CABAC, you can enable or disable this option.

8 For optimal results when encoding using the Matrox MAX H.264 codec, in the **Video** pane, under **Basic Video Settings**, select **Progressive** from the **Field Order** list.

9 Specify any other export settings as desired. For detailed information on Media Encoder settings, see your Media Encoder documentation.

**Note** To export a clip for use with Apple iPad, iPod or iPhone devices, you must select **AAC** as the **Audio Codec**.

10 In the **Export Settings** dialog, under **Export Settings**, click the **Save Preset** button next to the **Preset** list.

11 Type a descriptive name for your preset, and then click **OK**.

12 Export the file as you would normally.
Using Telestream Episode

This section details how to specify Matrox MAX H.264 compression settings in Telestream Episode for delivering QuickTime files for the web, and for use with Apple TV, iPad, iPod, iPhone, and other QuickTime-based devices. The encoded file’s extension will be .mov.

1. Start Telestream Episode, drag the source file that you want to encode, and an encoder preset, to the Workflow Panel.

2. Click the encoder preset in the Workflow Panel, and then in the Inspector Panel, type a descriptive name in the Task Name text box.

3. In the Inspector Panel, under Format, select MOV for the Container, and QuickTime for the Video Codec. The Compression Settings window appears. If not, highlight Video Codec, and then click Options.

4. In the Compression Settings dialog, select Matrox MAX H.264 from the Compression type menu.

5. Under Motion, select your desired settings as explained in your Telestream Episode documentation.
Remarks

- If using the CAVLC entropy coding algorithm (see step 7), you must enable Limit data rate to and type a value. If using CABAC, you can enable or disable this option.

- The Limit data rate to option applies to the video portion of your encoded file only. When factoring in the encoded audio, the overall data rate for your encoded file may exceed the specified data rate limit. To minimize the impact of the audio on the overall data rate, select AAC or AAC QuickTime as the Audio Codec in the Inspector Panel.

6 Under Compressor, set the Quality level for your encoded video. Your desired quality is delivered on each frame at the lowest data rate possible, depending on the complexity of the video.

7 Select the entropy coding Algorithm to be used during compression:

- CABAC Uses the CABAC coding method, and defines the video stream as H.264 Main profile.

- CAVLC Uses the CAVLC coding method, and defines the video stream as H.264 Main profile when Frame Reordering is selected. Otherwise, the video stream is defined as H.264 Baseline profile.

   Note CAVLC is not supported when encoding to a frame size that has a width greater than 720. In this case, CABAC will always be used for encoding.

8 If your source video is interlaced and you want to de-interlace your video before encoding, select De-interlace video. This option can be used to display your encoded video on a monitor that displays lines progressively, such as an LCD or computer monitor. For all other instances, make sure this option is not selected.

   Important If your interlaced video is being scaled, either because you applied an effect in your project or specified a different frame size for export (see step 12), don’t use this option. Instead, use the Deinterlace option under Video Filters in the Inspector Panel to de-interlace your video.

9 Select the H.264 level that you want to be used to encode your video.

<table>
<thead>
<tr>
<th>H.264 level</th>
<th>Maximum Frame size</th>
<th>Maximum Frame rate (fps)</th>
<th>Maximum Data rate (Mb/s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0</td>
<td>352×288</td>
<td>29.97</td>
<td>2</td>
</tr>
<tr>
<td>3.0</td>
<td>720×576</td>
<td>29.97</td>
<td>10</td>
</tr>
<tr>
<td>3.1</td>
<td>1280×720</td>
<td>29.97</td>
<td>14</td>
</tr>
<tr>
<td>4.0</td>
<td>1920×1080</td>
<td>29.97</td>
<td>20</td>
</tr>
<tr>
<td>4.1</td>
<td>1920×1080</td>
<td>29.97</td>
<td>50</td>
</tr>
</tbody>
</table>
Select the Noise filter level that will be applied to your video before encoding. Increasing the noise filter level reduces the amount of high frequencies in your source video by softening the high-detail portions of your video. Since high frequencies require more bits to encode, increasing the noise filter level leaves more bits available for the encoding of other frames, which can improve the overall quality of your encoded video. However, if you lose too much detail in your encoded video you may need to decrease the noise filter level.

Click OK.

If you want to scale your source video for export, specify the new frame size in the Resize option under Video Filters in the Inspector Panel.

The minimum frame size is 64×64, and the maximum frame size depends on the H.264 level selected in step 9. The horizontal and vertical values must be even numbers.

Set your desired audio settings. To export a clip for use with Apple iPad, iPod or iPhone devices, you must select AAC or AAC QuickTime as the Audio Codec in the Inspector Panel.

Drag a deployment location to the Workflow Panel, and encode the file as you would normally.

### H.264 level
<table>
<thead>
<tr>
<th>Maximum Frame size</th>
<th>Maximum Frame rate (fps)</th>
<th>Maximum Data rate (Mb/s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.2</td>
<td>1920×1080</td>
<td>59.94</td>
</tr>
</tbody>
</table>

Note Use H.264 level 3.1 to create HD video for use with Apple iPad.
Using Avid Media Composer or Symphony

This section details how to specify the Matrox MAX H.264 compression settings in Avid Media Composer and Avid Symphony for delivering QuickTime files for the web and mobile devices. The encoded file’s extension will be .mov.

1. Open Avid Media Composer/Symphony, and open the project that you want to export.
2. Choose File > Export.
3. In the Export As dialog, select Untitled from the Export setting list, and then click Options.
4. In the Export Settings dialog, select QuickTime Movie from the Export As list.

5. Select Custom, and then click Format Options.
6 In the **Movie Settings** dialog, under **Video**, click **Settings**.

7 From the **Compression Type** menu, select **Matrox MAX H.264**.

8 Under **Motion** and **Data Rate**, select your desired settings as explained in your Avid documentation.

Chapter 10, Using the Matrox MAX H.264 Codec
Remarks

- If using the CABAC entropy coding algorithm (see step 10), you can use either the **Automatic** or **Restrict to** data rate option. If using CAVLC, you must use the **Restrict to** data rate option.

- The **Restrict to** data rate option applies to the video portion of your encoded file only. When factoring in the encoded audio, the overall data rate for your encoded file may exceed the specified data rate limit. To minimize the impact of the audio on the overall data rate, select AAC as the audio format for your encoded file (see step 15).

9 Under **Compressor**, if **Automatic** was selected as the **Data Rate**, set the **Quality** level for your encoded video. Your video is compressed at the specified quality setting with no regard to data rate. Your desired quality is delivered on each frame at the lowest data rate possible, depending on the complexity of the video.

10 Select the entropy coding **Algorithm** to be used during compression:

- **CABAC** Uses the CABAC coding method, and defines the video stream as H.264 Main profile.

- **CAVLC** Uses the CAVLC coding method, and defines the video stream as H.264 Main profile when **Frame Reordering** is selected. Otherwise, the video stream is defined as H.264 Baseline profile.

  **Note** CAVLC is not supported when encoding to a frame size that has a width greater than 720. In this case, CABAC will always be used for encoding.

11 If your source video is interlaced and you want to de-interlace your video before encoding, select **De-interlace video**. This option can be used to display your encoded video on a monitor that displays lines progressively, such as an LCD or computer monitor. For all other instances, make sure this option is not selected.

  **Important** If your interlaced video is being scaled, either because you applied an effect in your project or specified a different compression frame size, don’t use this option. Instead, use the **Deinterlace Source Video** option in the **Export Size Setup** window to de-interlace your video. You’ll be able to do this when specifying the frame size for your encoded video in step 16.

12 Select the **H.264 level** that you want to be used to encode your video.

<table>
<thead>
<tr>
<th>H.264 level</th>
<th>Maximum Frame size</th>
<th>Maximum Frame rate (fps)</th>
<th>Maximum Data rate (Mb/s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0</td>
<td>352×288</td>
<td>29.97</td>
<td>2</td>
</tr>
<tr>
<td>3.0</td>
<td>720×576</td>
<td>29.97</td>
<td>10</td>
</tr>
</tbody>
</table>

Using Avid Media Composer or Symphony
Chapter 10, Using the Matrox MAX H.264 Codec

<table>
<thead>
<tr>
<th>H.264 level</th>
<th>Maximum Frame size</th>
<th>Maximum Frame rate (fps)</th>
<th>Maximum Data rate (Mb/s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1</td>
<td>1280×720</td>
<td>29.97</td>
<td>14</td>
</tr>
<tr>
<td>4.0</td>
<td>1920×1080</td>
<td>29.97</td>
<td>20</td>
</tr>
<tr>
<td>4.1</td>
<td>1920×1080</td>
<td>29.97</td>
<td>50</td>
</tr>
<tr>
<td>4.2</td>
<td>1920×1080</td>
<td>59.94</td>
<td>50</td>
</tr>
</tbody>
</table>

**Note** Use H.264 level 3.1 to create HD video for use with Apple iPad.

13 Select the **Noise filter level** that will be applied to your video before encoding. Increasing the noise filter level reduces the amount of high frequencies in your source video by softening the high-detail portions of your video. Since high frequencies require more bits to encode, increasing the noise filter level leaves more bits available for the encoding of other frames, which can improve the overall quality of your encoded video. However, if you lose too much detail in your encoded video you may need to decrease the noise filter level.

14 Click **OK**.

15 In the **Movie Settings** dialog, under **Sound**, click **Settings** to specify your audio settings, and then click **OK**.

**Remarks**
- When limiting the data rate of your encoded file to a specified bit rate (see step 8), please note that the encoded audio may cause the overall data rate to exceed the data rate limit. To minimize the impact of the encoded audio on the overall data rate, select AAC as the audio format for your encoded file. To do this, in the **Sound Settings** window, select **AAC** from the **Format** list.
- To export a clip for use with Apple iPod or iPhone devices, you must choose AAC (advanced audio coding) as your export audio file format. To do this, in the **Sound Settings** window, select **AAC** from the **Format** list.

16 In the **Movie Settings** dialog, click **Size** and select the frame size that you want for your encoded video from the **Dimensions** menu.

**Note** The minimum frame size is 64×64, and the maximum frame size depends on the H.264 level selected in step 12. The horizontal and vertical values must be even numbers.

17 Once all settings are specified, click **OK** in the **Movie Settings** window.

18 Click **Save** in the **Export Settings** dialog, and then click **Save** in the **Export As** window to encode your video.
Using Apple QuickTime Pro, and other QuickTime-based applications

This section details how to specify Matrox MAX H.264 compression settings in QuickTime Pro v7.6.x for delivering QuickTime files for the web, and for use with Apple TV, iPad, iPod, iPhone, and other QuickTime-based devices. The encoded file’s extension will be *.mov*. The settings described in this section are the same when exporting to QuickTime from other QuickTime-based video applications. For details on how to export to QuickTime from another QuickTime-based application, see your application’s documentation.

1. Start QuickTime Pro, and open the video file that you want to export.
2. Choose File > Export.
3. In the Save exported file as window, click Options.
4. In the Movie Settings dialog, under Video, click Settings.

5. From the Compression Type menu, select Matrox MAX H.264.
6. Under Motion and Data Rate, select your desired settings as explained in your application’s documentation.

Remarks
- If using the CABAC entropy coding algorithm (see step 8), you can use either the Automatic or Restrict to data rate option. If using CAVLC, you must use the Restrict to data rate option.

Using Apple QuickTime Pro, and other QuickTime-based applications
Chapter 10, Using the Matrox MAX H.264 Codec

7 Under **Compressor**, set the **Quality** level for your encoded video. Your desired quality is delivered on each frame at the lowest data rate possible, depending on the complexity of the video.

8 Select the entropy coding **Algorithm** to be used during compression:

   - **CABAC**  Uses the CABAC coding method, and defines the video stream as H.264 Main profile.

   - **CAVLC**  Uses the CAVLC coding method, and defines the video stream as H.264 Main profile when **Frame Reordering** is selected. Otherwise, the video stream is defined as H.264 Baseline profile.

   **Note**  CAVLC is not supported when encoding to a frame size that has a width greater than 720. In this case, CABAC will always be used for encoding.

9 If your source video is interlaced and you want to de-interlace your video before encoding, select **De-interlace video**. This option can be used to display your encoded video on a monitor that displays lines progressively, such as an LCD or computer monitor. For all other instances, make sure this option is not selected.

   **Important**  If your interlaced video is being scaled, either because you applied an effect in your project or specified a different compression frame size, don’t use this option. Instead, use the **Deinterlace Source Video** option in the **Export Size Setup** window to de-interlace your video. You’ll be able to do this when specifying the frame size for your encoded video in step 14.

10 Select the **H.264 level** that you want to be used to encode your video.

<table>
<thead>
<tr>
<th>H.264 level</th>
<th>Maximum Frame size</th>
<th>Maximum Frame rate (fps)</th>
<th>Maximum Data rate (Mb/s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0</td>
<td>352×288</td>
<td>29.97</td>
<td>2</td>
</tr>
<tr>
<td>3.0</td>
<td>720×576</td>
<td>29.97</td>
<td>10</td>
</tr>
<tr>
<td>3.1</td>
<td>1280×720</td>
<td>29.97</td>
<td>14</td>
</tr>
<tr>
<td>4.0</td>
<td>1920×1080</td>
<td>29.97</td>
<td>20</td>
</tr>
<tr>
<td>4.1</td>
<td>1920×1080</td>
<td>29.97</td>
<td>50</td>
</tr>
<tr>
<td>4.2</td>
<td>1920×1080</td>
<td>59.94</td>
<td>50</td>
</tr>
</tbody>
</table>
Using Apple QuickTime Pro, and other QuickTime-based applications

Note  Use H.264 level 3.1 to create HD video for use with Apple iPad.

11 Select the Noise filter level that will be applied to your video before encoding. Increasing the noise filter level reduces the amount of high frequencies in your source video by softening the high-detail portions of your video. Since high frequencies require more bits to encode, increasing the noise filter level leaves more bits available for the encoding of other frames, which can improve the overall quality of your encoded video. However, if you lose too much detail in your encoded video you may need to decrease the noise filter level.

12 Click OK.

13 In the Movie Settings dialog, under Sound, click Settings to specify your audio settings, and then click OK.

Remarks
- When limiting the data rate of your encoded file to a specified bit rate (see step 6), please note that the encoded audio may cause the overall data rate to exceed the data rate limit. To minimize the impact of the encoded audio on the overall data rate, select AAC as the audio format for your encoded file. To do this, in the Sound Settings window, select AAC from the Format list.

- To export a clip for use with Apple iPad, iPod or iPhone devices, you must choose AAC (advanced audio coding) as your export audio file format. To do this, in the Sound Settings window, select AAC from the Format list.

14 In the Movie Settings dialog, click Size and select the frame size that you want for your encoded video from the Dimensions menu.

Note  The minimum frame size is 64×64, and the maximum frame size depends on the H.264 level selected in step 10. The horizontal and vertical values must be even numbers.

15 Once all settings are specified, click OK, and then Save in the Save exported file as window to encode your video.
Your notes
Understanding Pulldown

This appendix describes MXO2 pulldown.
Overview

Depending on your project’s video output format, you may choose to apply a pulldown to convert 23.98 fps video to 29.97 fps or 59.94 fps video for output on MXO2 (see Appendix D, “Matrox MXO2 Supported Output Formats”). If you choose to enable Pulldown in the Video Output pane of the Matrox preferences window (see Chapter 7, “Configuring Your MXO2 System”), Matrox uses the standard pulldown method to convert 23.98 fps to 29.97 fps or 59.94 fps video.

Standard pulldown

Standard pulldown is often used as part of the telecine process to transfer 24 fps film footage to 29.97 fps interlaced video. This pulldown method is also used to convert any 23.98 fps progressive video to 29.97 fps interlaced video, such as for converting 486p @ 23.98 fps video to NTSC.

In order to convert 24 fps film or 23.98 progressive video to 29.97 fps interlaced video, additional video frames, and more specifically video fields, must be created and added to the video sequence. For example, to convert a sequence of four film or progressive frames, five frames of video are needed for a total of 10 video fields. Therefore, one additional video frame or two video fields must be created. To accomplish this, the first and third frames of a four-frame film or progressive video sequence are each converted to two video fields. The second and fourth frames of the sequence are converted to three video fields to make up a total of five interlaced video frames.

The following diagram demonstrates the process:

```

Film frames @ 24 fps or progressive frames @ 23.98 fps

A   B   C   D

Video fields @ 29.97 fps

a1   a2   b1   b2   b3   c1   c2   d1   d2   d3

Frame A   Frame B   Frame C   Frame D   Frame E
```

Standard pulldown is accomplished by representing the first frame of film or progressive video (frame A) as two fields of video (fields a1 and a2), the second frame (frame B) as three fields of video (fields b1, b2, and b3), the third frame...
(frame C) as two fields (fields c1 and c2), and the fourth frame (frame D) as three fields (fields d1, d2, and d3). This sequence repeats six times each second.
Matrox MXO2 Connectors

This appendix describes the inputs and outputs for MXO2, MXO2 Rack, MXO2 LE, and MXO2 Mini.
Appendix B, Matrox MXO2 Connectors
Matrox MXO2 Rack
(partial view)

Inputs

MXO2 Rack inputs

AES/EBU digital audio
CH 1/2

HDMI
(HD only)

Y/C
(S-Video)

External reference
(REF)

Composite video

Composite video

RS422
(see "MXO2 Rack
RS-422 serial
connection" on
page 28)

Analog audio
(balanced)

AES/EBU digital audio
CH 3/4

 AES/EBU

SDI
(HD/SD)

CH 2

CH 3

CH 4

IN OUT

IN OUT

Component video

(Ref/Out)

Power
(see "Powering
MXO2 Rack" on
page 24)

Host
(see "Connecting
MXO2/Rack to your
Mac system" on
page 25)

100 - 240 VAC – 40/60Hz
25 VA MAX

RS422

AES/EBU
digital audio
CH 1/2

AES/EBU
digital audio
CH 3/4

HDMI

(Y)

Pb

Pr

SDI

(Ref/Out)

(Ref/Out)

Host

(Host)

CH 1

CH 2

CH 3

CH 4

Analog audio

(AES/EBU)

(S-Video)

HDMI

(Ref)

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Ref

Re
## MXO2 LE inputs

<table>
<thead>
<tr>
<th>Component</th>
<th>Video (HD/SD)</th>
<th>Analog Audio (unbalanced)</th>
<th>External Reference (REF)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Composite video</td>
<td>Y/C (S-Video)</td>
<td>L (CH 1)</td>
<td></td>
</tr>
<tr>
<td>HDMI</td>
<td>Y/D</td>
<td>R (CH 2)</td>
<td></td>
</tr>
<tr>
<td>YPb</td>
<td>Pr</td>
<td>Analog audio</td>
<td></td>
</tr>
<tr>
<td>Component video</td>
<td>Pb</td>
<td>Analog audio (balanced)</td>
<td></td>
</tr>
</tbody>
</table>

**Matrox MXO2 LE**

- **CH 1**: Analog audio (balanced)
- **CH 2**: Analog audio (unbalanced)
- HDMI (HD/SD)
- Y/C (S-Video)
- Component video (HD/SD)
- SDI (HD/SD)

---

**Appendix B, Matrox MXO2 Connectors**
MXO2 Mini inputs

Composite video (CVBS) Y

S-Video (HD only)
Pb (Y) Pr (C)

HDMI

Component video (HD/SD)
Y Pb Pr (CH 1) Pr (CH 2)

Analog audio (unbalanced)
L R

Power (see "Powering MXO2 Mini" on page 42)

Host (see "Connecting MXO2 Mini to your computer" on page 44)

Matrox MXO2 Mini

Inputs
Input connector descriptions

This section describes the Matrox MXO2, MXO2 Rack, and MXO2 LE inputs. For MXO2 Mini inputs, see “Input connector descriptions (MXO2 Mini)” on page 162.

You can select the video and audio inputs to be used as your capture source in the MXO2 preferences window (see “Specifying your A/V input settings” on page 55). For a list of the supported input and capture formats, see Appendix C, “Matrox MXO2 Supported Input and Capture Formats.”

**Note** Depending on your MXO2 hardware, some of the following connectors may not be available or may be available in a limited capacity only. Some connectors on your MXO2 hardware may not appear exactly as shown below.

**External reference (REF)** Allows you to genlock all devices connected to your MXO2 system to an external genlock source (bi-level analog black burst for SD, or analog tri-level sync for HD). MXO2 Rack features an additional REF OUT connector with loop through that allows you to daisy chain the genlock reference input to another device’s reference input.

**Important** If you connected an external genlock source to MXO2 Rack’s REF IN connector, and you're not using the REF OUT connector, you must terminate the reference signal by connecting a BNC 75-ohm terminator to REF OUT.

To compensate for cable delays, timing-offset controls that align your video output relative to your external genlock source are available (see “Specifying your genlock settings” on page 54).

**HDMI** Provides an input for HD HDMI video (either YUV or RGB), and up to eight channels of uncompressed embedded audio, from a digital HDMI device. HDCP sources and SD video are not supported on this input. Connect a standard HDMI video/audio cable from a camera, VTR, or other video input source.
SDI  Provides an input for use with a digital SDI device. This input supports HD-SDI and SD-SDI video, and up to 16 channels of embedded audio. You can also use this input to capture closed captioning and AFD data (see “Matrox 4VANC capture and playback” on page 66). Connect an SDI video/audio cable from a camera, VTR, or other video input source.

Component video (Y, Pb, Pr)  Provide inputs for use with an analog component device, and support HD and SD video. Connect component Y, Pb, Pr video cables from a camera, VTR, or other video input source.

Y/C (S-Video)  Provides an input for use with an analog S-Video device (SD only). Connect an S-Video cable from a camera, VTR, or other video input source.

Composite video (CVBS)  Allows you to input SD video from an analog NTSC or PAL device. Connect a composite video cable from a camera, VTR, or other video input source.

AES/EBU digital audio  Allows you to input stereo digital audio. Connect a coaxial BNC audio cable from a camera, VTR, audio mixer, or other audio input source.

Note  Not available on MXO2 LE.

Analog audio (balanced)  Allows you to input balanced stereo analog audio. Connect XLR cables from a camera, VTR, audio mixer, or other audio input source.

Analog audio (unbalanced)  Allows you to input unbalanced stereo analog audio. Connect RCA cables from a camera, VTR, audio mixer, or other audio input source.
Input connector descriptions (MXO2 Mini)

This section describes the Matrox MXO2 Mini inputs. For other MXO2 products, see “Input connector descriptions” on page 160.

You can select the video and audio inputs to be used as your capture source in the MXO2 Mini preferences window (see “Specifying your video output settings” on page 58). For a list of the supported input and capture formats, see Appendix C, “Matrox MXO2 Supported Input and Capture Formats.”

Note Analog A/V cables connected to Matrox MXO2 Mini must be limited to less than three meters to comply with EEC and EMC directives.

- **HDMI** Provides an input for HD HDMI video (either YUV or RGB), and up to eight channels of uncompressed embedded audio, from a digital HDMI device. HDCP sources and SD video are not supported on this input. Connect a standard HDMI video/audio cable from a camera, VTR, or other video input source.

- **Component video (Y, Pb, Pr)** Provide inputs for use with an analog component device, and support HD and SD video. Connect component Y, Pb, Pr video cables from a camera, VTR, or other video input source.
  
  Note When you connect an analog component device to MXO2 Mini, you won’t be able to connect an S-Video or composite device at the same time.

- **S-Video** Input connectors Pb and Pr allow you to connect the MXO2 S-Video adapter cable for use with an analog S-Video device (SD only). Connect an S-Video cable, via the MXO2 S-Video adapter cable, from a camera, VTR, or other video input source. For an illustration on how to connect S-Video devices to MXO2 Mini, see “Connecting S-Video devices to MXO2 Mini” on page 47.

- **Composite video (Y)** Allows you to input SD video from an analog NTSC or PAL device. Connect a composite video cable from a camera, VTR, or other video input source.

- **Analog audio (unbalanced)** Allows you to input unbalanced stereo analog audio. Connect RCA cables from a camera, VTR, audio mixer, or other audio input source.
The following sections detail the MXO2, MXO2 Rack, MXO2 LE, and MXO2 Mini outputs.

**MXO2 outputs**
MXO2 Rack outputs

Appendix B, Matrox MXO2 Connectors
MXO2 LE outputs

Outputs
Appendix B, Matrox MXO2 Connectors

MXO2 Mini outputs

Matrox MXO2 Mini

- Component video (HD/SD) (Y, Pb, Pr)
- Analog audio (unbalanced) (L (CH 1), R (CH 2))
- S-Video (see "Connecting S-Video devices to MXO2 Mini" on page 47)
- Composite video (CVBS) (Y, Pb, Pr)
- HDMI (HD/SD) (Host)
- Power (see "Powering MXO2 Mini" on page 42)
Output connector descriptions

This section describes the Matrox MXO2, MXO2 Rack, and MXO2 LE outputs. For MXO2 Mini outputs, see “Output connector descriptions (MXO2 Mini)” on page 169.

HD to SD downscaling, SD to HD upscaling, and cross conversion are supported on all video outputs simultaneously. To select your video output settings, see “Specifying your video output settings” on page 58. You can also map any audio track in your video application to any MXO2 audio output (see “Specifying your audio output settings” on page 62). For a list of the video formats that you can output from the MXO2 outputs, see “Video formats supported on MXO2 outputs” on page 182.

Note Depending on your MXO2 hardware, some of the following connectors may not be available or may be available in a limited capacity only. Some connectors on your MXO2 hardware may not appear exactly as shown below.

HDMI Provides an output for HD/SD HDMI video, and up to eight channels of embedded audio, to a digital HDMI device. HDCP is not supported on this output. This output supports 1:1 pixel mapping for accurate monitoring on your HDMI display of NTSC, PAL, 1280×720, and 1920×1080 video. Connect a standard HDMI video/audio cable to an HDMI monitor, VTR, or other digital HDMI device. You can also connect directly to a home theatre system for surround sound monitoring.

Note The HDMI output supports YUV and RGB devices. To set the HDMI output type, see “Specifying your video output settings” on page 58.

HDMI monitor calibration is available through this output. Use the Matrox HDMI Calibration Utility to calibrate your HDMI monitor (see Chapter 8, “Calibrating Your HDMI Monitor for Video”).

167
SDI A and SDI B  Provide two simultaneous outputs of the same HD-SDI or SD-SDI video, with up to 16 channels of embedded audio. You can also output closed captioning and AFD data using the SDI outputs (see “Matrox 4VANC capture and playback” on page 66). For each output, connect an SDI video/audio cable to a video monitor, VTR, or other SDI device. You can also perform surround sound monitoring through the SDI output by connecting to a third-party device, such as an SDI audio de-embedder.

Component video (Y, Pb, Pr)  Allows you to output HD or SD video to an analog component device. Connect component Y, Pb, Pr video cables to a video monitor, VTR, or other component device.

**Note**  The component output supports YUV and RGB devices. To set the component output type, see “Specifying your video output settings” on page 58.

Y/C (S-Video)  Provides an output for SD video to an analog S-Video device. Connect an S-Video cable to a video monitor, VTR, or other S-Video device.

Composite video (CVBS)  Allows you to output SD video to an analog NTSC or PAL device. Connect a composite video cable to a video monitor, VTR, or other NTSC or PAL device.

AES/EBU digital audio  Allows you to output stereo digital audio. Connect a coaxial BNC audio cable to a VTR, audio mixer, speakers, or other audio device.

**Note**  Not available on MXO2 LE.

Analog audio (balanced)  Allows you to output balanced stereo analog audio. Connect XLR cables to a VTR, audio mixer, speakers, or other audio device.

Appendix B, Matrox MXO2 Connectors
Analog audio (unbalanced)  Provide outputs for unbalanced analog audio. Matrox MXO2 offers outputs for channels one to six, or three stereo pairs suitable for 5.1 surround sound monitoring. Connect RCA cables to a VTR, audio mixer, speakers, or other audio device.

Output connector descriptions (MXO2 Mini)
This section describes the Matrox MXO2 Mini outputs. For other MXO2 products, see “Output connector descriptions” on page 167.

HD to SD downscaling, SD to HD upscaling, and cross conversion are supported on all video outputs simultaneously. To select your video output settings, see “Specifying your video output settings” on page 58. You can also map any audio track in your video application to any MXO2 Mini audio output (see “Specifying your audio output settings” on page 62). For a list of the video formats that you can output from the MXO2 Mini outputs, see “Video formats supported on MXO2 outputs” on page 182.

Note  Analog A/V cables connected to Matrox MXO2 Mini must be limited to less than three meters to comply with EEC and EMC directives.

HDMI  Provides an output for HD/SD HDMI video, and up to eight channels of embedded audio, to a digital HDMI device. HDCP is not supported on this output. This output supports 1:1 pixel mapping for accurate monitoring on your HDMI display of NTSC, PAL, 1280×720, and 1920×1080 video. Connect a standard HDMI video/audio cable to an HDMI monitor, VTR, or other digital HDMI device. You can also connect directly to a home theatre system for surround sound monitoring.

Note  The HDMI output supports YUV and RGB devices.

HDMI monitor calibration is available through this output. Use the Matrox HDMI Calibration Utility to calibrate your HDMI monitor (see Chapter 8, “Calibrating Your HDMI Monitor for Video”).

Note  HDMI
**Component video (Y, Pb, Pr)**  Allows you to output HD or SD video to an analog component device. Connect component Y, Pb, Pr video cables to a video monitor, VTR, or other component device.

- **Note**  The component output supports YUV devices only. When you connect an analog component device to MXO2 Mini, you won’t be able to connect an S-Video or composite device at the same time.

**S-Video**  Output connectors Pb and Pr allow you to connect the MXO2 S-Video adapter cable for outputting SD video to an analog S-Video device. Connect an S-Video cable, via the MXO2 S-Video adapter cable, to a video monitor, VTR, or other S-Video device. For instructions on how to connect S-Video devices to MXO2 Mini, see “Connecting S-Video devices to MXO2 Mini” on page 47.

**Composite video (Y)**  Allows you to output SD video to an analog NTSC or PAL device. Connect a composite video cable to a video monitor, VTR, or other NTSC or PAL device.

**Analog audio (unbalanced)**  Provide outputs for unbalanced analog audio channels one and two, or one stereo pair. Connect RCA cables to a VTR, audio mixer, speakers, or other audio device.
Matrox MXO2 Supported Input and Capture Formats

This appendix provides information on the video input and capture formats that are supported on all MXO2 products.
Supported input formats

The following tables list the video formats that are supported on the various MXO2 inputs.

For descriptions of the inputs, see “Inputs” on page 156, and for a list of the supported capture formats, see “Supported capture formats” on page 174.

### Matrox MXO2, MXO2 Rack, and MXO2 LE

<table>
<thead>
<tr>
<th>Source video format</th>
<th>HDMI</th>
<th>SDI</th>
<th>Component (Y, Pb, Pr)</th>
<th>S-Video (Y/C)</th>
<th>Composite (CVBS)</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>PAL</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>NTSC 16:9</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>PAL 16:9</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>720p at 50 fps</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>720p at 59.94 fps</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080i at 25 fps</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080i at 29.97 fps</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080PsF at 23.98 fps</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080PsF at 25 fps</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080PsF at 29.97 fps</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080p at 23.98 fps</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080p at 24 fps</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080p at 25 fps</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080p at 29.97 fps</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080p at 30 fps</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>
# Supported input formats

<table>
<thead>
<tr>
<th>Source video format</th>
<th>HDMI</th>
<th>Component (Y, Pb, Pr)</th>
<th>S-Video (Pb, Pr)</th>
<th>Composite (Y)</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>PAL</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>NTSC 16:9</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>PAL 16:9</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>720p at 50 fps</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>720p at 59.94 fps</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080i at 25 fps</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080i at 29.97 fps</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080PsF at 23.98 fps</td>
<td>—</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080PsF at 25 fps</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080PsF at 29.97 fps</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080p at 23.98 fps</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080p at 24 fps</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080p at 25 fps</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080p at 29.97 fps</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080p at 30 fps</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>
### Supported capture formats

The following table lists the capture formats that are supported on MXO2 based on the format of your source video. If the format to which you want to capture does not match the format of your source video, you must enable scaling on the input. For a list of the video formats that are supported on the Matrox MXO2 inputs, see “Supported input formats” on page 172.

#### Avid Media Composer/Symphony

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>PAL</td>
<td>—</td>
<td>—</td>
<td>✔</td>
<td>✔</td>
<td>—</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>NTSC 16:9</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>PAL 16:9</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>720p at 50 fps</td>
<td>—</td>
<td>—</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>720p at 59.94 fps</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>1080i at 25 fps</td>
<td>—</td>
<td>—</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>1080i at 29.97 fps</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>1080iPsF at 23.98 fps</td>
<td>—</td>
<td>—</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>1080iPsF at 25 fps</td>
<td>—</td>
<td>—</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>1080iPsF at 29.97 fps</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>1080p at 23.98 fps</td>
<td>—</td>
<td>—</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>1080p at 24 fps</td>
<td>—</td>
<td>—</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>1080p at 25 fps</td>
<td>—</td>
<td>—</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>1080p at 29.97 fps</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>

1 You must enable Scale input for capture in the Matrox Utilities preferences window (see “Specifying your A/V input settings” on page 23).
## Supported capture formats

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>PAL</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>NTSC 16:9</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>PAL 16:9</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>720p at 50 fps</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>720p at 59.94 fps</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080i at 25 fps</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080i at 29.97 fps</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080PsF at 23.98 fps</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080PsF at 25 fps</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080PsF at 29.97 fps</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

1 You must enable Scale input for capture in the A/V Input pane of the Matrox Utilities preferences window (see Chapter 7, “Configuring Your MXO2 System”).
Appendix C, Matrox MXO2 Supported Input and Capture Formats
Matrox MXO2 Supported Output Formats

This appendix provides information on the video output formats that are available on the MXO2 main and SD channels, and the video formats that are supported on the MXO2 outputs.
Supported main and SD video output formats

This section lists the video output formats that are available on the MXO2 main and SD channels based on your project’s video format. You can specify the main and SD channel settings on the Video Output pane of the Matrox Utilities preferences window (see Chapter 7, “Configuring Your MXO2 System”).

### Apple Final Cut Pro X, Adobe Premiere Pro, Prelude, and Encore

<table>
<thead>
<tr>
<th>Project’s video format¹,²</th>
<th>Follow application</th>
<th>Main channel output</th>
<th>SD channel output³,⁴</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC (720×486i)</td>
<td>NTSC</td>
<td>720×486p at 59.94 fps</td>
<td>1280×720p at 59.94 fps</td>
</tr>
<tr>
<td>NTSC 16:9 (720×486i)</td>
<td>NTSC 16:9</td>
<td>720×486p at 59.94 fps</td>
<td>1280×720p at 59.94 fps</td>
</tr>
<tr>
<td>PAL (720×576i)</td>
<td>PAL</td>
<td>720×576p at 50 fps</td>
<td>1280×720p at 50 fps</td>
</tr>
<tr>
<td>PAL 16:9 (720×576i)</td>
<td>PAL 16:9</td>
<td>720×576p at 50 fps</td>
<td>1280×720p at 50 fps</td>
</tr>
<tr>
<td>DV-NTSC (720×486i)</td>
<td>NTSC</td>
<td>720×486p at 59.94 fps</td>
<td>1280×720p at 59.94 fps</td>
</tr>
<tr>
<td>DV-NTSC 16:9 (720×486i)</td>
<td>NTSC 16:9</td>
<td>720×486p at 59.94 fps</td>
<td>1280×720p at 59.94 fps</td>
</tr>
<tr>
<td>DV-PAL (720×576i)</td>
<td>PAL</td>
<td>720×576p at 50 fps</td>
<td>1280×720p at 50 fps</td>
</tr>
<tr>
<td>DV-PAL 16:9 (720×576i)</td>
<td>PAL 16:9</td>
<td>720×576p at 50 fps</td>
<td>1280×720p at 50 fps</td>
</tr>
<tr>
<td>486p at 23.98 fps</td>
<td>720×486p at 59.94 fps</td>
<td>1280×720p at 59.94 fps</td>
<td>1920×1080PsF at 23.98 fps³</td>
</tr>
<tr>
<td>486p at 23.98 fps 16:9</td>
<td>720×486p at 59.94 fps</td>
<td>1280×720p at 59.94 fps</td>
<td>1920×1080PsF at 23.98 fps³</td>
</tr>
<tr>
<td>486p at 29.97 fps 16:9</td>
<td>720×486p at 59.94 fps</td>
<td>1280×720p at 59.94 fps</td>
<td>1920×1080PsF at 29.97 fps</td>
</tr>
<tr>
<td>486p at 29.97 fps 16:9</td>
<td>720×486p at 59.94 fps</td>
<td>1280×720p at 59.94 fps</td>
<td>1920×1080PsF at 29.97 fps</td>
</tr>
<tr>
<td>576p at 25 fps</td>
<td>720×576p at 50 fps</td>
<td>1280×720p at 50 fps</td>
<td>1920×1080PsF at 25 fps</td>
</tr>
<tr>
<td>576p at 25 fps 16:9</td>
<td>720×576p at 50 fps</td>
<td>1280×720p at 50 fps</td>
<td>1920×1080PsF at 25 fps</td>
</tr>
<tr>
<td>960×720p at 23.98 fps</td>
<td>1280×720p at 59.94 fps</td>
<td>1280×720p at 59.94 fps</td>
<td>1920×1080PsF at 23.98 fps³</td>
</tr>
<tr>
<td>960×720p at 25 fps</td>
<td>1280×720p at 50 fps</td>
<td>1280×720p at 50 fps</td>
<td>1920×1080PsF at 25 fps</td>
</tr>
</tbody>
</table>

Appendix D, Matrox MXO2 Supported Output Formats
<table>
<thead>
<tr>
<th>Project's video format</th>
<th>Follow application</th>
<th>486p/576p</th>
<th>720p</th>
<th>1080i/PsF</th>
<th>1080p</th>
<th>SD channel output</th>
</tr>
</thead>
<tbody>
<tr>
<td>960×720p at 29.97 fps</td>
<td>1280×720p at 59.94 fps</td>
<td>720×486p at 59.94 fps</td>
<td>1280×720p at 59.94 fps</td>
<td>1920×1080PsF at 29.97 fps</td>
<td>1920×1080p at 29.97 fps</td>
<td>720×486PsF at 29.97 fps</td>
</tr>
<tr>
<td>960×720p at 50 fps</td>
<td>1280×720p at 50 fps</td>
<td>720×576p at 50 fps</td>
<td>1280×720p at 50 fps</td>
<td>1920×1080i at 25 fps</td>
<td>1920×1080p at 25 fps</td>
<td>PAL</td>
</tr>
<tr>
<td>960×720p at 59.94 fps</td>
<td>1280×720p at 59.94 fps</td>
<td>720×486p at 59.94 fps</td>
<td>1280×720p at 59.94 fps</td>
<td>1920×1080i at 29.97 fps</td>
<td>1920×1080p at 29.97 fps</td>
<td>NTSC</td>
</tr>
<tr>
<td>1280×720p at 23.98 fps</td>
<td>1280×720p at 59.94 fps</td>
<td>720×486p at 59.94 fps</td>
<td>1280×720p at 59.94 fps</td>
<td>1920×1080PsF at 23.98 fps³</td>
<td>1920×1080p at 23.98 fps</td>
<td>NTSC</td>
</tr>
<tr>
<td>1280×720p at 25 fps</td>
<td>1280×720p at 50 fps</td>
<td>720×576p at 50 fps</td>
<td>1280×720p at 50 fps</td>
<td>1920×1080PsF at 25 fps</td>
<td>1920×1080p at 25 fps</td>
<td>720×576PsF at 25 fps</td>
</tr>
<tr>
<td>1280×720p at 29.97 fps</td>
<td>1280×720p at 59.94 fps</td>
<td>720×486p at 59.94 fps</td>
<td>1280×720p at 59.94 fps</td>
<td>1920×1080PsF at 29.97 fps</td>
<td>1920×1080p at 29.97 fps</td>
<td>720×486PsF at 29.97 fps</td>
</tr>
<tr>
<td>1280×720p at 50 fps</td>
<td>1280×720p at 50 fps</td>
<td>720×576p at 50 fps</td>
<td>1280×720p at 50 fps</td>
<td>1920×1080i at 25 fps</td>
<td>1920×1080p at 25 fps</td>
<td>PAL</td>
</tr>
<tr>
<td>1280×720p at 59.94 fps</td>
<td>1280×720p at 59.94 fps</td>
<td>720×486p at 59.94 fps</td>
<td>1280×720p at 59.94 fps</td>
<td>1920×1080i at 29.97 fps</td>
<td>1920×1080p at 29.97 fps</td>
<td>NTSC</td>
</tr>
<tr>
<td>1280×1080i at 29.97 fps</td>
<td>1280×1080i at 59.94 fps</td>
<td>720×486p at 59.94 fps</td>
<td>1280×720p at 59.94 fps</td>
<td>1920×1080i at 29.97 fps</td>
<td>1920×1080p at 29.97 fps</td>
<td>NTSC</td>
</tr>
<tr>
<td>1440×1080i at 25 fps</td>
<td>1440×1080i at 59.94 fps</td>
<td>720×486p at 59.94 fps</td>
<td>1280×720p at 59.94 fps</td>
<td>1920×1080i at 25 fps</td>
<td>1920×1080p at 25 fps</td>
<td>PAL</td>
</tr>
<tr>
<td>1440×1080i at 29.97 fps</td>
<td>1440×1080i at 59.94 fps</td>
<td>720×486p at 59.94 fps</td>
<td>1280×720p at 59.94 fps</td>
<td>1920×1080i at 29.97 fps</td>
<td>1920×1080p at 29.97 fps</td>
<td>NTSC</td>
</tr>
<tr>
<td>1920×1080i at 25 fps</td>
<td>1920×1080i at 59.94 fps</td>
<td>720×486p at 59.94 fps</td>
<td>1280×720p at 59.94 fps</td>
<td>1920×1080i at 25 fps</td>
<td>1920×1080p at 25 fps</td>
<td>PAL</td>
</tr>
<tr>
<td>1920×1080i at 29.97 fps</td>
<td>1920×1080i at 59.94 fps</td>
<td>720×486p at 59.94 fps</td>
<td>1280×720p at 59.94 fps</td>
<td>1920×1080i at 29.97 fps</td>
<td>1920×1080p at 29.97 fps</td>
<td>NTSC</td>
</tr>
<tr>
<td>1280×1080p at 23.98 fps</td>
<td>1280×1080p at 59.94 fps</td>
<td>720×486p at 59.94 fps</td>
<td>1280×720p at 59.94 fps</td>
<td>1920×1080PsF at 23.98 fps³</td>
<td>1920×1080p at 23.98 fps</td>
<td>NTSC</td>
</tr>
<tr>
<td>1440×1080p at 23.98 fps</td>
<td>1440×1080p at 59.94 fps</td>
<td>720×486p at 59.94 fps</td>
<td>1280×720p at 59.94 fps</td>
<td>1920×1080PsF at 23.98 fps³</td>
<td>1920×1080p at 23.98 fps</td>
<td>NTSC</td>
</tr>
<tr>
<td>1440×1080p at 24 fps</td>
<td>1440×1080p at 24 fps</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>1920×1080p at 24 fps</td>
<td>—</td>
</tr>
<tr>
<td>1440×1080p at 25 fps</td>
<td>1440×1080p at 25 fps</td>
<td>720×576p at 50 fps</td>
<td>1280×720p at 50 fps</td>
<td>1920×1080PsF at 25 fps</td>
<td>1920×1080p at 25 fps</td>
<td>720×576PsF at 25 fps</td>
</tr>
<tr>
<td>1440×1080p at 29.97 fps</td>
<td>1440×1080p at 29.97 fps</td>
<td>720×576p at 50 fps</td>
<td>1280×720p at 50 fps</td>
<td>1920×1080PsF at 29.97 fps</td>
<td>1920×1080p at 29.97 fps</td>
<td>720×486PsF at 29.97 fps</td>
</tr>
<tr>
<td>1440×1080p at 30 fps</td>
<td>1440×1080p at 30 fps</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>1920×1080p at 30 fps</td>
<td>—</td>
</tr>
<tr>
<td>1920×1080p at 23.98 fps</td>
<td>1920×1080p at 23.98 fps</td>
<td>720×486p at 59.94 fps</td>
<td>1280×720p at 59.94 fps</td>
<td>1920×1080PsF at 23.98 fps³</td>
<td>1920×1080p at 23.98 fps</td>
<td>NTSC</td>
</tr>
</tbody>
</table>

Supported main and SD video output formats
<table>
<thead>
<tr>
<th>Project’s video format¹,²</th>
<th>Follow application</th>
<th>486p/576p⁴</th>
<th>720p</th>
<th>1080i/PsF</th>
<th>1080p</th>
<th>SD channel output³,⁴</th>
</tr>
</thead>
<tbody>
<tr>
<td>1920×1080p at 24 fps</td>
<td>1920×1080p at 24 fps</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>1920×1080p at 24 fps</td>
<td>—</td>
</tr>
<tr>
<td>1920×1080p at 29.97 fps</td>
<td>1920×1080p at 29.97 fps</td>
<td>720×486p at 59.94 fps</td>
<td>1280×720p at 59.94 fps</td>
<td>1920×1080PsF at 29.97 fps</td>
<td>1920×1080p at 29.97 fps</td>
<td>720×486PsF at 29.97 fps</td>
</tr>
<tr>
<td>1920×1080p at 30 fps</td>
<td>1920×1080p at 30 fps</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>1920×1080p at 30 fps</td>
<td>—</td>
</tr>
<tr>
<td>RED 1K 2:1 at 23.98 fps (1024×512)</td>
<td>1080p at 23.98 fps</td>
<td>486p at 59.94 fps</td>
<td>720p at 59.94 fps</td>
<td>1920×1080PsF at 23.98 fps³</td>
<td>1920×1080p at 23.98 fps</td>
<td>NTSC</td>
</tr>
<tr>
<td>RED 1K 16:9 at 23.98 fps (1024×576)</td>
<td>1080p at 23.98 fps</td>
<td>486p at 59.94 fps</td>
<td>720p at 59.94 fps</td>
<td>1920×1080PsF at 23.98 fps³</td>
<td>1920×1080p at 23.98 fps</td>
<td>NTSC</td>
</tr>
<tr>
<td>RED 2K 2:1 at 23.98 fps (2048×1024)</td>
<td>1080p at 23.98 fps</td>
<td>486p at 59.94 fps</td>
<td>720p at 59.94 fps</td>
<td>1920×1080PsF at 23.98 fps³</td>
<td>1920×1080p at 23.98 fps</td>
<td>NTSC</td>
</tr>
<tr>
<td>RED 2K 16:9 at 23.98 fps (2048×1152)</td>
<td>1080p at 23.98 fps</td>
<td>486p at 59.94 fps</td>
<td>720p at 59.94 fps</td>
<td>1920×1080PsF at 23.98 fps³</td>
<td>1920×1080p at 23.98 fps</td>
<td>NTSC</td>
</tr>
<tr>
<td>RED 1K 2:1 at 25 fps (1024×512)</td>
<td>1080p at 25 fps</td>
<td>576p at 50 fps</td>
<td>720p at 50 fps</td>
<td>1920×1080PsF at 25 fps</td>
<td>1920×1080p at 25 fps</td>
<td>720×576PsF at 25 fps</td>
</tr>
<tr>
<td>RED 1K 16:9 at 25 fps (1024×576)</td>
<td>1080p at 25 fps</td>
<td>576p at 50 fps</td>
<td>720p at 50 fps</td>
<td>1920×1080PsF at 25 fps</td>
<td>1920×1080p at 25 fps</td>
<td>720×576PsF at 25 fps</td>
</tr>
<tr>
<td>RED 2K 2:1 at 25 fps (2048×1024)</td>
<td>1080p at 25 fps</td>
<td>576p at 50 fps</td>
<td>720p at 50 fps</td>
<td>1920×1080PsF at 25 fps</td>
<td>1920×1080p at 25 fps</td>
<td>720×576PsF at 25 fps</td>
</tr>
<tr>
<td>RED 2K 16:9 at 25 fps (2048×1152)</td>
<td>1080p at 25 fps</td>
<td>576p at 50 fps</td>
<td>720p at 50 fps</td>
<td>1920×1080PsF at 25 fps</td>
<td>1920×1080p at 25 fps</td>
<td>720×576PsF at 25 fps</td>
</tr>
</tbody>
</table>

¹ If working with a non-standard video broadcast format, the video is scaled to the closest video broadcast format.
² Some of the listed video formats may not be available in all the supported applications.
³ The SD channel is not supported and is output as black video when cross-converting your project’s video output between 720p and 1080p/i/PsF.
⁴ If your project’s aspect ratio is 16:9, set **Aspect ratio formatting** to **Anamorphic** in the **Video Output** pane of the **Matrox Utilities** preferences window to output as 16:9 (see Chapter 7, “Configuring Your MXO2 System”).
⁵ Enable **Pulldown** in the **Video Output** pane of the **Matrox Utilities** preferences window to output 1080i at 29.97 fps (see Chapter 7, “Configuring Your MXO2 System”).

**Appendix D, Matrox MXO2 Supported Output Formats**
## Supported main and SD video output formats

<table>
<thead>
<tr>
<th>Project’s video format</th>
<th>Follow application</th>
<th>Main channel output</th>
<th>1080i/PsF</th>
<th>1080p</th>
<th>SD channel output</th>
</tr>
</thead>
<tbody>
<tr>
<td>23.976p NTSC</td>
<td>NTSC</td>
<td>486p at 59.94 fps</td>
<td>720p at 59.94 fps</td>
<td>1080i at 29.97 fps</td>
<td>NTSC</td>
</tr>
<tr>
<td>23.976p NTSC 16:9</td>
<td>NTSC 16:9</td>
<td>486p at 59.94 fps</td>
<td>720p at 59.94 fps</td>
<td>1080i at 29.97 fps</td>
<td>NTSC</td>
</tr>
<tr>
<td>24p NTSC</td>
<td>NTSC</td>
<td>486p at 59.94 fps</td>
<td>720p at 59.94 fps</td>
<td>1080i at 29.97 fps</td>
<td>NTSC</td>
</tr>
<tr>
<td>24p NTSC 16:9</td>
<td>NTSC 16:9</td>
<td>486p at 59.94 fps</td>
<td>720p at 59.94 fps</td>
<td>1080i at 29.97 fps</td>
<td>NTSC</td>
</tr>
<tr>
<td>30p NTSC</td>
<td>NTSC</td>
<td>486p at 59.94 fps</td>
<td>720p at 59.94 fps</td>
<td>1080i at 29.97 fps</td>
<td>NTSC</td>
</tr>
<tr>
<td>30i NTSC 16:9</td>
<td>NTSC 16:9</td>
<td>486p at 59.94 fps</td>
<td>720p at 59.94 fps</td>
<td>1080i at 29.97 fps</td>
<td>NTSC</td>
</tr>
<tr>
<td>24p PAL</td>
<td>PAL</td>
<td>576p at 50 fps</td>
<td>720p at 50 fps</td>
<td>1080i at 25 fps</td>
<td>PAL</td>
</tr>
<tr>
<td>24p PAL 16:9</td>
<td>PAL 16:9</td>
<td>576p at 50 fps</td>
<td>720p at 50 fps</td>
<td>1080i at 25 fps</td>
<td>PAL</td>
</tr>
<tr>
<td>25p PAL</td>
<td>PAL</td>
<td>576p at 50 fps</td>
<td>720p at 50 fps</td>
<td>1080i at 25 fps</td>
<td>PAL</td>
</tr>
<tr>
<td>25i PAL</td>
<td>PAL</td>
<td>576p at 50 fps</td>
<td>720p at 50 fps</td>
<td>1080i at 25 fps</td>
<td>PAL</td>
</tr>
<tr>
<td>720p/23.976</td>
<td>720p at 59.94 fps</td>
<td>486p at 59.94 fps</td>
<td>720p at 59.94 fps</td>
<td>1080i/PsF at 23.98 fps</td>
<td>NTSC</td>
</tr>
<tr>
<td>720p/25</td>
<td>720p at 50 fps</td>
<td>576p at 50 fps</td>
<td>720p at 50 fps</td>
<td>1080i/PsF at 25 fps</td>
<td>576PSF at 25 fps</td>
</tr>
<tr>
<td>720p/29.97</td>
<td>720p at 59.94 fps</td>
<td>486p at 59.94 fps</td>
<td>720p at 59.94 fps</td>
<td>1080i/PsF at 29.97 fps</td>
<td>486PSF at 29.97 fps</td>
</tr>
<tr>
<td>720p/50</td>
<td>720p at 50 fps</td>
<td>576p at 50 fps</td>
<td>720p at 50 fps</td>
<td>1080i at 25 fps</td>
<td>PAL</td>
</tr>
<tr>
<td>720p/59.94</td>
<td>720p at 59.94 fps</td>
<td>486p at 59.94 fps</td>
<td>720p at 59.94 fps</td>
<td>1080i at 29.97 fps</td>
<td>NTSC</td>
</tr>
<tr>
<td>1080p/23.976</td>
<td>1080p at 23.98 fps</td>
<td>486p at 59.94 fps</td>
<td>720p at 59.94 fps</td>
<td>1080i/PsF at 23.98 fps</td>
<td>1080p at 23.98 fps</td>
</tr>
<tr>
<td>1080p/24</td>
<td>1080p at 24 fps</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080p/25</td>
<td>1080p at 25 fps</td>
<td>576p at 50 fps</td>
<td>720p at 50 fps</td>
<td>1080i/PsF at 25 fps</td>
<td>576PSF at 25 fps</td>
</tr>
<tr>
<td>1080p/29.97</td>
<td>1080p at 29.97 fps</td>
<td>486p at 59.94 fps</td>
<td>720p at 59.94 fps</td>
<td>1080i/PsF at 29.97 fps</td>
<td>486PSF at 29.97 fps</td>
</tr>
<tr>
<td>1080i/50</td>
<td>1080i at 25 fps</td>
<td>576p at 50 fps</td>
<td>720p at 50 fps</td>
<td>1080i at 25 fps</td>
<td>PAL</td>
</tr>
<tr>
<td>1080i/59.94</td>
<td>1080i at 29.97 fps</td>
<td>486p at 59.94 fps</td>
<td>720p at 59.94 fps</td>
<td>1080i at 29.97 fps</td>
<td>NTSC</td>
</tr>
</tbody>
</table>

1 The SD channel is not supported and is output as black video when cross-converting your project’s video output between 720p and 1080p/1/PsF.

2 If your project’s aspect ratio is 16:9, set **Aspect ratio formatting** to **Anamorphic** in the **Video Output** pane of the **Matrox Utilities** preferences window to output as 16:9 (see Chapter 7, “Configuring Your MXO2 System”).

3 Enable **Pulldown** in the **Video Output** pane of the **Matrox Utilities** preferences window to output 1080i at 29.97 fps (see Chapter 7, “Configuring Your MXO2 System”).
The following table lists the video formats that you can output from the various Matrox MXO2 outputs. The listed video output formats are those that are supported on the main and SD channels (see “Supported main and SD video output formats” on page 178). To assign the main or SD channel to an MXO2 output, see “Specifying your video output settings” on page 58. For descriptions of the MXO2 outputs, see “Outputs” on page 163.

### Video formats supported on MXO2 outputs

The following table lists the video formats that you can output from the various Matrox MXO2 outputs. The listed video output formats are those that are supported on the main and SD channels (see “Supported main and SD video output formats” on page 178). To assign the main or SD channel to an MXO2 output, see “Specifying your video output settings” on page 58. For descriptions of the MXO2 outputs, see “Outputs” on page 163.

<table>
<thead>
<tr>
<th>Video output format</th>
<th>HDMI</th>
<th>SDI&lt;sup&gt;1&lt;/sup&gt;</th>
<th>Component (Y, Pb, Pr)</th>
<th>S-Video (Y/C)</th>
<th>Composite (CVBS)</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>NTSC</td>
<td>NTSC</td>
<td>NTSC</td>
<td>NTSC</td>
<td>NTSC</td>
</tr>
<tr>
<td>NTSC 16:9</td>
<td>NTSC 16:9</td>
<td>NTSC 16:9</td>
<td>NTSC 16:9</td>
<td>NTSC 16:9</td>
<td>NTSC 16:9</td>
</tr>
<tr>
<td>PAL</td>
<td>PAL</td>
<td>PAL</td>
<td>PAL</td>
<td>PAL</td>
<td>PAL</td>
</tr>
<tr>
<td>486PsF at 29.97 fps</td>
<td>486PsF at 29.97 fps</td>
<td>486PsF at 29.97 fps</td>
<td>486PsF at 29.97 fps</td>
<td>486PsF at 29.97 fps</td>
<td>486PsF at 29.97 fps</td>
</tr>
<tr>
<td>486PsF at 29.97 fps</td>
<td>486PsF at 29.97 fps</td>
<td>486PsF at 29.97 fps</td>
<td>486PsF at 29.97 fps</td>
<td>486PsF at 29.97 fps</td>
<td>486PsF at 29.97 fps</td>
</tr>
<tr>
<td>576PsF at 25 fps</td>
<td>576PsF at 25 fps</td>
<td>576PsF at 25 fps</td>
<td>576PsF at 25 fps</td>
<td>576PsF at 25 fps</td>
<td>576PsF at 25 fps</td>
</tr>
<tr>
<td>486p at 59.94 fps</td>
<td>480p at 59.94 fps</td>
<td>NTSC</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>486p at 59.94 fps 16:9</td>
<td>480p at 59.94 fps 16:9</td>
<td>NTSC 16:9</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>576p at 50 fps</td>
<td>576p at 50 fps</td>
<td>PAL</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>576p at 50 fps 16:9</td>
<td>576p at 50 fps 16:9</td>
<td>PAL 16:9</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>720p at 50 fps</td>
<td>720p at 50 fps</td>
<td>720p at 50 fps</td>
<td>720p at 50 fps</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>720p at 59.94 fps</td>
<td>720p at 59.94 fps</td>
<td>720p at 59.94 fps</td>
<td>720p at 59.94 fps</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080i at 25 fps</td>
<td>1080i at 25 fps</td>
<td>1080i at 25 fps</td>
<td>1080i at 25 fps</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080i at 29.97 fps</td>
<td>1080i at 29.97 fps</td>
<td>1080i at 29.97 fps</td>
<td>1080i at 29.97 fps</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080PsF at 23.98 fps</td>
<td>—</td>
<td>1080PsF at 23.98 fps</td>
<td>1080PsF at 23.98 fps</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080PsF at 25 fps</td>
<td>1080PsF at 25 fps</td>
<td>1080PsF at 25 fps</td>
<td>1080PsF at 25 fps</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080PsF at 29.97 fps</td>
<td>1080PsF at 29.97 fps</td>
<td>1080PsF at 29.97 fps</td>
<td>1080PsF at 29.97 fps</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080p at 23.98 fps</td>
<td>1080p at 23.98 fps</td>
<td>1080p at 23.98 fps</td>
<td>1080p at 23.98 fps</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080p at 24 fps</td>
<td>1080p at 24 fps</td>
<td>1080p at 24 fps</td>
<td>1080p at 24 fps</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080p at 25 fps</td>
<td>1080p at 25 fps</td>
<td>1080p at 25 fps</td>
<td>1080p at 25 fps</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080p at 29.97 fps</td>
<td>1080p at 29.97 fps</td>
<td>1080p at 29.97 fps</td>
<td>1080p at 29.97 fps</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>1080p at 30 fps</td>
<td>1080p at 30 fps</td>
<td>1080p at 30 fps</td>
<td>1080p at 30 fps</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

<sup>1</sup> The SDI output is not available on Matrox MXO2 Mini.
Connecting and Using Matrox MXO2 Dock

This chapter shows how to power MXO2 Dock, how to connect it to your MXO2 system, and lists the available connections for use with your peripheral devices.
Powering Matrox MXO2 Dock

To power Matrox MXO2 Dock, connect the power supply cable to MXO2 Dock and an AC outlet as shown in this section. To remove power from MXO2 Dock, unplug the power supply cable from the AC outlet.

MXO2 Dock power supply and adapter plugs

Matrox MXO2 Dock provides a power supply cable with international adapter plugs for use in different regions:

- To remove an adapter plug from the power adapter, hold down the button on the adapter plug, and then slide the adapter plug up until it releases from the power adapter.
- To insert an adapter plug into the power adapter, ensure that the adapter plug is properly aligned with the corresponding slot on the power adapter, and then slide the adapter plug down into the power adapter until it locks into place.
Powering Matrox MXO2 Dock

Matrox MXO2 Dock (back view)

Power supply cable

To AC outlet
Connecting MXO2 Dock to your MXO2 system

Use the Matrox MXO2 Dock docking station to connect MXO2 to your computer’s Thunderbolt port. When doing this, it may take up to ten seconds for your MXO2 to be detected by your system and its applications.

**Important** Make sure that the Matrox PCIe cable is connected to MXO2 Dock and MXO2 before connecting MXO2 Dock to your computer via the Thunderbolt cable. If you want to disconnect or connect MXO2 when your system is running, you must do it by disconnecting/connecting the Thunderbolt cable. Do not disconnect the Matrox PCIe cable from MXO2 Dock, or MXO2, when your Mac system is running.

### Connecting to Matrox MXO2

To ensure functionality and avoid damaging the PCIe cable or host connector, you must connect the PCIe cable as shown in “Ensuring proper PCIe cable connection” on page 14.

To your computer’s Thunderbolt port.
Connecting to Matrox MXO2 Rack

**Caution** To ensure functionality and avoid damaging the PCIe cable or host connector, you must connect the PCIe cable as shown in “Ensuring proper PCIe cable connection” on page 25.

Thunderbolt cable (Not included. A Thunderbolt cable is required to connect Matrox MXO2 Dock to your computer.)

Connecting MXO2 Dock to your MXO2 system
Connecting to Matrox MXO2 LE

**Caution** To ensure functionality and avoid damaging the PCIe cable or host connector, you must connect the PCIe cable as shown in “Ensuring proper PCIe cable connection” on page 34.

MXO2 LE (side view)

PCle cable

Thunderbolt cable (Not included. A Thunderbolt cable is required to connect Matrox MXO2 Dock to your computer.)

Matrox MXO2 Dock

To your computer’s Thunderbolt port.

Chapter E, Connecting and Using Matrox MXO2 Dock
Connecting to Matrox MXO2 Mini

![Diagram of MXO2 Mini connection](image)

**Caution** To ensure functionality and avoid damaging the PCIe cable or host connector, you must connect the PCIe cable as shown in “Ensuring proper PCIe cable connection” on page 44.

To your computer’s Thunderbolt port.

Connecting MXO2 Dock to your MXO2 system
Available MXO2 Dock connections

When your computer is connected to MXO2 Dock (see “Connecting MXO2 Dock to your MXO2 system” on page 186), all peripheral devices connected to MXO2 Dock are automatically detected by your Mac system. Matrox MXO2 Dock features the following connections for your peripheral devices:

- **HDMI**
  - Matrox MXO2 Dock features one HDMI connector for connecting an HDMI monitor.
  - By default, the monitor connected to MXO2 Dock is detected by your system as a secondary monitor. However, you can change your system’s display settings (System Preferences > Display) so that the HDMI monitor connected to MXO2 Dock’s HDMI output is the primary monitor. When you disconnect MXO2 Dock from your computer, your computer’s display settings return to default settings. When re-connecting MXO2 Dock to your computer, the display settings that were specified when MXO2 Dock was last connected are restored.

  - **Note** The Matrox MXO2 Dock HDMI output supports the playback of HDCP (content-protected) sources.

Chapter E, Connecting and Using Matrox MXO2 Dock
Gigabit Ethernet
Matrox MXO2 Dock has one Gigabit Ethernet port for connecting to a Gigabit Ethernet network.

The network connected to MXO2 Dock is automatically selected by your computer. If for any reason you need to select the network connected to MXO2 Dock, the MXO2 Dock port appears as Thunderbolt Ethernet Slot in System Preferences > Network. If your network connection goes through a proxy server, select Thunderbolt Ethernet Slot in Network preferences, and then set the appropriate proxy settings in the Advanced options. If a network cable is connected to MXO2 Dock’s Gigabit Ethernet port and another network cable is connected to an Ethernet port on your computer, the network connected directly to your computer is used.

Note The MXO2 Dock Gigabit Ethernet port supports wake-on-LAN (WOL).

USB
Matrox MXO2 Dock includes two USB 2.0 ports for connecting USB devices such as a keyboard, mouse, printer and scanner. MXO2 Dock also features one front-mounted USB 3.0 port for connecting a SuperSpeed device, such as a flash drive or storage.

Note The MXO2 Dock USB ports support wake-on-USB.

Understanding the MXO2 Dock status LED
Matrox MXO2 Dock features a status LED on the front of the unit to indicate the following conditions:

- **Green** Matrox MXO2 Dock is connected to a computer via the Thunderbolt cable, and is functioning properly.
- **Red** The computer to which MXO2 Dock is connected via the Thunderbolt cable is shut down, or MXO2 Dock is not connected to a computer via the Thunderbolt cable.
- **Amber** The computer to which MXO2 Dock is connected via the Thunderbolt cable is in sleep mode.
Your notes
Matrox MXO2 Specifications

This appendix provides specifications for all Matrox MXO2 products.
Matrox MXO2 specifications

General
- **Video formats**  NTSC, PAL, NTSC-EIAJ, 1080p/i/PsF, 720p, 576p, 480p
- **Regulatory compliance**
  - FCC Class A, CE Mark Class A, ACMA C-Tick Mark, VCCI
  - RoHS Directive 2002/95/EC
- **Dimensions**
  - Length  330 mm (13”)
  - Width  241 mm (9.5”)
  - Height  51 mm (2”)
- **External AC/DC adapter**
  - 100-240 VAC 50-60 Hz
  - Input: IEC320-C14 inlet
  - Output: +12V DC, 3A max
  - Dimensions: L 104 mm × W 46 mm × H 36 mm (4.1” × 1.8” × 1.4”)
- **Total power consumption**  15 watts

Connections
- **Genlock reference input**
  - HD analog tri-level sync or SD analog bi-level black burst
  - BNC connector (75 Ω), terminated
- **RS-422**  D-sub connector (9 pins)

Video
- **HDMI**
  - HD input and output
    - HDMI Y,Cb,Cr 4:2:2 (10-bit) / RGB (8-bit)
    - Eight channels of embedded audio
    - Standard Type A HDMI connector (19 pins)
  - SD output
    - HDMI Y,Cb,Cr 4:2:2 (10-bit) / RGB (8-bit)
    - Eight channels of embedded audio
    - Standard Type A HDMI connector (19 pins)
- **SDI**
  - HDTV input
    - HD-SDI with 16 channels of embedded SDI audio
• 24-bit, 48 kHz
• Compliant with SMPTE 292M, SMPTE 299M
• BNC connector (75 Ω), terminated
• Equalized input for maximum cable length support

– **HDTV output**
• HD-SDI with 16 channels of embedded SDI audio
• 24-bit, 48 kHz
• Compliant with SMPTE 292M, SMPTE 299M
• BNC connector (75 Ω)

– **SDTV input**
• SD-SDI with 16 channels of embedded audio
• 24-bit, 48 kHz
• BNC connector (75 Ω), terminated
• Equalized input for maximum cable length support
• Compliant with SMPTE 259M-C, SMPTE 272M

– **SDTV output**
• SD-SDI with 16 channels of embedded audio
• 24-bit, 48 kHz
• BNC connector (75 Ω)
• Compliant with SMPTE 259M-C, SMPTE 272M

• **S-Video and composite video input**

– **SDTV input**
• PAL, NTSC, NTSC-EIAJ
• BNC connector for composite (75 Ω), terminated
• 4-pin mini-DIN S-Video connector (75 Ω), terminated
• 12-bit ADC
• 2x oversampling
• Anti-aliasing filtering
• Automatic gain control

– **SDTV output**
• PAL, NTSC, NTSC-EIAJ
• BNC connector for composite (75 Ω)
• 4-pin mini-DIN S-Video connector (75 Ω)
• 12-bit DAC
• 8x oversampling
• Analog component video input
  – HDTV input
    • EIA-770.3 compliant
    • BNC connectors (75 Ω)
    • 12-bit ADC
    • Anti-aliasing filtering
  – HDTV output
    • EIA-770.3 compliant
    • BNC connectors (75 Ω)
    • 12-bit DAC
    • 2x oversampling
  – SDTV input
    • Betacam, Betacam SP (NTSC and NTSC-EIAJ)
    • SMPTE/EBU N10 (PAL)
    • BNC connectors (75 Ω)
    • 12-bit ADC
    • 4x oversampling
    • Anti-aliasing filter
  – SDTV output
    • Betacam, Betacam SP (NTSC and NTSC-EIAJ)
    • SMPTE/EBU N10 (PAL)
    • BNC connectors (75 Ω)
    • 12-bit DAC
    • 8x oversampling
• Analog video performance
  – HDTV analog component video (passthrough)
    • Frequency response Y: +/- 1.0 dB max to 28 MHz
    • Frequency response Pb, Pr: +/- 1.0 dB max to 12 MHz
    • Component channel delay: < 8 ns
    • Component S/N (Y, Pb, Pr): > 50 dB, unified weighted
  – SDTV S-Video and composite video (passthrough)
    • Amplitude error: < 4%
    • Frequency response: +/- 0.5 dB max to 5 MHz
    • 2T pulse response: 1.0% max
    • Diff. Gain: < 2%, Diff. Phase: < 1 degree

Appendix F, Matrox MXO2 Specifications
Matrox MXO2 specifications

- S/N: > 58 dB, unified weighted
- **SDTV analog component video (passthrough)**
  - Frequency response Y: +/- 0.5 dB max to 5 MHz
  - Frequency response Pb, Pr: +/- 1.0 dB max to 2 MHz
  - Component channel delay: < 8 ns
  - Component S/N (Y, Pb, Pr): > 54 dB, unified weighted

**Audio**

- **Unbalanced analog audio inputs**
  - 1x stereo pair
  - RCA connectors
  - Input impedance: Hi-Z
  - Line level with 18 db headroom (max level)

- **Unbalanced analog audio outputs**
  - 3x stereo pair
  - RCA connectors
  - Output impedance: 100 Ω
  - Line level with 18 db headroom (max level)

- **Balanced analog inputs**
  - 1x stereo pair
  - 2x XLR female connectors
  - Nominal levels: +4 dBu (+4 dBm)
  - Input impedance: Hi-Z
  - Line level with 18 db headroom (max level)

- **Balanced analog outputs**
  - 2x stereo pair
  - 4x XLR male connectors
  - Nominal levels: +4 dBu (+4 dBm)
  - Output impedance: 50 Ω
  - Line level with 18 db headroom (max level)

- **Unbalanced digital (AES/EBU) input**
  - 1x stereo pair
  - BNC connector (75 Ω), terminated
  - Maximum input level: 5 Vpp

- **Unbalanced digital (AES/EBU) output**
  - 1x stereo pair
Appendix F, Matrox MXO2 Specifications

BNC connector
- Output impedance: 75 $\Omega$
- Nominal output level: 1V$_{pp}$

Balanced and unbalanced analog audio performance
- Sampling frequency: 48 kHz (using 64x oversampling)
- Quantization: 24 bits
- S/N: > 85 db
- THDN at 1 kHz, nominal level: < 0.05%

Environmental specifications
- Minimum/maximum ambient operating temperatures: 0 to 40º C
- Minimum/maximum storage temperature: –40 to 75º C
- Maximum altitude for operation: 3,000 meters
- Maximum altitude for transport: 12,000 meters
- Operating humidity: 20 to 80% relative humidity (non-condensing)
- Storage humidity: 5 to 95% relative humidity (non-condensing)

Matrox MXO2 Rack specifications

General
- Video formats  NTSC, PAL, NTSC-EIAJ, 1080p/i/PsF, 720p, 576p, 480p
- Regulatory compliance
  - FCC Class A, CE Mark Class A, ACMA C-Tick Mark, VCCI
  - RoHS Directive 2002/95/EC
- Dimensions (without rackmount brackets)
  - Length  437 mm (17.2”)
  - Width  208 mm (8.2”)
  - Height  86 mm (3.4”) (two rack units)
- Dimensions (with rackmount brackets)
  - Length  483 mm (19”)
  - Width  208 mm (8.2”)
  - Height  89 mm (3.5”) (two rack units)
- AC power
  - 100-240 VAC 50-60 Hz
  - Input: IEC320-C14 inlet
  - Output: +12V DC, 3A max
Matrox MXO2 Rack specifications

- Total power consumption 15 watts

Connections
- Genlock reference input
  - HD analog tri-level sync or SD analog bi-level black burst
  - BNC connector (75 Ω)
- Genlock reference output
  - HD analog tri-level sync or SD analog bi-level black burst
  - Loop through
  - BNC connector (75 Ω)
- RS-422 D-sub connector (9 pins)

Video
- HDMI
  - HD input and output
    - HDMI Y,Cb,Cr 4:2:2 (10-bit) / RGB (8-bit)
    - Eight channels of embedded audio
    - Standard Type A HDMI connector (19 pins)
  - SD output
    - HDMI Y,Cb,Cr 4:2:2 (10-bit) / RGB (8-bit)
    - Eight channels of embedded audio
    - Standard Type A HDMI connector (19 pins)
- SDI
  - HDTV input
    - HD-SDI with 16 channels of embedded SDI audio
    - 24-bit, 48 kHz
    - Compliant with SMPTE 292M, SMPTE 299M
    - BNC connector (75 Ω), terminated
    - Equalized input for maximum cable length support
  - HDTV output
    - HD-SDI with 16 channels of embedded SDI audio
    - 24-bit, 48 kHz
    - Compliant with SMPTE 292M, SMPTE 299M
    - BNC connector (75 Ω)
Appendix F, Matrox MXO2 Specifications

- **SDTV input**
  - SD-SDI with 16 channels of embedded audio
  - 24-bit, 48 kHz
  - BNC connector (75 Ω), terminated
  - Equalized input for maximum cable length support
  - Compliant with SMPTE 259M-C, SMPTE 272M
- **SDTV output**
  - SD-SDI with 16 channels of embedded audio
  - 24-bit, 48 kHz
  - BNC connector (75 Ω)
  - Compliant with SMPTE 259M-C, SMPTE 272M
- **S-Video and composite video input**
  - **SDTV input**
    - PAL, NTSC, NTSC-EIAJ
    - BNC connector for composite (75 Ω), terminated
    - 4-pin mini-DIN S-Video connector (75 Ω), terminated
    - 12-bit ADC
    - 2x oversampling
    - Anti-aliasing filtering
    - Automatic gain control
  - **SDTV output**
    - PAL, NTSC, NTSC-EIAJ
    - BNC connector for composite (75 Ω)
    - 4-pin mini-DIN S-Video connector (75 Ω)
    - 12-bit DAC
    - 8x oversampling
- **Analog component video input**
  - **HDTV input**
    - EIA-770.3 compliant
    - BNC connectors (75 Ω)
    - 12-bit ADC
    - Anti-aliasing filtering
  - **HDTV output**
    - EIA-770.3 compliant
    - BNC connectors (75 Ω)
• 12-bit DAC
• 2x oversampling

– SDTV input
• Betacam, Betacam SP (NTSC and NTSC-EIAJ)
• SMPTE/EBU N10 (PAL)
• BNC connectors (75 Ω)
• 12-bit ADC
• 4x oversampling
• Anti-aliasing filter

– SDTV output
• Betacam, Betacam SP (NTSC and NTSC-EIAJ)
• SMPTE/EBU N10 (PAL)
• BNC connectors (75 Ω)
• 12-bit DAC
• 8x oversampling

• Analog video performance
  – HDTV analog component video (passthrough)
    • Frequency response Y: +/- 1.0 dB max to 28 MHz
    • Frequency response Pb, Pr: +/- 1.0 dB max to 12 MHz
    • Component channel delay: < 8 ns
    • Component S/N (Y, Pb, Pr): > 50 dB, unified weighted

  – SDTV S-Video and composite video (passthrough)
    • Amplitude error: < 4%
    • Frequency response: +/- 0.5 dB max to 5 MHz
    • 2T pulse response: 1.0% max
    • Diff. Gain: < 2%, Diff. Phase: < 1 degree
    • S/N: > 58 dB, unified weighted

  – SDTV analog component video (passthrough)
    • Frequency response Y: +/- 0.5 dB max to 5 MHz
    • Frequency response Pb, Pr: +/- 1.0 dB max to 2 MHz
    • Component channel delay: < 8 ns
    • Component S/N (Y, Pb, Pr): > 54 dB, unified weighted
Audio

- **Balanced analog inputs**
  - 2x stereo pair
  - 4x XLR female connectors
  - Nominal levels: +4 dBu (+4 dBm)
  - Input impedance: Hi-Z
  - Headroom (max level): 18 dB

- **Balanced analog outputs**
  - 4x stereo pair
  - 8x XLR male connectors
  - Nominal levels: +4 dBu (+4 dBm)
  - Output impedance: 50 \( \Omega \)
  - Headroom (max level): 18 db

- **Unbalanced digital (AES/EBU) input**
  - 2x stereo pair
  - 2x BNC connector (75 \( \Omega \)), terminated
  - Maximum input level: 5 V_{pp}

- **Unbalanced digital (AES/EBU) output**
  - 2x stereo pair
  - 2x BNC connector
  - Output impedance: 75 \( \Omega \)
  - Nominal output level: 1V_{pp}

- **Balanced analog audio performance**
  - Sampling frequency: 48 kHz (using 64x oversampling)
  - Quantization: 24 bits
  - S/N: > 85 db
  - THDN at 1 kHz, nominal level: < 0.05%

Environmental specifications

- Minimum/maximum ambient operating temperatures: 0 to 40\(^\circ\) C
- Minimum/maximum storage temperature: -40 to 75\(^\circ\) C
- Maximum altitude for operation: 3,000 meters
- Maximum altitude for transport: 12,000 meters
- Operating humidity: 20 to 80% relative humidity (non-condensing)
- Storage humidity: 5 to 95% relative humidity (non-condensing)
Matrox MXO2 LE specifications

General
- **Video formats**  NTSC, PAL, NTSC-EIAJ, 1080p/i/PsF, 720p, 576p, 486p
- **Regulatory compliance**
  - FCC Class A, CE Mark Class A, ACMA C-Tick Mark, VCCI
  - RoHS Directive 2002/95/EC
- **Dimensions**
  - Length  237 mm (9.3")
  - Width   241 mm (9.5")
  - Height  51 mm (2")
- **External AC/DC adapter**
  - 100-240 V AC 50-60 Hz
  - Input: IEC320-C14 inlet
  - Output: +12V DC, 3A max
  - Dimensions: L 104 mm × W 46 mm × H 36 mm (4.1" × 1.8" × 1.4")
- **Total power consumption**  15 watts

Connections
- **Genlock reference input**
  - HD analog tri-level sync or SD analog bi-level black burst
  - BNC connector (75 Ω), terminated
- **RS-422**  D-sub connector (9 pins)

Video
- **HDMI**
  - **HD input and output**
    - HDMI Y,Cb,Cr 4:2:2 (10-bit) / RGB (8-bit)
    - Eight channels of embedded audio
    - Standard Type A HDMI connector (19 pins)
  - **SD output**
    - HDMI Y,Cb,Cr 4:2:2 (10-bit) / RGB (8-bit)
    - Eight channels of embedded audio
    - Standard Type A HDMI connector (19 pins)
- **SDI**
  - **HDTV input**
    - HD-SDI with 16 channels of embedded SDI audio
Appendix F, Matrox MXO2 Specifications

- **24-bit, 48 kHz**
- Compliant with SMPTE 292M, SMPTE 299M
- BNC connector (75 Ω), terminated
- Equalized input for maximum cable length support

- **HDTV output**
  - HD-SDI with 16 channels of embedded SDI audio
  - 24-bit, 48 kHz
  - Compliant with SMPTE 292M, SMPTE 299M
  - BNC connector (75 Ω)

- **SDTV input**
  - SD-SDI with 16 channels of embedded audio
  - 24-bit, 48 kHz
  - BNC connector (75 Ω), terminated
  - Equalized input for maximum cable length support
  - Compliant with SMPTE 259M-C, SMPTE 272M

- **SDTV output**
  - SD-SDI with 16 channels of embedded audio
  - 24-bit, 48 kHz
  - BNC connector (75 Ω)
  - Compliant with SMPTE 259M-C, SMPTE 272M

- **S-Video and composite video input**

  - **SDTV input**
    - PAL, NTSC, NTSC-EIAJ
    - BNC connector for composite (75 Ω), terminated
    - 4-pin mini-DIN S-Video connector (75 Ω), terminated
    - 12-bit ADC
    - 2x oversampling
    - Anti-aliasing filtering
    - Automatic gain control

  - **SDTV output**
    - PAL, NTSC, NTSC-EIAJ
    - BNC connector for composite (75 Ω)
    - 4-pin mini-DIN S-Video connector (75 Ω)
    - 12-bit DAC
    - 8x oversampling
• Analog component video input
  – HDTV input
    • EIA-770.3 compliant
    • BNC connectors (75 Ω)
    • 12-bit ADC
    • Anti-aliasing filtering
  – HDTV output
    • EIA-770.3 compliant
    • BNC connectors (75 Ω)
    • 12-bit DAC
    • 2x oversampling
  – SDTV input
    • Betacam, Betacam SP (NTSC and NTSC-EIAJ)
    • SMPTE/EBU N10 (PAL)
    • BNC connectors (75 Ω)
    • 12-bit ADC
    • 4x oversampling
    • Anti-aliasing filter
  – SDTV output
    • Betacam, Betacam SP (NTSC and NTSC-EIAJ)
    • SMPTE/EBU N10 (PAL)
    • BNC connectors (75 Ω)
    • 12-bit DAC
    • 8x oversampling

• Analog video performance
  – HDTV analog component video (passthrough)
    • Frequency response Y: +/- 1.0 dB max to 28 MHz
    • Frequency response Pb, Pr: +/- 1.0 dB max to 12 MHz
    • Component channel delay: < 8 ns
    • Component S/N (Y, Pb, Pr): > 50 dB, unified weighted
  – SDTV S-Video and composite video (passthrough)
    • Amplitude error: < 4%
    • Frequency response: +/- 0.5 dB max to 5 MHz
    • 2T pulse response: 1.0% max
    • Diff. Gain: < 2%, Diff. Phase: < 1 degree

Matrox MXO2 LE specifications
• S/N: > 58 dB, unified weighted

  - **SDTV analog component video (passthrough)**
    - Frequency response Y: +/- 0.5 dB max to 5 MHz
    - Frequency response Pb, Pr: +/- 1.0 dB max to 2 MHz
    - Component channel delay: < 8 ns
    - Component S/N (Y, Pb, Pr): > 54 dB, unified weighted

**Audio**

- **Unbalanced analog audio inputs**
  - 1x stereo pair
  - RCA connectors
  - Input impedance: Hi-Z
  - Line level with 18 db headroom (max level)

- **Unbalanced analog audio outputs**
  - 1x stereo pair
  - RCA connectors
  - Output impedance: 100 Ω
  - Line level with 18 db headroom (max level)

- **Balanced analog inputs**
  - 1x stereo pair
  - 2x XLR female connectors
  - Nominal levels: +4 dBu (+4 dBm)
  - Input impedance: Hi-Z
  - Headroom (max level): 18 db

- **Balanced analog outputs**
  - 1x stereo pair
  - 2x XLR male connectors
  - Nominal levels: +4 dBu (+4 dBm)
  - Output impedance: 50 Ω
  - Headroom (max level): 18 db

- **Balanced and unbalanced analog audio performance**
  - Sampling frequency: 48 kHz (using 64x oversampling)
  - Quantization: 24 bits
  - S/N: > 85 db
  - THDN at 1 kHz, nominal level: < 0.05%
Environmental specifications
- Minimum/maximum ambient operating temperatures: 0 to 40º C
- Minimum/maximum storage temperature: -40 to 75º C
- Maximum altitude for operation: 3,000 meters
- Maximum altitude for transport: 12,000 meters
- Operating humidity: 20 to 80% relative humidity (non-condensing)
- Storage humidity: 5 to 95% relative humidity (non-condensing)

Matrox MXO2 Mini specifications

General
- Video formats  NTSC, PAL, NTSC-EIAJ, 1080p/i/PsF, 720p, 576p, 486p
- Regulatory compliance
  - FCC Class A, CE Mark Class A, ACMA C-Tick Mark, VCCI
  - RoHS Directive 2002/95/EC
- Dimensions
  - Length  166 mm (6.5”)
  - Width  110 mm (4.3”)
  - Height  40 mm (1.6”)
- Operating voltages and power consumption
  - Included AC/DC adapter: 100-240 V AC 50-60 Hz (5 V DC, 3 A max)
  - MXO2 Mini unit: 5-25 V DC, 2.5 mm barrel-type connector
    - 9 watts power consumption

Connections
Video
- HDMI video
  - HD input and output
    - HDMI Y,Cb,Cr 4:2:2 (10-bit) / RGB (8-bit)
    - Eight channels of embedded audio
    - Standard Type A HDMI connector (19 pins)
  - SD output
    - HDMI Y,Cb,Cr 4:2:2 (10-bit) / RGB (8-bit)
    - Eight channels of embedded audio
    - Standard Type A HDMI connector (19 pins)
Appendix F, Matrox MXO2 Specifications

- **Composite video** (not available if using analog component input/output)
  - **SDTV input**
    - PAL, NTSC, NTSC-EIAJ
    - RCA connector
    - 10-bit ADC
    - 4x oversampling
    - Anti-aliasing filtering
    - Automatic gain control
  - **SDTV output**
    - PAL, NTSC, NTSC-EIAJ
    - RCA connector
    - 12-bit DAC
    - 16x oversampling

- **S-Video** (not available when using analog component input/output)
  - **SDTV input**
    - PAL, NTSC, NTSC-EIAJ
    - RCA connectors
    - 10-bit ADC
    - 4x oversampling
    - Anti-aliasing filtering
    - Automatic gain control
  - **SDTV output**
    - PAL, NTSC, NTSC-EIAJ
    - RCA connectors
    - 12-bit DAC
    - 16x oversampling

- **Analog component video** (not available when using composite, or S-Video input/output)
  - **HDTV input**
    - EIA-770.3 compliant
    - RCA connectors
    - 10-bit ADC
    - Anti-aliasing filtering
  - **HDTV output**
    - EIA-770.3 compliant
- RCA connectors
- 12-bit DAC
- 4x oversampling

- SDTV input
  - Betacam, Betacam SP (NTSC and NTSC-EIAJ)
  - SMPTE/EBU N10 (PAL)
  - RCA connectors
  - 10-bit ADC
  - 2x oversampling
  - Anti-aliasing filter

- SDTV output
  - Betacam, Betacam SP (NTSC and NTSC-EIAJ)
  - SMPTE/EBU N10 (PAL)
  - RCA connectors
  - 12-bit DAC
  - 16x oversampling

- Analog video performance
  - HDTV analog component video
    - Frequency response Y: +/- 1.0 dB max to 28 MHz
    - Frequency response Pb, Pr: +/- 1.0 dB max to 12 MHz
    - Component channel delay: < 8 ns
    - Component S/N (Y, Pb, Pr): > 50 dB, unified weighted
  - SDTV S-Video and composite video
    - Amplitude error: < 4%
    - Frequency response: +/- 0.75 dB max to 5 MHz
    - Diff. Gain: < 2%, Diff. Phase: < 1 degree
    - S/N: > 54 dB, unified weighted
  - SDTV analog component video
    - Frequency response Y: +/- 0.75 dB max to 5 MHz
    - Frequency response Pb, Pr: +/- 1.0 dB max to 2 MHz
    - Component channel delay: < 8 ns
    - Component S/N (Y, Pb, Pr): > 54 dB, unified weighted

Matrox MXO2 Mini specifications
Audio

- **Unbalanced analog audio inputs**
  - 1x stereo pair
  - RCA connectors
  - Input impedance: > 10 kΩ
  - Line level with 18 db headroom (max level: +8 dBv)

- **Unbalanced analog audio outputs**
  - 1x stereo pair
  - RCA connectors
  - Output impedance: < 200 Ω
  - Line level with 18 db headroom (max level: +8 dBv)

- **Unbalanced analog audio performance**
  - Sampling frequency: 48 kHz (using 128x oversampling)
  - Quantization: 24 bits
  - S/N: > 90 db
  - THDN at 1 kHz, nominal level: < 0.02%
  - Frequency response: +/- 0.5 dB, 20 Hz to 20 kHz
  - Channel separation: > 100 db

Environmental specifications

- Minimum/maximum ambient operating temperatures: 0 to 40° C
- Minimum/maximum storage temperature: -40 to 75° C
- Maximum altitude for operation: 3,000 meters
- Maximum altitude for transport: 12,000 meters
- Operating humidity: 20 to 80% relative humidity (non-condensing)
- Storage humidity: 5 to 95% relative humidity (non-condensing)
Matrox MXO2 Thunderbolt adapter specifications

- **Dimensions**
  - Length 87 mm (3.4")
  - Width 48 mm (1.9")
  - Height 19 mm (.75")
- **Power consumption** 3.6 watts
- **Minimum/maximum ambient operating temperatures** 0 to 40°C

Matrox MXO2 Dock specifications

- **Regulatory compliance**
  - FCC Class B, CE Mark Class B
  - RoHS Directive 2002/95/EC
- **Dimensions**
  - Length 91 mm (3.6")
  - Width 201 mm (7.9")
  - Height 32 mm (1.25")
- **Weight** 484 g (1.07 lbs)
- **External AC/DC adapter**
  - Input: 100-240 VAC 50-60 Hz
  - Output: +12V DC, 2A max
  - Dimensions: L 78 mm × W 46 mm × H 36 mm (3.1” × 1.8” × 1.4”)
- **Unit voltage and amperage** 12V/2A
- **Total power consumption** 24 W

Connections

- **HDMI output:**
  - One Standard Type A HDMI connector (19 pins)
  - Eight channels of embedded audio
  - Maximum resolution: 1920 × 1080 at 60 fps
  - HDCP compliant for protected content playback
- **Data ports:**
  - One Thunderbolt port
  - One USB 3.0 port with wake-on-USB, and a maximum theoretical data transfer speed of 2.5 Gb/s.
  - Two USB 2.0 ports with wake-on-USB
One Gigabit Ethernet port with wake-on-LAN (WOL)

**Environmental specifications**
- Minimum/maximum operating temperature: 10°C to 35°C
- Minimum/maximum storage temperature: -20°C to 47°C
- Maximum altitude for operation: 3,000 m
- Maximum altitude for transport: 10,000 m
- Operating humidity: 20% to 80% relative humidity (non-condensing)

**Matrox PCIe host adapter specifications**

**Matrox PCIe host ExpressCard/34 adapter (for laptops)**
- Standard ExpressCard/34
- Dimensions: L 96 mm × W 33 mm × H 13 mm (3.8" × 1.3" × 0.5")

**Matrox PCIe host adapter (for desktops)**
- Standard low-profile PCIe (x1) card
- PCB dimensions
  - L 66 mm × H 69 mm (2.6" × 2.7")
  - Overall thickness including components: 19 mm (0.75")
Matrox Customer Support

This appendix explains how you can register your Matrox product and obtain customer support.
How to get Matrox customer support

If you have a problem that you’re unable to solve by referring to the documentation for your Matrox product, please contact your Matrox representative. He or she should be able to help you quickly correct any installation or system configuration problem.

If your representative is unable to solve your problem, contact Matrox for further information and assistance.

Registration
You can register your Matrox product in the Matrox Support section of our website at www.matrox.com/video/support.

**Important** Only registered users are entitled to customer support, software updates, special promotional offers, and access to our user forum.

Keep up to date with our website
In addition to registering your Matrox product, our website offers you up-to-the-minute information about Matrox products and software updates. Be sure to place our site in your favorites or bookmarks: www.matrox.com/video/support.

Contacting us
Matrox is proud to offer worldwide customer support. Please use the contact information for your Matrox product and area as provided on our website at www.matrox.com/video/support.
Numerics
264 files
See Blu-ray Disc files (.264)

A
A/V input settings 55
Adobe After Effects, using Matrox with 107
Adobe Encore, using Matrox with 105
Adobe Media Encoder
assigning a Matrox MAX H.264 preset 137
creating a custom Matrox MAX H.264 preset 137
Matrox MAX H.264 settings 136
Adobe Photoshop, using Matrox with 108
Adobe Prelude, using Matrox with 106
Adobe Premiere Pro
adding voice-over to sequence 86
assigning a Matrox MAX H.264 preset 137
creating a custom Matrox MAX H.264 preset 137
creating a new Matrox project 81
defining capture settings 84
exporting a sequence to tape 101
Matrox MAX H.264 settings 136
setting up Matrox device control 99
settings for capturing AFD 92
settings for capturing closed captioning 94
settings for exporting AFD 93
settings for exporting closed captioning to a file 95
settings for playing back AFD 92
settings for playing back closed captioning 95
working with 80
Adobe SpeedGrade
playback settings 109
AFD (active format description) 66
capture settings in Premiere Pro 92
exporting to a file in Premiere Pro 93
playback settings in Premiere Pro 92
After Effects
See Adobe After Effects
Apple Compressor
assigning a Matrox MAX H.264 setting 127
creating a custom Matrox MAX H.264 setting 128
Matrox MAX H.264 settings 126
Apple Final Cut Pro X
playback using Matrox MXO2 120

Apple QuickTime Pro, Matrox MAX H.264 settings in 147
Audio output settings 62
Audio Punch-In tool
using for voice-over 114, 115
Avid Media Composer
adding a voice-over in 114
creating a new Matrox project in 111
defining your capture settings in 112
defining your playback settings in 111
exporting your sequence to tape in 119
Matrox MAX H.264 settings 143
specifying settings for exporting Matrox 4VANC to a file 117
specifying settings for importing a Matrox 4VANC file 117
specifying your audio output settings in 118
testing input levels for voice-over 116
working with 111
Avid Symphony
adding a voice-over in 114
creating a new Matrox project in 111
defining your capture settings in 112
defining your playback settings in 111
exporting your sequence to tape in 119
specifying settings for exporting Matrox 4VANC to a file 117
specifying settings for importing a Matrox 4VANC file 117
specifying your audio output settings in 118
testing input levels for voice-over 116
working with 111

B
Battery
connecting to MXO2 12
connecting to MXO2 LE 32
requirements and guidelines 3
Blu-ray Disc files (.264)
assigning a Matrox MAX H.264 setting in Apple Compressor 127
creating a custom Matrox MAX H.264 setting in Apple Compressor 128
Index

C
Calibration, monitor
   See HDMI monitor calibration
Capture
   AFD (active format description) 66
   closed captioning 68
   supported video formats 174
   using Premiere Pro
      AFD settings 92
      closed captioning settings 94
Channels, video output
   specifying settings for 58
   supported formats 178
Closed captioning 68
   capture settings in Premiere Pro 94
   exporting to a file in Premiere Pro 95
   playback settings in Premiere Pro 95
Codec
   See Matrox MAX H.264 codec
Compressor
   See Apple Compressor
Computer system
   connecting to your MXO2 14
   connecting to your MXO2 LE 34
   connecting to your MXO2 Mini 44
   connecting to your MXO2 Rack 25
   requirements 2
Connections
   AC power
      for MXO2 12
      for MXO2 Dock 184
      for MXO2 LE 32
      for MXO2 Mini 42
      for MXO2 Rack 24
   available on Matrox MXO2 12
   available on Matrox MXO2 LE 32
   available on Matrox MXO2 Mini 42
   available on Matrox MXO2 Rack 22
   available on MXO2 Dock 190
   battery
      for MXO2 12
      for MXO2 LE 32
   MXO2 LE to Mac system 34
   MXO2 Mini to Mac system 44
   MXO2 Rack to Mac system 25
   MXO2 to Mac system 14
   RS-422
      for MXO2 17
      for MXO2 LE 37
      for MXO2 Rack 28
   typical
      for MXO2 18
      for MXO2 LE 38
      for MXO2 Mini 48
      for MXO2 Rack 29
Customer support 214

D
Device control
   RS-422
      connection for MXO2 17
      connection for MXO2 LE 37
      connection for MXO2 Rack 28
   setting up in Premiere Pro 99
Docking station
   See Matrox MXO2 Dock

E
Encore
   See Adobe Encore
Export to tape
   device control settings in Premiere Pro 99
   in Avid Media Composer/Symphony 119
   in Premiere Pro 101
ExpressCard
   See PCIe host ExpressCard/34 adapter

F
Firmware, updating 8

G
Genlock
   specifying settings for MXO2, MXO2 Rack, and MXO2 LE 54
   timing offset controls 55

H
Hardware warranty i
Hardware, MXO2
   before you install 6
   safety precautions 6
   specifications 193
Index

updating firmware 8
HDMI monitor calibration
  - calibrating your HDMI monitor 76
  - enabling and disabling the Matrox HDMI calibration settings 78
  - loading Matrox HDMI calibration settings 77
  - overview 76

I
Inputs
  - supported video formats 172
Inputs on MXO2 Mini
    - analog RCA audio 162
    - available 159
    - component (Y, Pb, Pr) 162
    - composite (Y) 162
    - HDMI 162
    - scaling on 56
    - specifying 55
    - S-Video (Pb, Pr) 162
Inputs on MXO2, MXO2 Rack, and MXO2 LE
    - AES/EBU audio 161
    - analog RCA audio 161
    - analog XLR audio 161
    - available on MXO2 156
    - available on MXO2 LE 158
    - available on MXO2 Rack 157
    - component (Y, Pb, Pr) 161
    - composite (CVBS) 161
    - HDMI 160
    - REF 160
    - scaling on 56
    - SDI 161
    - specifying 55
    - S-Video (Y/C) 161
Internet site, Matrox 214

L
Luminance levels, setting for video input/output 53

M
Mac system
  - connecting to your MXO2 14
  - connecting to your MXO2 LE 34
  - connecting to your MXO2 Mini 44
  - connecting to your MXO2 Rack 25
Main and SD channels, video output formats on 178
Matrox
  - contacting us 214
  - WWW site 214
Matrox MAX H.264 codec
  - assigning a preset for Adobe Media Encoder and Premiere Pro 137
  - assigning a setting for Apple Compressor 127
  - creating a custom preset for Adobe Media Encoder and Premiere Pro 137
  - creating a custom setting for Apple Compressor 128
  - settings for Adobe Media Encoder 136
  - settings for Adobe Premiere Pro 136
  - settings for Apple Compressor 126
  - settings for Apple QuickTime Pro 147
  - settings for Telestream Episode 140
  - settings in Avid Media Composer 143
Matrox MPEG-2 I-frame codec
  - configuring settings 102
  - downloading for playback 102
  - overview 102
Matrox MXO2 Dock
  - available connections 190
  - connecting to MXO2 186
  - connecting to MXO2 LE 188
  - connecting to MXO2 Rack 187
  - DVI connection 190
  - Gigabit Ethernet connection 191
  - HDMI connection 190
  - specifications 211
  - status LEDs 191
  - USB connection 191
Matrox MXO2 Thunderbolt adapter
  - connecting to MXO2 15
  - connecting to MXO2 LE 35
  - connecting to MXO2 Mini 45
  - connecting to MXO2 Rack 26
  - specifications 211
Matrox Player
  - setting as video device 109
Matrox WYSIWYG
  - specifying settings 70
  - working with Adobe After Effects 107
  - working with Adobe Photoshop 108
Media Composer
  - See Avid Media Composer
Monitor calibration
Index

See HDMI monitor calibration
MOV files
    See QuickTime files (.mov)
MPEG-2 I-frame
    See Matrox MPEG-2 I-frame codec

Outputs on MXO2 Mini
    analog RCA audio 170
    available 166
    component (Y, Pb, Pr) 170
    composite (Y) 170
    HDMI 169
    specifying audio 62
    specifying video 58
    supported video formats 182
    supported video formats on main and SD channels 178
    S-Video (Pb, Pr) 170

Outputs on MXO2, MXO2 Rack, and MXO2 LE
    AES/EBU audio 168
    analog RCA audio 169
    analog XLR audio 168
    available on MXO2 163
    available on MXO2 LE 165
    available on MXO2 Rack 164
    component (Y, Pb, Pr) 168
    composite (CVBS) 168
    HDMI 167
    SDI 168
    specifying audio 62
    specifying video 58
    supported video formats 182
    supported video formats on main and SD channels 178
    S-Video (Y/C) 168

PCle host adapter
    connecting to MXO2 16
    connecting to MXO2 LE 36
    connecting to MXO2 Mini 44, 46
    connecting to MXO2 Rack 27
    installing 7
    specifications 212

PCle host ExpressCard/34 adapter
    connecting to MXO2 16
    connecting to MXO2 LE 36
    connecting to MXO2 Mini 44, 46
    connecting to MXO2 Rack 27
    installing 7
    specifications 212

Pedestal, setting for NTSC analog video 54
Photoshop
    See Adobe Photoshop

Power
    connecting to MXO2 12
    connecting to MXO2 Dock 184
    connecting to MXO2 LE 32
    connecting to MXO2 Mini 42
    connecting to MXO2 Rack 24
    functionality in MXO2 12
    functionality in MXO2 LE 32
    functionality in MXO2 Rack 24
    See also Battery

Power adapter plugs
    connecting for MXO2 Dock 184
    connecting for MXO2 Mini 42

Preferences window
    Loading custom presets 52
    saving custom presets 52
    specifying A/V input settings 55
    specifying audio output settings 62
    specifying general settings 53
    specifying genlock settings for MXO2, MXO2 Rack, and MXO2 LE 54
    specifying Matrox WYSIWYG settings 70
    specifying the Apple Final Cut Pro X setting 120
    specifying video output settings 58
    viewing MXO2 information 72

Prelude
    See Adobe Prelude

Premiere Pro
    See Adobe Premiere Pro

Presets, preferences window
    loading 52
    saving 52

Programs, using with supported 79

QuickTime files (.mov)
assigning a Matrox MAX H.264 preset in Adobe Media Encoder 137
assigning a Matrox MAX H.264 preset in Adobe Premiere Pro 137
assigning a Matrox MAX H.264 setting in Apple Compressor 127
creating a custom Matrox MAX H.264 preset in Adobe Media Encoder 137
creating a custom Matrox MAX H.264 preset in Adobe Premiere Pro 137
creating a custom Matrox MAX H.264 setting in Apple Compressor 128
creating in Avid Media Composer using Matrox MAX H.264 143
specifying Matrox MAX H.264 settings in Adobe Media Encoder 136
specifying Matrox MAX H.264 settings in Adobe Premiere Pro 136
specifying Matrox MAX H.264 settings in Apple QuickTime Pro 147
specifying Matrox MAX H.264 settings in Telestream Episode 140

R
Registering your Matrox product 214
RS-422
  connection to MXO2 17
  connection to MXO2 LE 37
  connection to MXO2 Rack 28
  See also Device control

S
Scaling
  on MXO2 inputs 56
Settings
  A/V input 55
  audio output 62
  for capturing AFD in Premiere Pro 92
  for capturing closed captioning in Premiere Pro 94
  for exporting AFD in Premiere Pro 93
  for exporting closed captioning to a file in Premiere Pro 95
  for playing back AFD in Premiere Pro 92
  for playing back closed captioning in Premiere Pro 95
  general 53
  genlock for MXO2, MXO2 Rack, and MXO2 LE 54
  video output for MXO2 58

Setup level
  See Pedestal
Software, MXO2
  installing 8
  removing 9
Specifications
  host ExpressCard/34 adapter 212
  Matrox MXO2 194
  Matrox MXO2 Dock 211
  Matrox MXO2 LE 203
  Matrox MXO2 Mini 207
  Matrox MXO2 Rack 198
  Matrox MXO2 Thunderbolt adapter 211
  PCIe host adapter 212
SpeedGrade
  See Adobe SpeedGrade
Style conventions 3
Symphony
  See Avid Symphony
System requirements 2

T
Technical support 214
Telestream Episode, Matrox MAX H.264 settings in 140
Thunderbolt adapter
  See Matrox MXO2 Thunderbolt adapter

V
Video formats
  expressed in MXO2 documentation 4
  supported in capture 174
  supported on inputs 172
  See also Video output device settings
  See also Video output formats, MXO2
Video output device settings
  in Adobe After Effects 107
  in Adobe Encore 105
  in Adobe Photoshop 108
  in Adobe Prelude 106
Video output formats
  supported on main and SD channels 178
  supported on outputs 182
  See also Video output device settings
  See also Video formats
Video output settings 58
Voice-over
  adding to sequence
    in Adobe Premiere Pro 86
    in Avid editing applications 114
  connection and setup
    in Adobe Premiere Pro 86
    in Avid editing applications 114
  recording
    in Adobe Premiere Pro 90
    in Avid editing applications 115

W
  Warranty i
  WWW site, Matrox 214
  WYSIWYG, specifying settings 70
**Compliance Statements**

**USA**

**FCC Compliance Statement**

Remark for the Matrox hardware products supported by this guide

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

**WARNING**

Changes or modifications to this unit not expressly approved by the party responsible for the compliance could void the user’s authority to operate this equipment. The use of shielded cables for connection of the equipment and other peripherals is required to meet FCC requirements.

**Canada**

**Industry Canada Compliance Statement**

CAN ICES-3 (A)/NMB-3 (A)

**Remark for the Matrox hardware products supported by this guide**

These digital devices do not exceed the Class A limits for radio noise emission from digital devices set out in the Radio Interference Regulation of Industry Canada.

**European user’s information – Declaration of Conformity**

Remark for the Matrox hardware products supported by this guide

These devices comply with EC Directive 2006/95/EC for a Class A digital device. They have been tested and found to comply with EN55022/CISPR22 and EN55024/CISPR24. In a domestic environment these products may cause radio interference in which case the user may be required to take adequate measures. To meet EC requirements, shielded cables must be used to connect the equipment and other peripherals. Analog A/V cables connected to Matrox MXO2 Mini must be limited to less than three meters to comply with EEC and EMC directives. These products have been tested in a typical Class A compliant host system. It is assumed that these products will also achieve compliance in any Class A compliant system.

**European user’s information – Declaration of Conformity**

Remark for the Matrox hardware products supported by this guide

These digital devices do not exceed the Class A limits for radio noise emission from digital devices set out in the Radio Interference Regulation of Industry Canada.

**European user’s information – Declaration of Conformity**

Remark for the Matrox hardware products supported by this guide

These digital devices do not exceed the Class A limits for radio noise emission from digital devices set out in the Radio Interference Regulation of Industry Canada.

**Europe**

**Remark for the Matrox hardware products supported by this guide**

These digital devices do not exceed the Class A limits for radio noise emission from digital devices set out in the Radio Interference Regulation of Industry Canada.

**Remarque sur les produits matériels Matrox couverts par ce guide**

Ces appareils numériques n’émettent aucun bruit radioélectrique dépassant les limites applicables aux appareils numériques de Classe A prescrites dans le Règlement sur le brouillage radioélectrique édicté par Industrie Canada.

**Europe**

**Remark for the Matrox hardware products supported by this guide**

These digital devices do not exceed the Class A limits for radio noise emission from digital devices set out in the Radio Interference Regulation of Industry Canada.

**Remarque sur les produits matériels Matrox couverts par ce guide**

Ces appareils numériques n’émettent aucun bruit radioélectrique dépassant les limites applicables aux appareils numériques de Classe A prescrites dans le Règlement sur le brouillage radioélectrique édicté par Industrie Canada.

**Europe**

**Remark for the Matrox hardware products supported by this guide**

These digital devices do not exceed the Class A limits for radio noise emission from digital devices set out in the Radio Interference Regulation of Industry Canada.

**Remarque sur les produits matériels Matrox couverts par ce guide**

Ces appareils numériques n’émettent aucun bruit radioélectrique dépassant les limites applicables aux appareils numériques de Classe A prescrites dans le Règlement sur le brouillage radioélectrique édicté par Industrie Canada.

**Europe**

**Remark for the Matrox hardware products supported by this guide**

These digital devices do not exceed the Class A limits for radio noise emission from digital devices set out in the Radio Interference Regulation of Industry Canada.

**Remarque sur les produits matériels Matrox couverts par ce guide**

Ces appareils numériques n’émettent aucun bruit radioélectrique dépassant les limites applicables aux appareils numériques de Classe A prescrites dans le Règlement sur le brouillage radioélectrique édicté par Industrie Canada.

**Europe**

**Remark for the Matrox hardware products supported by this guide**

These digital devices do not exceed the Class A limits for radio noise emission from digital devices set out in the Radio Interference Regulation of Industry Canada.

**Remarque sur les produits matériels Matrox couverts par ce guide**

Ces appareils numériques n’émettent aucun bruit radioélectrique dépassant les limites applicables aux appareils numériques de Classe A prescrites dans le Règlement sur le brouillage radioélectrique édicté par Industrie Canada.

**Europe**

**Remark for the Matrox hardware products supported by this guide**

These digital devices do not exceed the Class A limits for radio noise emission from digital devices set out in the Radio Interference Regulation of Industry Canada.

**Remarque sur les produits matériels Matrox couverts par ce guide**

Ces appareils numériques n’émettent aucun bruit radioélectrique dépassant les limites applicables aux appareils numériques de Classe A prescrites dans le Règlement sur le brouillage radioélectrique édicté par Industrie Canada.

**Europe**

**Remark for the Matrox hardware products supported by this guide**

These digital devices do not exceed the Class A limits for radio noise emission from digital devices set out in the Radio Interference Regulation of Industry Canada.

**Remarque sur les produits matériels Matrox couverts par ce guide**

Ces appareils numériques n’émettent aucun bruit radioélectrique dépassant les limites applicables aux appareils numériques de Classe A prescrites dans le Règlement sur le brouillage radioélectrique édicté par Industrie Canada.

**Europe**

**Remark for the Matrox hardware products supported by this guide**

These digital devices do not exceed the Class A limits for radio noise emission from digital devices set out in the Radio Interference Regulation of Industry Canada.

**Remarque sur les produits matériels Matrox couverts par ce guide**

Ces appareils numériques n’émettent aucun bruit radioélectrique dépassant les limites applicables aux appareils numériques de Classe A prescrites dans le Règlement sur le brouillage radioélectrique édicté par Industrie Canada.

**Europe**

**Remark for the Matrox hardware products supported by this guide**

These digital devices do not exceed the Class A limits for radio noise emission from digital devices set out in the Radio Interference Regulation of Industry Canada.

**Remarque sur les produits matériels Matrox couverts par ce guide**

Ces appareils numériques n’émettent aucun bruit radioélectrique dépassant les limites applicables aux appareils numériques de Classe A prescrites dans le Règlement sur le brouillage radioélectrique édicté par Industrie Canada.

**Europe**

**Remark for the Matrox hardware products supported by this guide**

These digital devices do not exceed the Class A limits for radio noise emission from digital devices set out in the Radio Interference Regulation of Industry Canada.

**Remarque sur les produits matériels Matrox couverts par ce guide**

Ces appareils numériques n’émettent aucun bruit radioélectrique dépassant les limites applicables aux appareils numériques de Classe A prescrites dans le Règlement sur le brouillage radioélectrique édicté par Industrie Canada.

**Europe**

**Remark for the Matrox hardware products supported by this guide**

These digital devices do not exceed the Class A limits for radio noise emission from digital devices set out in the Radio Interference Regulation of Industry Canada.

**Remarque sur les produits matériels Matrox couverts par ce guide**

Ces appareils numériques n’émettent aucun bruit radioélectrique dépassant les limites applicables aux appareils numériques de Classe A prescrites dans le Règlement sur le brouillage radioélectrique édicté par Industrie Canada.

**Europe**

**Remark for the Matrox hardware products supported by this guide**

These digital devices do not exceed the Class A limits for radio noise emission from digital devices set out in the Radio Interference Regulation of Industry Canada.

**Remarque sur les produits matériels Matrox couverts par ce guide**

Ces appareils numériques n’émettent aucun bruit radioélectrique dépassant les limites applicables aux appareils numériques de Classe A prescrites dans le Règlement sur le brouillage radioélectrique édicté par Industrie Canada.